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PART |

Introducing ASP.NET Core MVC

ASP.NET Core MVC is a radical shift for web developers using the Microsoft platform. It emphasizes
clean architecture, design patterns, and testability, and it doesn’t try to conceal how the Web works.
The first part of this book is designed to help you understand broadly the foundational ideas of

MVC development, including the new features in ASP.NET Core MVC, and to experience in practice
what the framework is like to use.
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CHAPTER 1

ASP.NET Core MVC in Context /

ASP.NET Core MVC is a web application development framework from Microsoft that combines the
effectiveness and tidiness of model-view-controller (MVC) architecture, ideas and techniques from agile
development, and the best parts of the .NET platform. In this chapter, you’ll learn why Microsoft created ASP.
NET Core MVC, see how it compares to its predecessors and alternatives, and, finally, get an overview of
what’s new in ASP.NET Core MVC and what’s covered in this book.

Understanding the History of ASP.NET Core MVC

The original ASP.NET was introduced in 2002, at a time when Microsoft was keen to protect a dominant
position in traditional desktop application development and saw the Internet as a threat. Figure 1-1
illustrates Microsoft’s technology stack as it appeared then.

ASP.NET Web Forms

A set of Ul components (pages, buttons, etc.) plus a
stateful, object-oriented GUI programming model

ASP.NET

A way to host .NET applications in IIS (Microsoft’s web server
product), letting you interact with HTTP requests and responses

.NET

A multilanguage-managed code platform
(brand-new at the time—a landmark in its own right)

Figure 1-1. The ASP.NET Web Forms technology stack

ASP.NET Web Forms

With Web Forms, Microsoft attempted to hide both Hypertext Transfer Protocol (HTTP), with its intrinsic
statelessness, and Hypertext Markup Language (HTML), which at the time was unfamiliar to many developers,
by modeling the user interface (UT) as a hierarchy of server-side control objects. Each control kept track of its own
state across requests, rendering itself as HTML when needed and automatically connecting client-side events (for
example, a button click) with the corresponding server-side event handler code. In effect, Web Forms is a giant
abstraction layer designed to deliver a classic event-driven graphical user interface (GUI) over the Web.

Electronic supplementary material The online version of this chapter (doi:10.1007/978-1-4842-0397-2_1)
contains supplementary material, which is available to authorized users.
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The idea was to make web development feel just the same as developing a desktop application.
Developers could think in terms of a stateful UI and didn’t need to work with a series of independent HTTP
requests and responses. Microsoft could seamlessly transition the army of Windows desktop developers into
the new world of web applications.

What Was Wrong with ASP.NET Web Forms?

Traditional ASP.NET Web Forms development was good in principle, but reality proved more complicated.

e View State weight: The actual mechanism for maintaining state across requests
(known as View State) resulted in large blocks of data being transferred between
the client and server. This data could reach hundreds of kilobytes in even modest
web applications, and it went back and forth with every request, leading to slower
response times and increasing the bandwidth demands of the server.

e Page life cycle: The mechanism for connecting client-side events with server-side
event handler code, part of the page life cycle, could be complicated and delicate.
Few developers had success manipulating the control hierarchy at runtime without
creating View State errors or finding that some event handlers mysteriously fail to
execute.

e  False sense of separation of concerns: ASP.NET Web Forms’ code-behind model
provided a means to take application code out of its HTML markup and into a
separate code-behind class. This was done to separate logic and presentation, but,
in reality, developers were encouraged to mix presentation code (for example,
manipulating the server-side control tree) with their application logic (for example,
manipulating database data) in these same monstrous code-behind classes. The end
result could be fragile and unintelligible.

e  Limited control over HTML: Server controls rendered themselves as HTML, but not
necessarily the HTML you wanted. In early versions of ASP.NET, the HTML output
failed to meet with web standards or make good use of Cascading Style Sheets (CSS),
and server controls generated unpredictable and complex ID attributes that are hard
to access using JavaScript. These problems have improved in recent Web Forms
releases, but it can still be tricky to get the HTML you expect.

e Leaky abstraction: Web Forms tried to hide HTML and HTTP wherever possible. As
you tried to implement custom behaviors, you frequently fell out of the abstraction,
which forced you to reverse-engineer the postback event mechanism or perform
obtuse acts to make it generate the desired HTML.

e  Low testability: The designers of Web Forms could not have anticipated that
automated testing would become an essential component of software development.
The tightly coupled architecture they designed was unsuitable for unit testing.
Integration testing could be a challenge, too.

Web Forms wasn'’t all bad, and Microsoft put a lot of effort into improving standards compliance
and simplifying the development process and even took some features from the original ASP.NET MVC
Framework and applied them to Web Forms. Web Forms excelled when you needed quick results, and
you could have a reasonably complex web app up and running within a day. But unless you were careful
during development, you would find that the application you created was hard to test and hard to
maintain.
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The Original MVC Framework

In October 2007, Microsoft announced a new development platform, built on the existing ASP.NET platform,
that was intended as a direct response to the criticisms of Web Forms and the popularity of competing
platforms such as Ruby on Rails. The new platform was called ASPNET MVC Framework and reflected the
emerging trends in web application development, such as HTML and CSS standardization, RESTful web
services, effective unit testing, and the idea that developers should embrace the stateful nature of HTTP.

The concepts that underpin the original MVC Framework seem natural and obvious now, but they were
lacking from the world of .NET web development in 2007. The introduction of the ASPNET MVC Framework
brought Microsoft’s web development platform back into the modern age.

The MVC Framework also signaled an important change in attitude from Microsoft, which had
previously tried to control every component in the web application toolchain. With the MVC Framework,
Microsoft built on open source tools such as jQuery, took on design conventions and best practices from
competing (and more successful) platforms, and released the source code to the MVC Framework for
developers to inspect.

What Was Wrong with the Original MVC Framework?

At the time it was created, it made sense for Microsoft to create the MVC Framework on top of the existing
ASP.NET platform, which had a lot of solid low-level functionality that provided a head start in the
development process and which was already well-known and understood by ASP.NET developers.

Compromises were required to graft the MVC Framework onto a platform that was originally designed
for Web Forms. MVC Framework developers became used to using configuration settings and code tweaks
that disabled or reconfigured features that didn’t have any bearing on their web application but were
required to get everything working.

As the MVC Framework grew in popularity, Microsoft started to take some of the core features and
add them to Web Forms. The result was increasingly odd, where features with design quirks required to
support the MVC Framework were extended to support Web Forms, with further design quirks to make
everything fit together. At the same time, Microsoft started to expand ASP.NET with new frameworks for
creating web services (Web API) and real-time communication (SignalR). The new frameworks added their
own configuration and development conventions, each of which had its own benefits and oddities, and the
overall result was a fragmented mess.

Understanding ASP.NET Core

In 2015, Microsoft announced a new direction for ASP.NET and the MVC Framework, which would
eventually produce ASP.NET Core MVC, the topic of this book.

ASP.NET Core is built on .NET Core, which is a cross-platform version of the .NET Framework without
the Windows-specific application programming interfaces (APIs). Windows is still a dominant operating
system but web applications are increasingly hosted in small and simple containers in cloud platforms,
and by embracing a cross-platform approach, Microsoft has extended the reach of .NET, made it possible
to deploy ASP.NET Core applications to a broader set of hosting environments, and, as a bonus, made it
possible for developers to create ASP.NET Core web applications on Linux and OS X/macOS.

ASP.NET Core is a completely new framework. It is simpler, it is easier to work with, and it is free of the
legacy that comes from Web Forms. And, since it is based on .NET Core, it supports the development of web
applications on a range of platforms and containers.

ASP.NET Core MVC provides the functionality of the original ASPNET MVC Framework built on
the new ASP.NET Core platform. It includes the functionality that was previously provided by Web AP, it
includes a more natural way of generating complex content, and it makes key development tasks, such as
unit testing, simpler and more predictable.
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Key Benefits of ASP.NET Core MVC

The following sections briefly describe how the new MVC platform overcomes the legacy of Web Forms and
the original MVC Framework and has brought ASP.NET back to the cutting edge.

MVC Architecture

ASP.NET Core MVC follows a pattern called model-view-controller (MVC), which guides the shape of an ASP.
NET web application and the interactions between the components it contains.

It is important to distinguish between the MVC architectural pattern and the ASP.NET Core MVC
implementation. The MVC pattern is not new—it dates back to 1978 and the Smalltalk project at Xerox
PARC—but it has gained popularity today as a pattern for web applications, for the following reasons:

e  User interaction with an application that adheres to the MVC pattern follows a
natural cycle: the user takes an action, and in response the application changes its
data model and delivers an updated view to the user. And then the cycle repeats.
This is a convenient fit for web applications delivered as a series of HTTP requests
and responses.

e  Web applications necessitate combining several technologies (databases, HTML,
and executable code, for example), usually split into a set of tiers or layers. The
patterns that arise from these combinations map naturally onto the concepts in the
MVC pattern.

ASP.NET Core MVC implements the MVC pattern and, in doing so, provides a greatly improved
separation of concerns when compared to Web Forms. In fact, ASP.NET Core MVC implements a variant of
the MVC pattern that is especially suitable for web applications. You will learn more about the theory and
practice of this architecture in Chapter 3.

Extensibility

ASP.NET Core and ASP.NET Core MVC are built as a series of independent components that have well-
defined characteristics, satisfy a .NET interface or that are built on an abstract base class. You can easily
replace key components with ones of your own implementation. In general, the ASPNET Core MVC gives
you these three options for each component:

e  Use the default implementation of the component as it stands (which should be
enough for most applications).

e  Derive a subclass of the default implementation to tweak its behavior.

e Replace the component entirely with a new implementation of the interface or
abstract base class.

You'll learn all about the various components and how and why you might want to tweak or replace
each of them, starting in Chapter 14.

Tight Control over HTML and HTTP

ASP.NET Core MVC produces clean, standards-compliant markup. Its built-in tag helpers produce
standards-compliant output, but there is a more significant philosophical change compared with Web
Forms. Instead of generating out swathes of HTML over which you have little control, ASP.NET Core MVC
encourages you to craft simple, elegant markup styled with CSS.

6
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Of course, if you do want to throw in some ready-made widgets for complex UI elements such as date
pickers or cascading menus, the “no special requirements” approach taken by ASP.NET Core MVC makes it
easy to use best-of-breed client-side libraries such as jQuery, Angular, or the Bootstrap CSS library. ASP.NET
Core MVC meshes so well with these libraries that Microsoft includes support for them as built-in parts of
the standard Visual Studio project template for web applications.

ASP.NET Core MVC works in tune with HTTP. You have control over the requests passing between the
browser and server, so you can fine-tune your user experience as much as you like. Ajax is made easy, and
creating web services to receive browser HTTP requests is a simple process, as described in Chapter 20.

Testability

The ASP.NET Core MVC architecture gives you a great start in making your application maintainable and
testable because you naturally separate different application concerns into independent pieces. In addition,
each piece of the ASP.NET Core platform and the ASP.NET Core MVC framework can be isolated and
replaced for unit testing, which can be performed using any popular open source testing framework, such as
xUnit, which I introduce in Chapter 7.

In this book, you will see examples of how to write clean, simple unit tests for ASPNET MVC controllers
and actions that supply fake or mock implementations of framework components to simulate any scenario,
using a variety of testing and mocking strategies. Even if you have never written a unit test before, you will be
off to a great start.

Testability is not only a matter of unit testing. ASP.NET Core MVC applications work well with UI
automation testing tools, too. You can write test scripts that simulate user interactions without needing to
guess which HTML element structures, CSS classes, or IDs the framework will generate, and you do not have
to worry about the structure changing unexpectedly.

Powerful Routing System

The style of uniform resource locators (URLs) has evolved as web application technology has improved.
URLs like this one:

/App_v2/User/Page.aspx?action=show%20prop&prop id=82742
are increasingly rare, replaced with a simpler, cleaner format like this:
/to-rent/chicago/2303-silver-street

There are some good reasons for caring about the structure of URLs. First, search engines give weight
to keywords found in a URL. A search for “rent in Chicago” is much more likely to turn up the simpler URL.
Second, many web users are now savvy enough to understand a URL and appreciate the option of navigating
by typing it into their browser’s address bar. Third, when someone understands the structure of a URL, they
are more likely to link to it, share it with a friend, or even read it aloud over the phone. Fourth, it doesn’t
expose the technical details, folder, and file name structure of your application to the public Internet, so you
are free to change the underlying implementation without breaking all your incoming links.

Clean URLs were hard to implement in earlier frameworks, but ASP.NET Core MVC uses a feature
known as URL routing to provide clean URLs by default. This gives you control over your URL schema and its
relationship to your application, offering you the freedom to create a pattern of URLs that is meaningful and
useful to your users, without the need to conform to a predefined pattern. And, of course, this means you
can easily define a modern REST-style URL schema if you want. You'll find a thorough description of URL
routing in Chapters 15 and 16.

VN Secret
Www.vnsecret.com


http://dx.doi.org/10.1007/978-1-4842-0397-2_20
http://dx.doi.org/10.1007/978-1-4842-0397-2_7
http://dx.doi.org/10.1007/978-1-4842-0397-2_15
http://dx.doi.org/10.1007/978-1-4842-0397-2_16

CHAPTER 1 © ASP.NET CORE MVC IN CONTEXT

Modern API

Microsoft’s .NET platform has evolved with each major release, supporting—and even defining—the state-of-the-
art aspects of modern programming. ASP.NET Core MVC is built for .NET Core, so its API can take full advantage
oflanguage and runtime innovations familiar to C# programmers, including the await keyword, extension
methods, lambda expressions, anonymous and dynamic types, and Language Integrated Query (LINQ).

Many of the ASP.NET Core MVC API methods and coding patterns follow a cleaner, more expressive
composition than was possible with earlier platforms. Don’t worry if you are not up to speed on the latest C#
language features: I provide a summary of the most important C# features for MVC development in Chapter 4.

Cross-Platform

Previous versions of ASP.NET were specific to Windows, requiring a Windows desktop to write web
applications and a Windows server to deploy and run them. Microsoft made ASP.NET Core cross-platform,
both for development and for deployment. .NET Core is available for different platforms—including Linux
and OS X/macOS—and is likely to be ported to others.

Most ASP.NET Core MVC development is likely to be done using Visual Studio for the immediate future,
but Microsoft has also created a cross-platform development tool called Visual Studio Code, which means
that ASP.NET Core MVC development is no longer restricted to Windows.

ASP.NET Core MVC Is Open Source

Unlike previous Microsoft web development platforms, you are free to download the source code for ASP.
NET Core and ASP.NET Core MVC and even modify and compile your own version of it. This is invaluable
when your debugging trail leads into a system component and you want to step into its code (and even read
the original programmers’ comments). It is also useful if you are building an advanced component and want
to see what development possibilities exist or how the built-in components actually work.

You can download the ASP.NET Core and ASP.NET Core MVC source code from https://github.com/
aspnet.

What Do | Need to Know?

To get the most from this book, you should be familiar with the basics of web development, understand how
HTML and CSS work, and have a working knowledge of C#. Don't worry if you are a little hazy on the client-
side details, such as JavaScript. My emphasis is on server-side development in this book, and you can pick
up what you need through the examples. In Chapter 4, I summarize the most useful C# language features
for MVC development, which you’ll find useful if you are moving to the latest .NET versions from an earlier
release.

What Is the Structure of This Book?

This book is split into two parts, each of which covers a set of related topics.

Part 1: Introducing ASP.NET Core MVC

I start this book by putting ASP.NET Core MVC in context. I explain the benefits and practical impact of the
MVC pattern, cover the way in which ASP.NET Core MVC fits into modern web development, and describe
the tools and C# language features that every ASP.NET Core MVC programmer needs.

8
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In Chapter 2, you will dive right in and create a simple web application and get an idea of what the
major components and building blocks are and how they fit together. Most of this part of the book, however,
is given over to the development of a project called SportsStore, through which I show you a realistic
development process from inception to deployment, touching on the major features of ASP.NET Core MVC.

Part 2: ASP.NET Core MVC in Detail

In Part 2, I explain the inner workings of ASP.NET Core MVC features that I used to build the SportsStore
application. I show you how each feature works, explain the role it plays, and show you the configuration
and customization options that are available. Having set the broad context in Part 1, I dig right into the
details in Part 2.

What’s New in This Edition?

This edition has been revised and expanded to describe ASP.NET Core MVC, which reflects a complete
change in the way that Microsoft supports web development. Earlier versions of the MVC Framework were
built on the foundations of ASP.NET that were originally created for Web Forms. This had the advantage of
providing some mature underpinnings for MVC development but did so in ways that leaked details of how
Web Forms worked. Some features exposed the internals of Web Forms in ways that had no bearing in MVC
applications, and other features could produce unpredictable results.

In addition, the ASP.NET foundation was provided using assemblies that were included in the .NET
Framework, which meant that major changes could be made only when Microsoft released a new version
of .NET. This became a problem because the pace of change for web development exceeds the rate at which
.NET changes.

ASP.NET Core MVC is a complete rewrite that retains the philosophy and overall design of earlier
versions but updates the API to improve the design and performance of web apps. ASP.NET Core MVC
depends on ASP.NET Core, which is itself a complete rewrite of the web stack underpinnings: the primacy of
Web Forms is gone and the tight coupling to .NET Framework releases has been broken.

You may find the extent of the changes to be alarming if you have experience with MVC 5, but don't
panic. The underlying concepts are the same, and many of the changes look more substantial and complex
than they really are. In Part 2 of this book, I summarize the changes for each major feature to ease the
transition from MVC 5 to ASP.NET Core MVC.

Where Can | Get the Example Code?

You can download all the examples for all the chapters in this book from Apress.com. The download

is available without charge and includes all of the code projects and their contents. You don’t have to
download the code, but it is the easiest way of experimenting with the examples and cutting and pasting
techniques into your own projects.

Summary

In this chapter, I explained the context in which ASP.NET Core MVC exists and how it has evolved from Web
Forms and the original ASPNET MVC Framework. I described the benefits of using the ASP.NET Core MVC,
the structure of this book, and the software that you will require to follow the examples. In the next chapter,
you'll see ASP.NET Core MVC Framework in action in a simple demonstration of the features that deliver
these benefits.
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CHAPTER 2

Your First MVC Application

The best way to appreciate a software development framework is to jump right in and use it. In this chapter,
you'll create a simple data-entry application using the ASP.NET Core MVC. I take things a step at a time so
you can see how an MVC application is constructed. To keep things simple, I skip over some of the technical
details for the moment. But don’t worry. If you are new to MVC, you will find plenty to keep you interested.
Where I use something without explaining it, I provide a reference to the chapter in which you can find all
the details.

Installing Visual Studio

This book relies on Visual Studio 2015, which provides everything you will need for ASP.NET Core MVC
development. I use the free Visual Studio 2015 Community edition, which can be downloaded from www.
visualstudio.com. When you install Visual Studio, you should ensure that the Microsoft Web Developer
Tools option is selected.

Tip  Visual Studio only supports Windows. You can create ASP.NET Core MVC applications on other
platforms using Visual Studio Code but it doesn’t provide all of the tools required for the examples in this book.
See Chapter 13 for details.

If you have an existing Visual Studio installation, you must ensure that you apply Visual Studio
Update 3, which provides support for working with ASP.NET Core applications. The update will be applied
automatically for new Visual Studio installations. If you need the update, you can download it from http://
go.microsoft.com/fwlink/?LinkId=691129.

Next, you must download and install .NET Core, which is available from https://go.microsoft.com/
fwlink/?LinkId=817245. The .NET Core download is required even for new Visual Studio installations.

The final step is to install a tool called git, which can be downloaded from https://git-scm.com/
download. Visual Studio includes its own version of git but it doesn’t work properly and it produces
unexpected results when used by other tools, including Bower, which I describe in Chapter 6. When you
install git, ensure that you tell the installer to add the tool to the PATH environment variable, as shown in
Figure 2-1. This ensures that Visual Studio will be able to find the new version of git.

© Adam Freeman 2016 11
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4" Git 2.9.0 Setup — X
Adjusting your PATH environment \\
How would you like to use Git from the command line? ‘\)

() Use Git from Git Bash only

This is the safest choice as your PATH will not be modified at all. You will only be
able to use the Git command line tools from Git Bash.

(® Use Git from the Windows Command Prompt

This option is considered safe as it only adds some minimal Git wrappers to your
PATH to avoid duttering your environment with optional Unix tools. You will be
able to use Git from both Git Bash and the Windows Command Prompt.

(O Use Git and optional Unix tools from the Windows Command Prompt

Both Git and the optional Unix tools will be added to your PATH.
Warning: This will override Windows tools like "find" and "sort". Only
use this option if you understand the implications.

https://ait-for-windows. github.io -

<Back |[ Next> | | cancel |

Figure 2-1. Adding git to the path

Start Visual Studio and select Tools » Options and navigate to the Projects and Solutions » External Web
Tools section, as shown in Figure 2-2. Uncheck the $(VSINSTALLDIR)\Web\External\git item to disable the
Visual Studio version of git and make sure that the $ (PATH) item is enabled so that the git you just installed is used.

Options 7 X
Seawcly Sptions i+ ) P Locations of external tools: EI E
Keyboard Al T y —
Notifications Anode_modules\.bin
Quick Launch [V]$(VSINSTALLDIR)\Web\External
Startup [VIS(PATH)
e [JS(VSINSTALLDIR)\Web\Externalgit
Tabs and Windows
Task List

Web Browser
4 Projects and Solutions
General
.NET Core Projects
Build and Run
erema i Tok
VB Defaults
VC++ Directories The paths listed above will be searched when Visual Studio uses 3rd-party tools such as
VC++ Project Settings Grunt, Gulp, Bower, or npm.
Web Projects o

o

Figure 2-2. Configuring git in Visual Studio
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THE FUTURE OF ASPNET CORE MVC AND VISUAL STUDIO

Microsoft underestimated how long it would take to create ASP.NET Core and ASPNET Core MVC. The
originally planned release dates would have coincided with the release of Visual Studio 2015, but delays on
the ASP.NET side mean that development of the next version of Visual Studio has already started as | write
this. This means that the tooling support for creating ASPNET Core MVC applications will change when

the next Visual Studio is released. When the tooling stabilizes, | will provide an update for the instructions
required to create the example applications. See the Apress.com page for this book for details.

Creating a New ASP.NET Core MVC Project

I am going to start by creating a new ASP.NET Core MVC project in Visual Studio. Select New » Project from
the File menu to open the New Project dialog. If you navigate to the Templates » Visual C# » Web section
in the left panel, you will see the ASP.NET Core Web Application (.Net Core) project template. Select this
project type, as shown in Figure 2-3.

New Project 3 {4 X
| b Recent NET Framework 4.6.1 - Sortby: Default -] 5 [i=) [Search Installed Templates (Ctrl+E) 0 -|
| 4 Installed Type: Visual C2 |

@ ASP.NET Web Application (.NET Framework) Visual C# ype: Visua
4 Templates Project templates for creating ASP.NET
4 Visual C# @ ASP, Web Apolication (. Visual C# Core applications for Windows, Linux and
b Windows RAT Core Ve Aptcaion (T Co mls 05 X using .NET Core.
Web @ ASP.NET Core Web Application (NET Framework)  Visual C# @ Application Insights
NET Core [] Add Application Insights to project
Android Optimize performance and monitor
Cloud usaqge in your live application.
Extensibility
i0s
Reporting
Silverlight
Tact - Help me understand Applicaticon Insights

b Online Click here to go online and find templates. Privacy Statement

Name: Partylnvites

Location: C:\Projects b

Solution name: Partylnvites [w] Create directory for solution

["] Add to Source Control

Figure 2-3. The Visual Studio ASP.NET Core Web Application project template

Tip The choice of project template can be confusing because their names are so similar. The ASP.NET
Web Application (NET Framework) template is for creating projects using the legacy versions of ASP.NET and
the MVC Framework, which predated ASP.NET Core. The other two templates are for creating ASP.NET Core
applications, and they differ in the runtime they use, allowing you to select either the .NET Framework or .NET
Core. | explain the difference between them in Chapter 6, but | use the .NET Core option throughout this book,
so it is the one you should select to ensure that you get the same results from the example applications.
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Set the Name field for the new project to PartyInvites and ensure that the Add Application Insights
to Project option is unchecked, as shown in Figure 2-3. Click the OK button to continue and you will see
another dialog box, shown in Figure 2-4, which asks you to set the initial content for the project.

New ASP.NET Core Web Application ((NET Core) - Partylnvites

Select a template:

| A project template for creating an ASP.NET Core
ASP.NET Core Templates application with example ASP.NET MVC Views and
Controllers. This template can also be used for RESTful

m E HTTP services.

Learn more
Empty Web API Web
Application

Change Authentication

Authentication: No Authentication

“S Microsoft Azure
@ [] Host in the cloud

. App Service v

oK || Cancel

Figure 2-4. Selecting the initial project configuration

There are three different ASP.NET Core Template options, each of which creates a project with different
starting content. For this chapter, select the Web Application option, which sets up a MVC application with
pre-defined content to jump start development.

Note This is the only chapter in which I use the Web Application project template. | don’t like using
predefined project templates because they encourage developers to treat some important features,
such as authentication, as black boxes. My goal in this book is to give you the knowledge to understand
and manage every aspect of your MVC applications, so | use the Empty template throughout the rest
of the book. This chapter is about getting started quickly, for which the Web Application template is
well-suited.

Click the Change Authentication button and ensure that the No Authentication option is selected, as
shown in Figure 2-5. This project doesn’t require any authentication, but I explain how to secure ASP.NET
applications in Chapters 28-30.
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Change Authentication X

@® No Authentication Learn more
) Individual User Accounts
() Work And School Accounts

() Windows Authentication

Figure 2-5. Selecting the authentication settings

For applications that don't require any user authentication.

OK || Cancel

Click OK to close the Change Authentication dialog. Ensure that the Host in the Cloud option is
unchecked and then click OK to create the PartyInvites project. Once Visual Studio has created the project,
you will see a number of files and folders displayed in the Solution Explorer window, as shown in Figure 2-6.
This is the default project structure for a new MVC project created using the Web Application template, and
you will soon understand the purpose of each file and folder that Visual Studio creates.

Solution Explorer *O X
COR| o-s @ F -
Search Solution Explorer (Ctrl+;) P~
fa] Solution 'Partylnvites’ (1 project)
4 .| Solution Items

&T global,json
4 o src

4 Partylnvites
b Properties

P =B References

@ wwwroot

#-8 Dependencies
Controllers

T v v w

i Views

&T appsettings.json

&T bundleconfig,json
c* Program.cs

b &7 projectjson

) Project_Readme.html
c# Startup.cs

¢ web.config

Figure 2-6. The initial file and folder structure of an ASPNET Core MVC project
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You can run the application by selecting Start Debugging from the Debug menu (if it prompts you to
enable debugging, just click the OK button). When you do this, Visual Studio compiles the application,
uses an application server called IIS Express to run it, and opens a web browser to request the application
content. You can see the result in Figure 2-7.

| Home Page - Partylrite. 3

| C | @ locathost57628 L4

ASP.NET Core | Windows Linux  OSX

Learn how to build ASP.NET apps that can run anywhere.
[ ] )

Application uses How to Overview Run & Deploy
« Sample pages using ASPNET « Add a Controller and View + Concaptual overview of what is « Run your app
Core MVC = Add an appseiting in config and ASPNET Core = Run tocls such as EF migrations
= Bowar for managing client-side access itin app. » Fundamentals of ASPNET Core and mor
libraries = Manage User Secrats using Secret such as Startup and middleware. » Publish to Mcrosoft Azure Web
= Theming using Bootstrap Manager. » Working with Data Apps.
« Usa logging to log a message. « Security
« Add packages using NuGel. « Client side development
« Add client packages using Bower. « Daevelop on ditferent platiorms
» Target development, staging or « Read more on the documentation
production anvironment. sita
@ 2016 - Partylnvites

Figure 2-7. Running the example project

When Visual Studio creates a project with the Web Application template, it adds some basic code and
content, which is what you see when you run the application. Throughout the rest of the chapter, I will
replace this content to create a simple MVC application.

When you are finished, be sure to stop debugging by closing the browser window that shows the error or
by going back to Visual Studio and selecting Stop Debugging from the Debug menu.

As you have just seen, Visual Studio opens the browser to display the project. You can select any
browser that you have installed by clicking the arrow to the right of the IIS Express toolbar button and
choosing from the list of options in the Web Browser menu, as shown in Figure 2-8.
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Iest CodeMaid  Analyze Window Help ’
- bEISExpress-ov|ﬁd= :
IIS Express
IIS Express
Partylnvites
Web Browser (Google Chrome) . Firefox

Browse With... Google Chrome

Google Chrome Canary D"

Internet Explorer
Microsoft Edge

Opera Internet Browser

Figure 2-8. Selecting a browser

From here on, I will use Google Chrome or Google Chrome Canary for all the screenshots in this book,
but you can use any modern browser to display the examples in the books, including Microsoft Edge and
recent versions of Internet Explorer.

Adding the Controller

In the MVC pattern, incoming requests are handled by controllers. In ASPNET Core MVC, controllers are just
C# classes (usually inheriting from the Microsoft.AspNetCore.Mvc.Controller class, which is the built-in
MVC controller base class).

Each public method in a controller is known as an action method, meaning you can invoke it from
the Web via some URL to perform an action. The MVC convention is to put controllers in the Controllers
folder, which Visual Studio created when it set up the project.

Tip  You do not need to follow this or most other MVC conventions, but | recommend that you do—not least
because it will help you make sense of the examples in this book.

Visual Studio adds a default controller class to the project, which you can see if you expand the
Controllers folder in the Solution Explorer. The file is called HomeController.cs. Controller classes contain
a name followed by the word Controller, which means that when you see a file called HomeController.
cs, you know that it contains a controller called Home, which is the default controller that is used in MVC
applications. Click on the HomeController.cs file in the Solution Explorer so that Visual Studio opens it for
editing. You will see the C# code shown in Listing 2-1.

17
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Listing 2-1. The Initial Contents of the HomeController.cs File in the Controllers Folder
using System;
using System.Collections.Generic;
using System.Ling;
using System.Threading.Tasks;
using Microsoft.AspNetCore.Mvc;
namespace PartyInvites.Controllers {
public class HomeController : Controller {
public IActionResult Index() {
return View();
}
public IActionResult About() {
ViewData[ "Message"] = "Your application description page.";
return View();
public IActionResult Contact() {

ViewData[ "Message"] = "Your contact page.";

return View();

}

public IActionResult Error() {
return View();
}

Replace the code in the HomeController.cs file so that it matches Listing 2-2. I have removed all but
one of the methods, changed the result type and its implementation and removed the using statements for
unused namespaces.

Listing 2-2. Changing the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
namespace PartyInvites.Controllers {
public class HomeController : Controller {

public string Index() {
return "Hello World";
}

18
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These changes don’t have a dramatic effect, but they make for a nice demonstration. I have changed
the method called Index so that it returns the string Hello World. Run the project again by selecting Start
Debugging from the Visual Studio Debug menu.

Tip  If you left the application running from the previous section, then select Restart from the Debugging
menu or, if you prefer, select Stop Debugging and then Start Debugging.

The browser will make an HTTP request to the server. The default MVC configuration means that the
request will be handled using the Index method (known as an action method or just an action) and the result
from the method will be sent back to the browser, as shown in Figure 2-9.

| localhost:57628 X

C | © localhost:57628 v+l ©

Hello World

Figure 2-9. The output from the action method

Tip  Notice that Visual Studio has directed the browser to port 57628. You will almost certainly see a
different port number in the URL that your browser requests because Visual Studio allocates a random port
when the project is created. If you look in the Windows taskbar notification area, you will find an icon for lIS
Express. This is a cut-down version of the full IS application server that is included with Visual Studio and is
used to deliver ASP.NET content and services during development. I'll show you how to deploy an MVC project
into a production environment in Chapter 12.

Understanding Routes

As well as models, views, and controllers, MVC applications use the ASP.NET routing system, which decides
how URLs map to controllers and actions. A route is a rule that is used to decide how a request is handled.
When Visual Studio creates the MVC project, it adds some default routes to get you started. You can request
any of the following URLSs, and they will be directed to the Index action on the HomeController.

o /
e  /Home

e  /Home/Index
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So, when a browser requests http://yoursite/ or http://yoursite/Home, it gets back the output
from HomeController’s Index method. You can try this yourself by changing the URL in the browser. At the
moment, it will be http://localhost:57628/, except that the port part may be different. If you append /
Home or /Home/Index to the URL and press Return, you will see the same Hello World result from the MVC
application.

This is a good example of benefiting from following conventions implemented by ASP.NET Core
MVC. In this case, the convention is that I will have a controller called HomeController and that it will be
the starting point for the MVC application. The default configuration that Visual Studio creates for a new
project assumes that I will follow this convention. And since I did follow the convention, I automatically
got support for the URLs in the preceding list. If I had not followed the convention, I would need to modify
the configuration to point to whatever controller I had created instead. For this simple example, the default
configuration is all  need.

Rendering Web Pages

The output from the previous example wasn’'t HTML—it was just the string Hello World. To produce an
HTML response to a browser request, I need a view, which tells MVC how to generate a response for a
request from a browser.

Creating and Rendering a View

The first thing I need to do is modify my Index action method, as shown in Listing 2-3. The changes are
shown in bold, which is a convention I follow throughout this book to make the examples easier to follow.

Listing 2-3. Moditying the Controller to Render a View in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
namespace PartyInvites.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
return View("MyView");
}

When I return a ViewResult object from an action method, I am instructing MVC to render a view. I
create the ViewResult by calling the View method, specifying the name of the view that I want to use, which
is MyView. If you run the application, you can see MVC trying to find the view, as shown in the error message
displayed in Figure 2-10.
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| Internal Server Error X

C | @ localhost:57628 * 4

An unhandled exception occurred while processing the request.

InvalidOperationException: The view 'MyView' was not found. The following locations
were searched:

/Views/Home/MyView.cshtml

/Views/Shared/MyView.cshtml

EnsureSuccessful

m Query Cookies Headers

Figure 2-10. MVC trying to find a view

This error message is quite helpful. It not only explains that MVC could not find the view I specified
for the action method but also shows where it looked. Views are stored in the Views folder, organized into
subfolders. Views that are associated with the Home controller, for example, are stored in a folder called
Views/Home. Views that are not specific to a single controller are stored in a folder called Views/Shared.
Visual Studio creates the Home and Shared folders automatically when the Web Application template is used
and puts in some placeholder views to get the project started.

To create the view, right-click the Views » Home folder in the Solution Explorer and select Add » New Item
from the pop-up menu. Visual Studio will present you with a list of item templates. Select the ASP.NET category
using the left pane and then select the MVC View Page item in the central pane, as shown in Figure 2-11.

Add New [tem - Partylnvites

4 |nstalled Sort by: Default - i = Search Installed Templates (Ctri+E) P~
ce -
:?'qu ,';j MVC Controller Class ASP.NET Type: ASP.NET
c |:In nes i = MVC View Page
= fe]  Web APl Controller Class ASP.NET
: &
P Online

@ MVC View Page ASP.NET

c-
@] MVC View Layout Page ASP.NET

cn
@' MVC View Start Page ASP.NET

can
Em“l MVC View Imports Page ASP.NET

c‘
.:j Razor Tag Helper ASP.NET

- -
Click here to go online and find templates.
Name:  MyView.cshtml
Add || Cancel
Figure 2-11. Creating a view
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Tip  You will see some existing files in the views folder, which were added to the project by Visual Studio to
provide some initial content, some of which you saw in Figure 2-7. You can ignore these files.

Set the Name field to MyView.cshtml and click the Add button to create the view. Visual Studio will
create the Views/Home/MyView.cshtml file and open it for editing. The initial content of the view file is just
some comments and a placeholder. Replace them with the content shown in Listing 2-4.

Tip Itis easy to end up creating the view file in the wrong folder. If you didn’t end up with a file called
MyView.cshtml in the Views/Home folder, then delete the file you did create and try again.

Listing 2-4. Replacing the Content of the MyView.cshtml File in the Views/Home Folder
of

}

<!DOCTYPE html>

Layout = null;

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
</head>
<body>
<div>
Hello World (from the view)
</div>
</body>
</html>

The new contents of the view file are mostly HTML. The exception is the part that looks like this:
o{
}

Layout = null;

This is an expression that will be interpreted by the Razor view engine, which processes the contents of
views and generates HTML that is sent to the browser. This is a simple Razor expression, and it tells Razor
that I chose not to use a layout, which is like a template for the HTML that will be sent to the browser (and
which I describe in Chapter 5). I am going to ignore Razor for the moment and come back to it later. To see
the effect of creating the view, select Start Debugging from the Debug menu to run the application. You
should see the result in Figure 2-12.
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| Index x

C | @ localhost:57628

b2

Hello World (from the view)

Figure 2-12. Testing the view

When I first edited the Index action method, it returned a string value. This meant that MVC did
nothing except pass the string value as is to the browser. Now that the Index method returns a ViewResult,
MVC renders a view and returns the HTML it produces. I told MVC which view should be used, so it used
the naming convention to find it automatically. The convention is that the view has the name of the action
method and is contained in a folder named after the controller: /Views/Home/MyView.cshtml.

I can return other results from action methods besides strings and ViewResult objects. For
example, if I return a RedirectResult, the browser will be redirected to another URL. If I return an
HttpUnauthorizedResult, Iforce the user to log in. These objects are collectively known as action results.
The action result system lets you encapsulate and reuse common responses in actions. I'll tell you more
about them and explain the different ways they can be used in Chapter 17.

Adding Dynamic Output

The whole point of a web application platform is to construct and display dynamic output. In MVC, it is the
controller’s job to construct some data and pass it to the view, which is responsible for rendering it to HTML.

One way to pass data from the controller to the view is by using the ViewBag object, which is a member
of the Controller base class. ViewBag is a dynamic object to which you can assign arbitrary properties,
making those values available in whatever view is subsequently rendered. Listing 2-5 demonstrates passing
some simple dynamic data in this way in the HomeController.cs file.

Listing 2-5. Setting View Data in the HomeController.cs File

using System;
using Microsoft.AspNetCore.Mvc;

namespace PartyInvites.Controllers {
public class HomeController : Controller {
public ViewResult Index() {
int hour = DateTime.Now.Hour;

ViewBag.Greeting = hour < 12 ? "Good Morning" : "Good Afternoon";
return View("MyView");
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I provide data for the view when I assign a value to the ViewBag.Greeting property. The Greeting
property didn’t exist until the moment I assigned the value—this allows me to pass data from the controller
to the view in a free and fluid manner, without having to define classes ahead of time. I refer to the ViewBag.
Greeting property again in the view to get the data value, as illustrated in Listing 2-6, which shows the
corresponding change to the MyView.cshtml file.

Listing 2-6. Retrieving a ViewBag Data Value in the MyView.cshtml File

of
}

<!DOCTYPE html>

Layout = null;

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
</head>
<body>
<div>
@ViewBag.Greeting World (from the view)
</div>
</body>
</html>

The addition to the listing is a Razor expression that is evaluated when MVC uses the view to generate
aresponse. When I call the View method in the controller’s Index method, MVC locates the MyView.cshtml
view file and asks the Razor view engine to parse the file’s content. Razor looks for expressions like the one
I added in the listing and processes them. In this example, processing the expression means inserting the
value assigned to the ViewBag.Greeting property in the action method into the view.

There’s nothing special about the property name Greeting; you could replace this with any property name
and it would work the same, just as long as the name you use in the controller matches the name you use in the
view. You can pass multiple data values from your controller to the view by assigning values to more than one
property. You can see the effect of these changes by starting the project, as shown in Figure 2-13.

| Index X
C | ® localhost:57628 W

Good Moming World (from the view)

Figure 2-13. A dynamic response from MVC
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Creating a Simple Data-Entry Application

In the rest of this chapter, I will explore more of the basic MVC features by building a simple data-entry
application. I am going to pick up the pace in this section. My goal is to demonstrate MVC in action, so I will
skip over some of the explanations as to how things work behind the scenes. But don’t worry; I'll revisit these
topics in depth in later chapters.

Setting the Scene

Imagine that a friend has decided to host a New Year’s Eve party and that she has asked me to create a web
app that allows her invitees to electronically RSVP. She has asked for these four key features:

e  Ahome page that shows information about the party

e  Aform that can be used to RSVP

e  Validation for the RSVP form, which will display a thank-you page
e Asummary page that shows who is coming to the party

In the following sections, I will build up the MVC project I created at the start of the chapter and add
these features. I can check the first item off the list by applying what I covered earlier and add some HTML
to my existing view to give details of the party. To get started, Listing 2-7 shows the additions I made to the
Views/Home/MyView.cshtml file.

Listing 2-7. Displaying Details of the Party in the MyView.cshtml File
of

}

<!DOCTYPE html>

Layout = null;

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
</head>
<body>
<div>
@ViewBag.Greeting World (from the view)
<p>We're going to have an exciting party.<br />
(To do: sell it better. Add pictures or something.)
</p>
</div>
</body>
</html>

I am on my way. If you run the application, by selecting Start Debugging from the Debug menu, you'll see
the details of the party (well, the placeholder for the details, but you get the idea), as shown in Figure 2-14.
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| Index X
C | ® localhost:57628 w|
Good Moming World (from the view)

We're going to have an exciting party.
(To do: sell 1t better. Add pictures or something.)

Figure 2-14. Adding to the view HTML

Designing a Data Model

In MVC, the M stands for model, and it is the most important part of the application. The model is the
representation of the real-world objects, processes, and rules that define the subject, known as the domain, of
the application. The model, often referred to as a domain model, contains the C# objects (known as domain
objects) that make up the universe of the application and the methods that manipulate them. The views and
controllers expose the domain to the clients in a consistent manner, and a well-designed MVC application
starts with a well-designed model, which is then the focal point as controllers and views are added.

I don’t need a complex model for the PartyInvites project because it is such a simple application and
Ineed to create just one domain class that I will call GuestResponse. This object will be responsible for
storing, validating, and confirming an RSVP.

The MVC convention is that the classes that make up a model are placed inside a folder called the Models
folder. To create this folder, right-click the PartyInvites project (the item that contains the Controllers and
Views folders), select Add » New Folder from the pop-up menu, and set the name of the folder to Models.

Note You won’t be able to set the name of the new folder if the application is still running. Select Stop
Debugging from the Debug menu, right-click the NewFolder item that has been added to the Solution Explorer,
select Rename from the pop-up menu, and change the name to Models.

To create the class file, right-click the Models folder in the Solution Explorer and select Add » Class
from the pop-up menu. Set the name of the new class to GuestResponse. cs and click the Add button. Edit
the contents of the new class file to match Listing 2-8.

Listing 2-8. The GuestResponse Domain Class Defined in the GuestResponse.cs File in the Models Folder

namespace PartyInvites.Models {
public class GuestResponse {
public string Name { get; set; }
public string Email { get; set; }
public string Phone { get; set; }
public bool? WillAttend { get; set; }
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Tip  You may have noticed that the WillAttend property is a nullable bool, which means that it can be
true, false, or null. | explain the rationale for this in the “Adding Validation” section later in the chapter.

Creating a Second Action and a Strongly Typed View

One of my application goals is to include an RSVP form, which means that I need to define an action
method that can receive requests for it. A single controller class can define multiple action methods, and the
convention is to group related actions together in the same controller. Listing 2-9 shows the addition of a
new action method to the Home controller.

Listing 2-9. Adding an Action Method in the HomeController.cs File
using System;

using Microsoft.AspNetCore.Mvc;

namespace PartyInvites.Controllers {

public class HomeController : Controller {

public ViewResult Index() {
int hour = DateTime.Now.Hour;
ViewBag.Greeting = hour < 12 ? "Good Morning" : "Good Afternoon";
return View("MyView");

}

public ViewResult RsvpForm() {
return View();
}

The RsvpForm action method calls the View method without an argument, which tells MVC to render
the default view associated with the action method, which is a view with the same name as the action
method, in this case RsvpForm.cshtml.

Right-click the Views » Home folder and select Add » New Item from the pop-up menu. Select the
MVC View Page template from the ASP.NET category, set the name of the new file to RsvpForm.cshtml, and
click the Add button to create the file. Change the content of the file so that it matches Listing 2-10.

Listing 2-10. Setting the Content of the RsvpForm.cshtml File in the Views/Home Folder

@model PartyInvites.Models.GuestResponse

of
Layout = null;
}

<!DOCTYPE html>
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<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>RsvpForm</title>
</head>
<body>
<div>
This is the RsvpForm.cshtml View
</div>
</body>
</html>

This content is mostly HTML but with the addition of a @model Razor expression, which is used to create
a strongly typed view. A strongly typed view is intended to render a specific model type, and if I specify the
type I want to work with (the GuestResponse class in the PartyInvites.Models namespace in this case),
MVC can create some helpful shortcuts to make it easier. I will take advantage of the strongly typed feature
shortly.

To test the new action method and its view, start the application by selecting Start Debugging from the
Debug menu and use the browser to navigate to the /Home/RsvpForm URL.

MVC will use the naming convention I described earlier to direct the request to the RsvpForm action
method defined by the Home controller. This action method tells MVC to render the default view, which,
with another application of the naming convention, renders RsvpForm.cshml from the Views/Home folder.
Figure 2-15 shows the result.

| RsvpForm X

- C | ® localhost:57628/Home/RsvpForm 7% [

This is the RsvpForm.cshtml View

Figure 2-15. Rendering a second view

Linking Action Methods

I want to be able to create a link from the MyView view so that guests can see the RsvpForm view without
having to know the URL that targets a specific action method, as shown in Listing 2-11.

Listing 2-11. Adding a Link to the RSVP Form in the MyView.cshtml File

o{

Layout = null;
}
<!DOCTYPE html>
<html>
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<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
</head>
<body>
<div>
@ViewBag.Greeting World (from the view)
<p>We're going to have an exciting party.<br />
(To do: sell it better. Add pictures or something.)
</p>
<a asp-action="RsvpForm">RSVP Now</a»
</div>
</body>
</html>

The addition to the listing is an a element that has an asp-action attribute. The attribute is an example
of a tag helper attribute, which is an instruction for Razor that will be performed when the view is rendered.
The asp-action attribute is an instruction to add a href attribute to the a element that contains a URL for
an action method. I explain how tag helpers work in Chapters 24, 25, and 26, but this is the simplest type
of tag helper attribute for a elements, and it tells Razor to insert a URL for an action method defined by the
same controller for which the current view is being rendered. You can see the link that the helper creates by
starting the project, as shown in Figure 2-16.

| RsvpForm

& > C | @ localhost:57628

| € C | ® localhost:57628/Home/RsvpFo ¥ | &

Good Moming World (from the view)

We're going to have an exciting party. This is the RsvpForm.cshtml View

(To do: sell it better. Add pictures ge€omething.)

RSVP Now

Figure 2-16. Linking between action methods

Start the application and roll the mouse over the RSVP Now link the browser. You will see that the link
points to the following URL (allowing for the different port number that Visual Studio will have assigned to
your project):

http://localhost:57628/Home/RsvpForm

There is an important principle at work here, which is that you should use the features provided by
MVC to generate URLs, rather than hard-code them into your views. When the tag helper created the href
attribute for the a element, it inspected the configuration of the application to figure out what the URL
should be. This allows the configuration of the application to be changed to support different URL formats
without needing to update any views. I explain how this works in Chapter 15.
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Building the Form

Now that I have created the strongly typed view and can reach it from the Index view, I am going to build out
the contents of the RsvpForm. cshtml file to make it into an HTML form for editing GuestResponse objects, as
shown in Listing 2-12.

Listing 2-12. Creating a Form View in the RsvpForm.cshtml File

@model PartyInvites.Models.GuestResponse

of

}

<!DOCTYPE html>

Layout = null;

<html>

<head>
<meta name="viewport" content="width=device-width" />
<title>RsvpForm</title>

</head>
<body>
<form asp-action="RsvpForm" method="post"»
<p>
<label asp-for="Name"s>Your name:</labels
<input asp-for="Name" />
</p>
<p>
<label asp-for="Email"»Your email:</labels
<input asp-for="Email" />
</p>
<p>
<label asp-for="Phone"»Your phone:</labels
<input asp-for="Phone" /></p>
<p>
<label>Will you attend?</labels
<select asp-for="WillAttend"s
<option value=""»>Choose an option</option>
<option value="true"sYes, I'll be there</option>
<option value="false">No, I can't come</option»
</select>
</p>
<button type="submit">Submit RSVP</button>
</foxm>
</body>
</html>

I have defined a 1abel and input element for each property of the GuestResponse model class (or, in
the case of the WillAttend property, a select element). Each element is associated with the model property
using the asp-for attribute, which is another tag helper attribute. The tag helper attributes configure the
elements to tie them to the model object. Here is an example of the HTML that the tag helpers produce and
which is sent to the browser:
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<p>
<label for="Name">Your name:</label>
<input type="text" id="Name" name="Name" value=
</p>

>

The asp-for attribute on the label element sets the value of the for attribute. The asp-for attribute
on the input element sets the id and name elements. This doesn’t look especially useful at the moment, but
you will see that associating elements with a model property offers additional advantages as the application
functionality is defined.

Of more immediate use is the asp-action attribute applied to the form element, which uses the
application’s URL routing configuration to set the action attribute to a URL that will target a specific action
method, like this:

<form method="post" action="/Home/RsvpForm">

As with the helper attribute I applied to the a element, the benefit of this approach is that you can
change the system of URLs that the application uses and the content generated by the tag helpers will reflect
the changes automatically.

You can see the form by running the application and clicking the RSVP Now link, as shown in Figure 2-17.

X

| RsvpForm
= C | ® localhost:57628/Home/RsvpForm w| ¢
Your name: |
Your email: |
Your phone:

Will you attend? | Choose an option ¥

Submit RSVP |

Figure 2-17. Adding an HTML form to the application

Receiving Form Data

I have not yet told MVC what I want to do when the form is posted to the server. As things stand, clicking the
Submit RSVP button just clears any values you have entered into the form. That is because the form posts
back to the RsvpForm action method in the Home controller, which just tells MVC to render the view again.
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To receive and process submitted form data, I am going to use a core controller feature. I will add a second
RsvpForm action method to create the following:

e A method that responds to HTTP GET requests: A GET request is what a browser
issues normally each time someone clicks a link. This version of the action will be
responsible for displaying the initial blank form when someone first visits /Home/
RsvpForm.

e A method that responds to HTTP POST requests: By default, forms rendered using
Html.BeginForm() are submitted by the browser as a POST request. This version of
the action will be responsible for receiving submitted data and deciding what to do
with it.

Handing GET and POST requests in separate C# methods helps to keep my controller code tidy, since the
two methods have different responsibilities. Both action methods are invoked by the same URL, but MVC
makes sure that the appropriate method is called, based on whether I am dealing with a GET or POST request.
Listing 2-13 shows the changes to the HomeController class.

Listing 2-13. Adding an Action Method to Support POST Requests in the HomeController.cs File

using System;
using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;

namespace PartyInvites.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
int hour = DateTime.Now.Hour;
ViewBag.Greeting = hour < 12 ? "Good Morning" : "Good Afternoon";
return View("MyView");

}

[HttpGet]

public ViewResult RsvpForm() {
return View();

}

[HttpPost]

public ViewResult RsvpForm(GuestResponse guestResponse) {
// TODO: store repsonse from guest
return View();

I'have added the HttpGet attribute to the existing RsvpForm action method. This tells MVC that this
method should be used only for GET requests. I then added an overloaded version of the RsvpForm method,
which accepts a GuestResponse object. I applied the HttpPost attribute to this method, which tells MVC
that the new method will deal with POST requests. I explain how these additions to the listing work in the
following sections. I also imported the PartyInvites.Models namespace—this is just so I can refer to the
GuestResponse model type without needing to qualify the class name.
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Using Model Binding

The first overload of the RsvpForm action method renders the same view as before—the RsvpForm.cshtml
file—to generate the form shown in Figure 2-17. The second overload is more interesting because of the
parameter, but given that the action method will be invoked in response to an HTTP POST request and that
the GuestResponse type is a C# class, how are the two connected?

The answer is model binding, a useful MVC feature whereby incoming data is parsed and the key/value
pairs in the HTTP request are used to populate properties of domain model types.

Model binding is a powerful and customizable feature that eliminates the grind and toil of dealing with
HTTP requests directly and lets you work with C# objects rather than dealing with individual data values
sent by the browser. The GuestResponse object that is passed as the parameter to the action method is
automatically populated with the data from the form fields. I dive into the detail of model binding, including
how it can be customized, in Chapter 26.

One of the application goals is to present a summary page with details of who is attending, which means
that I need to keep track of the responses that I receive. I am going to do this by creating an in-memory
collection of objects. This isn’t useful in a real application because the response data will be lost when the
application is stopped or restarted, but this approach will allow me to keep the focus on MVC and create an
application that can easily be reset to its initial state.

Tip | demonstrate how MVC can be used to store and access data persistently in Chapter 8 as part of a
more realistic example application.

I added a file to the project by right-clicking the Models folder and selecting Add » Class from the pop-
up menu. I set the name of the file to Repository.cs and used it to define the class shown in Listing 2-14.

Listing 2-14. The Contents of the Repository.cs File in the Models Folder
using System.Collections.Generic;
namespace PartyInvites.Models {

public static class Repository {
private static List<GuestResponse> responses = new List<GuestResponse>();

public static IEnumerable<GuestResponse> Responses {
get {
return responses;
}

}

public static void AddResponse(GuestResponse response) {
responses.Add(response);
}

The Repository class and its members are static, which will make it easy for me to store and retrieve
data from different places in the application. MVC provides a more sophisticated approach for defining
common functionality, called dependency injection, which I describe in Chapter 18, but a static class is a
good way to get started for a simple application like this one.
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Storing Responses

Now that I have somewhere to store the data, I can update the action method that receives the HTTP POST
requests, as shown in Listing 2-15.

Listing 2-15. Updating an Action Method in the HomeController.cs File

using System;
using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;

namespace PartyInvites.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
int hour = DateTime.Now.Hour;
ViewBag.Greeting = hour < 12 ? "Good Morning" : "Good Afternoon";
return View("MyView");

}

[HttpGet]

public ViewResult RsvpForm() {
return View();

}

[HttpPost]

public ViewResult RsvpForm(GuestResponse guestResponse) {
Repository.AddResponse(guestResponse);
return View("Thanks", guestResponse);

AllThave to do to deal with the form data sent in a request is to work with the GuestResponse object
that is passed to the action method—in this case, to pass it as an argument to the Repository.AddResponse
method so that the response can be stored.

WHY MODEL BINDING IS NOT LIKE WEB FORMS

In Chapter 1, | explained that one of the disadvantages of traditional ASP.NET Web Forms is that it hides
the details of HTTP and HTML from the developers. You may be wondering whether the MVC model
binding that | used to create a GuestResponse object from an HTTP POST request in Listing 2-15 is
doing the same thing.

It isn’t. Model binding frees me from the tedious and error-prone task of having to inspect an HTTP
request and extract all the data values that | require, but (and this is the important part) if | wanted to
process a request manually, | could do so because MVC provides easy access to all of the request data.
Nothing is hidden from the developer, but there are a number of useful features that make working with
HTTP and HTML simpler and easier; however, using these features is optional.
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This may seem like a subtle difference, but as you learn more about MVC, you will see that the
development experience is completely different from traditional Web Forms and that you are always
aware of how the requests your application receives are handled.

The call to the View method in the RsvpForm action method tells MVC to render a view called Thanks
and to pass the GuestResponse object to the view. To create the view, right-click the Views/Home folder in the
Solution Explorer and select Add » New Item from the pop-up menu. Select the MVC View Page template in
the ASP.NET category, set the name to Thanks.cshtml, and click the Add button. Visual Studio will create the
Views/Home/Thanks.cshtml file and open it for editing. Change the contents of the file to match Listing 2-16.

Listing 2-16. The Contents of the Thanks.cshtml File in the Views/Home Folder

@model PartyInvites.Models.GuestResponse

of

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />
<title>Thanks</title>
</head>
<body>
<p>
<h1>Thank you, @Model.Name!</h1>
@if (Model.WillAttend == true) {
@:It's great that you're coming. The drinks are already in the fridge!
} else {
@:Sorry to hear that you can't make it, but thanks for letting us know.
}

</p>

<p>Click <a asp-action="ListResponses">here</a> to see who is coming.</p>
</body>
</html>

The Thanks.cshtml view uses Razor to display content based on the value of the GuestResponse
properties that I passed to the View method in the RsvpForm action method. The Razor @model expression
specifies the domain model type with which the view is strongly typed.

To access the value of a property in the domain object, I use Model.PropertyName. For example, to get
the value of the Name property, I call Model.Name. Don’t worry if the Razor syntax doesn’t make sense—I
explain it in more detail in Chapter 5.

Now that I have created the Thanks view, I have a basic working example of handling a form with MVC.
Start the application in Visual Studio by selecting Start Debugging from the Debug menu, click the RSVP
Now link, add some data to the form, and click the Submit RSVP button. You will see the result shown in
Figure 2-18 (although it will differ if your name is not Joe or you said you could not attend).
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|- RsvpForm

i

C | @ localhost:57628/Home/RsvpForm

(5 C | @ localhost:57628/Home/RsvpForm | @

Your name: Joe

Thank you, Joe!

Your email: joe@example.com

Your phone: |555-1234 It's great that you're coming. The drinks are already mn the fndge!

Will you attend? | Yes, I'll be there Click here to see who 1s coming.

Submit RSVP

Figure 2-18. The Thanks view

Displaying the Responses

At the end of the Thanks.cshtml view, I added an a element to create a link to display the list of people who
are coming to the party. [ used the asp-action tag helper attribute to create a URL that targets an action
method called ListResponses, like this:

<p>Click <a asp-action="ListResponses">here</a> to see who is coming.</p>

If you hover the mouse over the link that is displayed by the browser, you will see that it targets the
/Home/ListResponses URL. This doesn’t correspond to any of the action methods in the Home controller, and
if you click the link, you will see an empty page. Opening the browser’s developer tools and looking at the
response sent by the server will reveal that a 404 - Not Found error was sent back by the server (Chrome is
a little odd in that it doesn’t display an error message to the user, but I explain how to generate meaningful
error messages in Chapter 14).

I am going to fix the problem by creating the action method that the URL targets in the Home controller,
as shown in Listing 2-17.

Listing 2-17. Adding an Action Method in the HomeController.cs File

using System;

using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;
using System.Ling;

namespace PartyInvites.Controllers {
public class HomeController : Controller {
public ViewResult Index() {
int hour = DateTime.Now.Hour;

ViewBag.CGreeting = hour < 12 ? "Good Morning" : "Good Afternoon";
return View("MyView");
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[HttpGet]

public ViewResult RsvpForm() {
return View();

}

[HttpPost]

public ViewResult RsvpForm(GuestResponse guestResponse) {
Repository.AddResponse(guestResponse);
return View("Thanks", guestResponse);

}

public ViewResult ListResponses() {
return View(Repository.Responses.Where(r => r.WillAttend == true));
}

The new action method is called ListResponses, and it calls the View method, using the Repository.
Responses property as the argument. This is how an action method provides data to a strongly typed view.
The collection of GuestResponse objects is filtered using LINQ so that only positive responses are used.

The ListResponses action method doesn’t specify the name of the view that should be used to display
the collection of GuestResponse objects, which means that the default naming convention will be used
and MVC will look for a view called ListResponses.cshtml in the Views/Home and Views/Shared folders.
To create the view, right-click the Views/Home folder in the Solution Explorer and select Add » New Item
from the pop-up menu. Select the MVC View Page template in the ASP.NET category, set the name to
ListResponses.cshtml, and click the Add button. Edit the contents of the new view to match Listing 2-18.

Listing 2-18. Displaying the Acceptances in the ListResponses.cshtml File in the Views/Home Folder

@model IEnumerable<PartyInvites.Models.GuestResponse>

of
Layout = null;
}

<!DOCTYPE html>

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Responses</title>
</head>
<body>
<h2>Here is the list of people attending the party</h2>
<table>
<thead>
<tr>
<th>Name</th>
<th>Email</th>
<th>Phone</th>
</tr>
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</thead>
<tbody>
@foreach (PartyInvites.Models.GuestResponse r in Model) {
<tr>
<td>@r.Name</td>
<td>@r.Email</td>
<td>@r.Phone</td>
</tr>
}
</tbody>
</table>
</body>
</html>

Razor view files have the cshtml file extension because they are a mix of C# code and HTML elements.
You can see this in Listing 2-18 where I have used a foreach loop to process each of the GuestResponse
objects that the action method passes to the view using the View method. Unlike a normal C# foreach
loop, the body of a Razor foreach loop contains HTML elements that are added to the response that will be
sent back to the browser. In this view, each GuestResponse object generates a tr element that contains td
elements populated with the value of an object property.

To see the list at work, run the application by selecting Start Debugging from the Start menu, submit
some form data, and then click the link to see the list of responses. You will see a summary of the data you
have entered since the application was started, as shown in Figure 2-19. The view does not present the data
in an appealing way, but it is enough for the moment, and I will address the styling of the application later in
this chapter.

|  Responses X

- C | @ localhost:57628/Home/ListResponses ol

Here is the list of people attending the party

Name Email Phone
Joe  joe@example.com 555-1234
Alice alice@example.com 555-5678

Figure 2-19. Showing a list of party attendees

Adding Validation

I am now in a position to add data validation to my application. Without validation, users could enter
nonsense data or even submit an empty form. In an MVC application, you will typically apply validation to
the domain model rather than in the user interface. This means that you define validation in one place, but
it takes effect anywhere in the application that the model class is used. MVC supports declarative validation
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rules defined with attributes from the System.ComponentModel.DataAnnotations namespace, meaning
that validation constraints are expressed using the standard C# attribute features. Listing 2-19 shows how I
applied these attributes to the GuestResponse model class.

Listing 2-19. Applying Validation in the GuestResponse.cs File

using System.ComponentModel.DataAnnotations;
namespace PartyInvites.Models {
public class GuestResponse {

[Required(ErrorMessage = "Please enter your name")]
public string Name { get; set; }

[Required(ErrorMessage = "Please enter your email address")]
[RegularExpression(".+\\@.+\\..+",

ErrorMessage = "Please enter a valid email address")]
public string Email { get; set; }

[Required(ErrorMessage = "Please enter your phone number")]
public string Phone { get; set; }

[Required(ErrorMessage = "Please specify whether you'll attend")]
public bool? WillAttend { get; set; }

MVC automatically detects the attributes and uses them to validate data during the model-binding
process. I imported the namespace that contains the validation attributes, so I can refer to them without
needing to qualify their names.

Tip As noted earlier, | used a nullable bool for the WillAttend property. | did this so that | could apply the
Required validation attribute. If | had used a regular bool, the value | received through model binding could be
only true or false, and | would not be able to tell whether the user had selected a value. A nullable bool has
three possible values: true, false, and null. The browser sends a null value if the user has not selected a
value, and this causes the Required atiribute to report a validation error. This is a nice example of how MVC
elegantly blends C# features with HTML and HTTP.

I check to see whether there has been a validation problem using the ModelState.IsValid property in
the controller class. Listing 2-20 shows how I have done this in the POST-enabled RsvpForm action method in
the Home controller class.

Listing 2-20. Checking for Form Validation Errors in the HomeController.cs File

using System;

using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;
using System.Lling;
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namespace PartyInvites.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
int hour = DateTime.Now.Hour;
ViewBag.Greeting = hour < 12 ? "Good Morning" : "Good Afternoon";
return View("MyView");

}

[HttpGet]
public ViewResult RsvpForm() {
return View();

[HttpPost]
public ViewResult RsvpForm(GuestResponse guestResponse) {
if (ModelState.IsValid) {
Repository.AddResponse(guestResponse);
return View("Thanks", guestResponse);
} else {
// there is a validation error
return View();

}

public ViewResult ListResponses() {
return View(Repository.Responses.Where(r => r.WillAttend == true));
}

The Controller base class provides a property called ModelState that provides information about the
conversion of HTTP request data into C# objects. If the ModelState. IsValue property returns true, then I
know that MVC has been able to satisfy the validation constraints I specified through the attributes on the
GuestResponse class. When this happens, I render the Thanks view, just as I did previously.

If the ModelState.IsValue property returns false, then I know that there are validation errors. The
object returned by the ModelState property provides details of each problem that has been encountered, but
I don’t need to get into that level of detail, because I can rely on a useful feature that automates the process
of asking the user to address any problems by calling the View method without any parameters.

When MVC renders a view, Razor has access to the details of any validation errors associated with the
request, and tag helpers can access the details to display validation errors to the user. Listing 2-21 shows the
addition of validation tag helper attributes to the RsvpForm view.

Listing 2-21. Adding a Validation Summary to the RsvpForm.cshtml File

@model PartyInvites.Models.GuestResponse
of
}

Layout = null;
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<!DOCTYPE html>

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>RsvpForm¢/title>
</head>
<body>
<form asp-action="RsvpForm" method="post">
<div asp-validation-summary="A11"></div>
<p>
<label asp-for="Name">Your name:</label>
<input asp-for="Name" />
</p>
<p>
<label asp-for="Email">Your email:</label>
<input asp-for="Email" />
</p>
<p>
<label asp-for="Phone">Your phone:</label>
<input asp-for="Phone" /></p>
<p>
<label>Will you attend?</label>
<select asp-for="WillAttend">
<option value="">Choose an option</option>
<option value="true">Yes, I'll be there</option>
<option value="false">No, I can't come</option>
</select>
</p>
<button type="submit">Submit RSVP</button>
</form>
</body>
</html>

The asp-validation-summary attribute is applied to a div element, and it displays a list of validation
errors when the view is rendered. The value for the asp-validation-summary attribute is a value from an
enumeration called ValidationSummary, which specifies what types of validation errors the summary will
contain. I specified A11, which is a good starting point for most applications, and I describe the other values
and explain how they work in Chapter 27.

To see how the validation summary works, run the application, fill out the Name field, and submit the
form without entering any other data. You will see a summary of validation errors, as shown in Figure 2-20.
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| RsvpForm X

¢ C | © localhost:57628/Home/RsvpForm o

waw

e Please enter your email address

e Please enter your phone number

¢ Please specify whether you'll attend
Your name: Joe

Your emal:

Your phone:
Will vou attend? | Choose an option ¥

Submit RSVP |

Figure 2-20. Displaying validation errors

The RsvpForm action method will not render the Thanks view until all of the validation constraints
applied to the GuestResponse class have been satisfied. Notice that the data entered into the Name field was
preserved and displayed again when Razor rendered the view with the validation summary. This is another
benefit of model binding, and it simplifies working with form data.

Note If you have worked with ASP.NET Web Forms, you will know that Web Forms has a concept of server
controls that retain state by serializing values into a hidden form field called _ VIEWSTATE. MVC model binding
is not related to the Web Forms concepts of server controls, postbacks, or View State. MVC does not inject a
hidden _ VIEWSTATE field into your rendered HTML pages. Instead, it includes the data by setting the value
attributes of the input element.

Highlighting Invalid Fields

The tag helper attributes that associate model properties with elements have a handy feature that can be
used in conjunction with model binding. When a model class property has failed validation, the helper
attributes will generate slightly different HTML. Here is the input element that is generated for the Phone
field when there is no validation error:

<input type="text" data-val="true" data-val-required="Please enter your phone number"
id="Phone" name="Phone" value="">
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For comparison, here is the same HTML element after the user has submitted the form without entering
any data into the text field (which is a validation error because I applied the Required validation attribute to
the Phone property of the GuestResponse class):

<input type="text" class="input-validation-error" data-val="true"
data-val-required="Please enter your phone number" id="Phone"
name="Phone" value="">

I have highlighted the difference: the asp-for tag helper attribute added the input element to a class
called input-validation-error. I can take advantage of this feature by creating a stylesheet that contains
CSS styles for this class and the others that different HTML helper attributes use.

The convention in MVC projects is that static content delivered to clients is placed into the wwwroot
folder, organized by content type, so that CSS stylesheets go into the wawroot/css folder, JavaScript files go
into the wwwroot/js folder, and so on.

To create the stylesheet, right-click the wawroot/css folder in the Visual Studio Solution Explorer, select
Add » New Item, navigate to the Client-side section, and select Style Sheet from the list of templates, as
shown in Figure 2-21.

Add New Iltem - Partylnvites

| 4 Installed Sort by: Default - g;! = Search Installed Templates (Ctrl+E) L~
ASP.NET - T
S I_j HTML Page Client-side Type: Client-side
= <o
Cod 5 A cascading style sheet (CS5) used for rich
15 i
e EJ JavaScript File Client-side HTML style definitions
b Online
Style Sheet Client-side
EI TypeScript File Client-side
-Ts -
&' TypeScript JSX File Client-side
°| I TypeScript JSON Configuration File Client-side
f I Bower Configuration File Client-side
° b

Click here to go online and find templates.

Name: styles.css

Add ] | Cancel

Figure 2-21. Creating a CSS stylesheet

Tip  Visual Studio creates a style.css file in the wwwroot/css folder when a project is created using the
Web Application template. You can ignore this file, which | don’t use in this chapter.

Set the name of the file to styles.css, click the Add button to create the stylesheet, and edit the new file
so that it contains the styles shown in Listing 2-22.
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Listing 2-22. The Contents of the styles.css File

.field-validation-error {color: #f00;}

.field-validation-valid { display: none;}

.input-validation-error { border: 1px solid #f00; background-color: #fee; }
.validation-summary-errors { font-weight: bold; color: #f00;}
.validation-summary-valid { display: none;}

To apply this stylesheet, I have added a 1ink element to the head section of the RsvpForm view, as shown
in Listing 2-23.

Listing 2-23. Applying a Stylesheet in the RsvpForm.cshtml File

<head>
<meta name="viewport" content="width=device-width" />
<title>RsvpForm¢/title>
<link rel="stylesheet" href="/css/styles.css" />
</head>

The link element uses the href attribute to specify the location of the stylesheet. Notice that
the wwwroot folder is omitted from the URL. The default configuration for ASP.NET includes support
for serving static content, such as images, CSS stylesheets, and JavaScript files, and it maps requests
to the wwwroot folder automatically. I describe the ASP.NET and MVC configuration process in
Chapter 14.

Tip There is a special tag helper for dealing with stylesheets that can be useful if you have a lot of files to
manage. See Chapter 25 for details.

With the application of the style sheet, a more visually obvious validation error will be displayed when
data is submitted that causes a validation error, as shown in Figure 2-22.

44

VN Secret
Www.vnsecret.com


http://dx.doi.org/10.1007/978-1-4842-0397-2_14
http://dx.doi.org/10.1007/978-1-4842-0397-2_25

CHAPTER 2 © YOUR FIRST MVC APPLICATION

| RsvpForm X

< C | © localhost:57628/Home/RsvpForm w o

¢ Please enter vour email address
¢ Please enter vour phone number
* Please specify whether you'll attend

Your name: Joe

Your emaul: | |

Your phone: | |

Will you attend? | Choose an option ¥

| Submit RSVP

Figure 2-22. Automatically highlighted validation errors

Styling the Content

All of the functional goals for the application are complete, but the overall appearance of the application
is poor. When you create a project using the Web Application template, as I did for the example in this
chapter, Visual Studio installs some common client-side development packages. While I am not a fan of
using template projects, I do like the client-side libraries that Microsoft has chosen. One of them is called
Bootstrap, which is a nice CSS framework originally developed by Twitter that has become a major open
source project in its own right and which has become a mainstay of web application development.

Note Bootstrap 3 is the current version as | write this but version 4 is under development. Microsoft may
choose to update the version of Bootstrap used by the Web Application template in later releases of Visual
Studio, which may cause the content to display differently. This won’t be a problem for the other chapters in the
book because | show you how to explicitly specify a package version so that you get the expected results.

Styling the Welcome View

The basic Bootstrap features work by applying classes to elements that correspond to CSS selectors defined
in the files added to the wawroot/1ib/bootstrap folder. You can get full details of the classes that Bootstrap
defines from http://getbootstrap.com, but you can see how I have applied some basic styling to the
MyView.cshtml view file in Listing 2-24.
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Listing 2-24. Adding Bootstrap to the MyView.cshtml File
of

}

<!DOCTYPE html>

Layout = null;

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
<link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
</head>
<body>
<div class="text-center"s
<h3s>We're going to have an exciting party!</h3»
<h4>And you are invited</h4>
<a class="btn btn-primary" asp-action="RsvpForm">RSVP Now</a»
</div>
</body>
</html>

I have added 1ink element whose href attribute loads the bootstrap.css file from the wawroot/1ib/
bootstrap/dist/css folder. The convention is that third-party CSS and JavaScript packages are installed
into the wwwroot/1ib folder, and I describe the tool that is used to manage these packages in Chapter 6.

Having imported the Bootstrap stylesheets, I need to style my elements. This is a simple example and so
I only need to use a small number of Bootstrap CSS classes: text-center, btn, and btn-primary.

The text-center class centers the content of an element and its children. The btn class styles a button,
input, or a element as a pretty button, and the btn-primary specifies which of a range of colors I want the
button to be. You can see the effect by running the application, as shown in Figure 2-23.

| Index x

C | ® localhost:57628 ) * gl -

We're going to have an exciting party!
And you are invited

RSVP Now

Figure 2-23. Styling a view
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It will be obvious to you that I am not a web designer. In fact, as a child, I was excused from art lessons
on the basis that I had absolutely no talent whatsoever. This had the happy result of making more time for
math lessons but meant that my artistic skills have not developed beyond those of the average 10-year-old.
For a real project, I would seek a professional to help design and style the content, but for this example I am
going it alone, and that means applying Bootstrap with as much restraint and consistency as I can muster.

Styling the RsvpForm View

Bootstrap defines classes that can be used to style forms. I am not going to go into detail, but you can see
how I have applied these classes in Listing 2-25.

Listing 2-25. Adding Bootstrap to the RsvpForm.cshtml File

@model PartyInvites.Models.GuestResponse

ef

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />
<title>RsvpForm</title>
<link rel="stylesheet" href="/css/styles.css" />
<link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
</head>
<body>
<div class="panel panel-success"»
<div class="panel-heading text-center"»<h4>RSVP</h4></div>
<div class="panel-body">
<foxrm class="p-a-1" asp-action="RsvpForm" method="post">
<div asp-validation-summary="A11"»</div>
<div class="form-group"»
<label asp-for="Name"»Your name:</label>
<input class="form-control” asp-for="Name" />
</div»
<div class="form-group"s
<label asp-for="Email"»Your email:</labels
<input class="form-control" asp-for="Email" />
</div>
<div class="form-group"s
<label asp-for="Phone"s>Your phone:</label>
<input class="form-control" asp-for="Phone" /»
</div>
<div class="form-group"»
<label>Will you attend?</labels
<select class="form-control” asp-for="WillAttend"»
<option value=""»>Choose an option</option>
<option value="true">Yes, I'll be there</option>
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<option value="false"s>No, I can't come</option»
</select>
</div»
<div class="text-center"»
<button class="btn btn-primary" type="submit"s
Submit RSVP
</button>
</divy
</formy
</div»
</div>
</body>
</html>

The Bootstrap classes in this example create a header, just to give structure to the layout. To style the
form, I have used the form-group class, which is used to style the element that contains the label and the
associated input or select element. You can see the effect of the styles in Figure 2-24.

| RsvpForm X

& C | ® localhost:57628/Home/RsvpForm ol o

RSVP

Your name:
Your email:
Your phone:

Will you attend?

Choose an option v

Submit RSVP

Figure 2-24. Styling the RsvpForm view
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Styling the Thanks View

The next view file to style is Thanks.cshtml, and you can see how I have done this in Listing 2-26, using CSS
classes that are similar to the ones I used for the other views. To make an application easier to manage, it is
a good principle to avoid duplicating code and markup wherever possible. MVC provides several features
to help reduce duplication, which I describe in later chapters. These features include Razor layouts
(Chapter 5), partial views (Chapter 21), and view components (Chapter 22).

Listing 2-26. Applying Bootstrap to the Thanks.cshtml File

@model PartyInvites.Models.GuestResponse
of
}

<!DOCTYPE html>

Layout = null;

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Thanks</title>
<link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
</head>
<body class="text-center"»
<p>
<h1>Thank you, @Model.Name!</h1>
@if (Model.WillAttend == true) {
@:It's great that you're coming. The drinks are already in the fridge!
} else {
@:Sorry to hear that you can't make it, but thanks for letting us know.
}

</p>
Click <a class="nav-link" asp-action="ListResponses"shere</as
to see who is coming.

</body>

</html>

Figure 2-25 shows the effect of the styles.
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|  Thanks b 4

— C | @ localhost:57628/Home/RsvpForm b e

Thank you, Joe!

It's great that you're coming. The drinks are already in the fridge!

Click here to see who is coming.

Figure 2-25. Styling the Thanks view

Styling the List View

The final view to style is ListResponses, which presents the list of attendees. Styling the content follows the
same basic approach as used for all Bootstrap styles, as shown in Listing 2-27.

Listing 2-27. Adding Bootstrap to the ListResponses.cshtml File

@model IEnumerable<PartyInvites.Models.GuestResponse>

o{

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />
<link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" /»
<title>Responses</title>
</head>
<body>
<div class="panel-body">
<h2>Here is the list of people attending the party</h2>
<table class="table table-sm table-striped table-bordered"»
<thead>
<tr>
<th>Name</th>
<th>Email</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
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@foreach (PartyInvites.Models.GuestResponse r in Model) {

<tr>
<td>@r.Name</td>
<td>@r.Email</td>
<td>@r.Phone</td>
</tr>
}
</tbody>
</table>
</div>
</body>
</html>

Figure 2-26 shows the way that the table of attendees is presented. Adding these styles to the view
completes the example application, which now meets all of the development goals and has a much
improved appearance.

| Responses x

i C | ® localhost:57628/Home/ListResponses I

Here is the list of people attending the party

Name Email Phone

Joe joe @example.com 555-1234
Alice alice @example.com 555-5678
Bob bob@example.com 255-2345

Figure 2-26. Styling the ListResponses view

Summary

In this chapter, I created a new MVC project and used it to construct a simple data-entry application, giving
you a first glimpse of the ASP.NET Core MVC architecture and approach. I skipped over some key features
(including Razor syntax, routing, and testing), but I return to these topics in depth in later chapters. In the
next chapter, I describe the MVC design patterns, which form the foundation for effective development with
ASP.NET Core MVC.
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The MVC Pattern, Projects, and
Conventions

Before digging into the details of ASP.NET Core MVC, I want to make sure you are familiar with the MVC
design pattern, the thinking behind it, and the way it is translated into ASP.NET Core MVC projects.

You might already know about some of the ideas and conventions I discuss in this chapter, especially if
you have done advanced ASP.NET or C# development. If not, I encourage you to read carefully—a good
understanding of what lies behind MVC can help put the features of the framework into context as you
continue through the book.

The History of MVC

The term model-view-controller has been in use since the late 1970s and arose from the Smalltalk project
at Xerox PARC, where it was conceived as a way to organize some early GUI applications. Some of the
fine detail of the original MVC pattern was tied to Smalltalk-specific concepts, such as screens and tools,
but the broader concepts are still applicable to applications, and they are especially well suited to web
applications.

Understanding the MVC Pattern

In high-level terms, the MVC pattern means that an MVC application will be split into at least three pieces.
e Models, which contain or represent the data that users work with
e  Views, which are used to render some part of the model as a user interface

e Controllers, which process incoming requests, perform operations on the model, and
select views to render to the user

Each piece of the MVC architecture is well-defined and self-contained, which is referred to as the
separation of concerns. The logic that manipulates the data in the model is contained only in the model; the
logic that displays data is only in the view, and the code that handles user requests and input is contained
only in the controller. With a clear division between each of the pieces, your application will be easier to
maintain and extend over its lifetime, no matter how large it becomes.
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Understanding Models

Models—the M in MVC—contain the data that users work with. There are two broad types of model: view
models, which represent just data passed from the controller to the view, and domain models, which contain
the data in a business domain, along with the operations, transformations, and rules for creating, storing,
and manipulating that data, collectively referred to as the model logic.

Models are the definition of the universe your application works in. In a banking application, for example,
the model represents everything in the bank that the application supports, such as accounts, the general ledger,
and credit limits for customers, as well as the operations that can be used to manipulate the data in the model,
such as depositing funds and making withdrawals from the accounts. The model is also responsible for preserving
the overall state and consistency of the data—for example, making sure that all transactions are added to the
ledger and that a client doesn’t withdraw more money than he is entitled to or more money than the bank has.

For each of the components in the MVC pattern, I'll describe what should and should not be included.
The model in an application built using the MVC pattern should

e  Contain the domain data

e  Contain the logic for creating, managing, and modifying the domain data

e  Provide a clean API that exposes the model data and operations on it
The model should not

e  Expose details of how the model data is obtained or managed (in other words, details
of the data storage mechanism should not be exposed to controllers and views)

e  Contain logic that transforms the model based on user interaction (because that is
the controller’s job)

e  Contain logic for displaying data to the user (that is the view’s job)

The benefits of ensuring that the model is isolated from the controller and views are that you can test
your logic more easily (I describe unit testing in Chapter 7) and that enhancing and maintaining the overall
application is simpler and easier.

Tip Many developers new to the MVC pattern get confused with the idea of including logic in the data
model, believing that the goal of the MVC pattern is to separate data from logic. This is a misapprehension:
the goal of the MVC pattern is to divide an application into three functional areas, each of which may contain
both logic and data. The goal isn’t to eliminate logic from the model. Rather, it is to ensure that the model only
contains logic for creating and managing the model data.

Understanding Controllers

Controllers are the connective tissue in the MVC pattern, acting as conduits between the data model and
views. Controllers define actions that provide the business logic that operates on the data model and that
provide he data that views display to the user.

A controller built using the MVC pattern should

e  Contain the actions required to update the model based on user interaction
The controller should not
e Contain logic that manages the appearance of data (that is the job of the view)

e Contain logic that manages the persistence of data (that is the job of the model)
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Understanding Views

Views contain the logic required to display data to the user or to capture data from the user so that it can be
processed by a controller action. Views should

e  Contain the logic and markup required to present data to the user
Views should not

e  Contain complex logic (this is better placed in a controller)

e  Contain logic that creates, stores, or manipulates the domain model

Views can contain logic, but it should be simple and used sparingly. Putting anything but the simplest
method calls or expressions in a view makes the overall application harder to test and maintain.

The ASP.NET Implementation of MVC

As its name suggests, the ASP.NET Core MVC adapts the abstract MVC pattern to the world of ASP.NET and
C# development. In ASP.NET Core MVC, controllers are C# classes, usually derived from the Microsoft.
AspNetCore.Mvc.Controller class. Each public method in a class derived from Controller is an action
method, which is associated with a URL. When a request is sent to the URL associated with an action
method, the statements in that action method are executed in order to perform some operation on the
domain model and then to select a view to display to the client. Figure 3-1 shows the interactions between
the controller, model, and view.

HTTP
Request P - === persistence
(usually to a
Controller Model relational
Responéa View < ] ~— <=~ database)
Presentation
Model

Figure 3-1. The interactions in an MVC application

ASP.NET Core MVC uses a view engine, known as Razor, which is the component responsible for
processing a view in order to generate a response for the browser. Razor views are HTML templates that
contain C# logic that is used to process model data to generate dynamic content that responds to changes in
the model. I explain how Razor works in Chapter 5.

ASP.NET Core MVC doesn’t apply any constraints on the implementation of your domain model. You
can create a model using regular C# objects and implement persistence using any of the databases, object-
relational mapping frameworks, or other data tools supported by .NET.

Comparing MVC to Other Patterns

MVC is not the only software architecture pattern, of course. There are many others, and some of them are,
or at least have been, extremely popular. You can learn a lot about MVC by looking at the alternatives. In
the following sections, I briefly describe different approaches to structuring an application and contrast
them with MVC. Some of the patterns are close variations on the MVC theme, whereas others are entirely
different.
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I am not suggesting that MVC is the perfect pattern for all situations. I am a proponent of picking the
best approach to solve the problem at hand. As you will see, there are situations where some competing
patterns are as useful as or better than MVC. I encourage you to make an informed and deliberate choice
when selecting a pattern. The fact that you are reading this book suggests that you already have a certain
commitment to the MVC pattern, but it is always helpful to maintain the widest possible perspective.

Understanding the Smart Ul Pattern

One of the most common design patterns is known as the smart user interface (smart Ul). Most programmers
have created a smart UI application at some point in their careers—I certainly have. If you have used
Windows Forms or ASP.NET Web Forms, you have too.

To build a smart UI application, developers construct a user interface, often by dragging a set of
components or controls onto a design surface or canvas. The controls report interactions with the user by
emitting events for button presses, keystrokes, mouse movements, and so on. The developer adds code to
respond to these events in a series of event handlers; these are small blocks of code that are called when
a specific event on a specific component is emitted. This creates a monolithic application, as shown in
Figure 3-2. The code that handles the user interface and the business is all mixed together with no separation
of concerns at all. The code that defines the acceptable values for a data input and that queries for data or
modifies a user account ends up in little pieces, coupled together by the order in which events are expected.

Request = [===P persistence
(usually to a

Smart Ul relational

Response < <@ ==* Jatabase)

Figure 3-2. The smart Ul pattern

Smart Uls are ideal for simple projects because you can get some good results quickly (by comparison
to MVC development, which, as you'll see in Chapter 8, requires an initial investment before delivering
results). Smart Uls are also suited to user interface prototyping. These design surface tools can be really
good, and if you are sitting with a customer and want to capture the requirements for the look and flow of the
interface, a smart Ul tool can be a quick and responsive way to generate and test different ideas.

The biggest drawback is that smart Uls are difficult to maintain and extend. Mixing the domain model
and business logic code in with the user interface code leads to duplication, where the same fragment of
business logic is copied and pasted to support a newly added component. Finding all the duplicate parts and
applying a fix can be difficult. It can be almost impossible to add a new feature without breaking an existing
one. Testing a smart Ul application can also be difficult. The only way is to simulate user interactions, which
is far from ideal and a difficult basis from which to provide full test coverage.

In the world of MVC, the smart Ul is often referred to as an anti-pattern: something that should be
avoided at all costs. This antipathy arises, at least in part, because people come to MVC looking for an
alternative after spending part of their careers trying to develop and maintain smart UI applications that
grow out of control.

That said, it is a mistake to reject the smart UI pattern out of hand. Not everything is rotten in the smart
Ul pattern, and there are positive aspects to this approach. Smart UI applications are quick and easy to
develop. The component and design tool producers have put a lot of effort into making the development
experience a pleasant one, and even the most inexperienced programmer can produce something
professional-looking and reasonably functional in just a few hours.
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The biggest weakness of smart UI applications—maintainability—doesn’t arise in small development
efforts. If you are producing a simple tool for a small audience, a smart UI application can be a good
solution. The additional complexity of an MVC application simply isn’t warranted.

Understanding the Model-View Architecture

The area in which maintenance problems tend to arise in a smart UI application is in the business logic,
which ends up so diffused across the application that making changes or adding features becomes a fraught
process. An improvement in this area is offered by the model-view architecture, which pulls out the business
logic into a separate domain model. In doing this, the data, processes, and rules are all concentrated in one
part of the application, as shown in Figure 3-3.

Request = o EEm—— === persistence
(usually to a
(View) Model relational

Response <¢— — <@ ==* database)

Figure 3-3. The model-view pattern

The model-view architecture can be an improvement over the monolithic smart UI pattern—it is much
easier to maintain, for example—but two problems arise. The first is that since the UI and the domain model
are closely integrated, it can be difficult to perform unit testing on either. The second problem arises from
practice, rather than the definition of the pattern. The model typically contains a mass of data access code—
this need not be the case, but it usually is—and this means that the data model does not contain just the
business data, operations, and rules.

Understanding Classic Three-Tier Architectures

To address the problems of the model-view architecture, the three-tier or three-layer pattern separates the
persistence code from the domain model and places it in a new component called the data access layer
(DAL). This is shown in Figure 3-4.

Request— — ———>|  Dpata [==P Persistence
I
" Model Access (‘:Zf,’:ﬁi;z,a
Response ogf—— ( |EW] B ——— B —— Laver == darabase}

Figure 3-4. The three-tier pattern

The three-tier architecture is the most widely used pattern for business applications. It has no
constraints on how the Ul is implemented and provides good separation of concerns without being too
complicated. And, with some care, the DAL can be created so that unit testing is relatively easy. You can see
the obvious similarities between a classic three-tier application and the MVC pattern. The difference is that
when the Ul layer is directly coupled to a click-and-event GUI framework (such as Windows Forms or ASP.
NET Web Forms), it becomes almost impossible to perform automated unit tests. And because the UI part of
a three-tier application can be complex, there’s a lot of code that can’t be rigorously tested.
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In the worst scenario, the three-tier pattern’s lack of enforced discipline in the UI tier means that many
such applications end up as thinly disguised smart UI applications, with no real separation of concerns. This
gives the worst possible outcome: an untestable, unmaintainable application that is excessively complex.

Understanding Variations on MVC

I have already described the core design principles of MVC applications, especially as they apply to the ASP.
NET Core MVC. Others interpret aspects of the pattern differently and have added to, adjusted, or otherwise
adapted MVC to suit the scope and subject of their projects. In the following sections, I provide a brief
overview of the two most prevalent variations on the MVC theme. Understanding these variations is not
essential to working with ASP.NET Core MVC, and I have included this information just for completeness
because you will hear the terms used in most discussions of software patterns.

Understanding the Model-View-Presenter Pattern

Model-view-presenter (MVP) is a variation on MVC that is designed to fit more easily with stateful GUI
platforms such as Windows Forms or ASP.NET Web Forms. This is a worthwhile attempt to get the best
aspects of the smart UI pattern without the problems it usually brings.

In this pattern, the presenter has the same responsibilities as an MVC controller, but it also takes a more
direct relationship to a stateful view, directly managing the values displayed in the UI components according
to the user’s inputs and actions. There are two implementations of this pattern.

e  The passive view implementation, in which the view contains no logic. The view is a
container for UI controls that are directly manipulated by the presenter.

e The supervising controller implementation, in which the view may be responsible
for some elements of presentation logic, such as data binding, and has been given a
reference to a data source from the domain models.

The difference between these two approaches relates to how intelligent the view is. Either way, the
presenter is decoupled from the GUI framework, which makes the presenter logic simpler and suitable for
unit testing.

Understanding the Model-View-View Model Pattern

The model-view-view model (MVVM) pattern is a recent variation on MVC. It originated from Microsoft and
is used in the Windows Presentation Foundation (WPF). In the MVVM pattern, models and views have the
same roles as they do in MVC. The difference is the MVVM concept of a view model, which is an abstract
representation of a user interface—typically a C# class that exposes both properties for the data to be
displayed in the Ul and operations on the data that can be invoked from the UI Unlike an MVC controller, an
MVVM view model has no notion that a view (or any specific UI technology) exists. An MVVM view uses the
WPF binding feature to bi-directionally associate properties exposed by controls in the view (items in a drop-
down menu, or the effect of pressing a button) with the properties exposed by the view model.

Tip The MVC pattern also uses the term view model but refers to a simple model class that is used only to
pass data from a controller to a view, as opposed to domain models, which are sophisticated representations of
data, operations, and rules.
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Understanding ASP.NET Core MVC Projects

When you create a new ASP.NET Core MVC project, Visual Studio gives you some choices about the initial
content that you want in the project. The idea is to ease the learning process for new developers and apply
some time-saving best practices for common features and tasks. I am not a fan of this kind of approach

to cookie-cutter projects or code. The intent is good, but the execution is always underwhelming. One

of the characteristics I like most about ASP.NET and MVC is just how much flexibility I have in tailoring

the platform to suit my development style. The projects, classes, and views that Visual Studio creates

and populates make me feel constrained to work in someone else’s style. I also find the content and
configuration too generic and too bland to be useful. Microsoft can’t possibly know what kind of application
is needed and so it covers all the bases, but in such a generalized way that I end up just ripping out the
default content anyway.

My advice (given to anyone who makes the mistake of asking) is to start with an empty project and add
the folders, files, and packages that you need. Not only will you learn more about the way that MVC works,
but you will have complete control over what your application contains.

But my preferences should not color your development experience. You may find the templates more
useful than I do, especially if you are new to ASP.NET development and you have not yet developed a
development style that suits you. You may also find the project templates a useful resource and a source
of ideas, although you should be cautious about adding any functionality to an application before you
completely understand how it works.

Creating the Project

When you first create a new ASP.NET Core project, you have three basic starting points to choose from: the
Empty template, the Web API template, and the Web Application template, as shown in Figure 3-5.

New ASP.NET Core Web Application (NET Core) - MyProject T X

Select a template:

A project template for creating an ASP.NET Core
ASFE.NET Core Templates application with example ASP.NET MVC Views and
Controllers. This template can also be used for RESTful

m E @ HTTP services.

Learn more
Empty Web API Web
Application

Change Authentication

Authentication: No Authentication
> Microsoft Azure
@ [] Host in the cloud

App Service i

ok || cancel

Figure 3-5. The ASP.NET Core project templates
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The Empty project template contains the plumbing for ASP.NET Core but doesn’t include the libraries
or configuration required for an MVC application. The Web API project template includes ASP.NET Core
and MVC, with a sample application that demonstrates how to receive and process Ajax requests from
clients. The Web Application project template includes ASP.NET Core and MVC, with a sample application
that demonstrates how to generate HTML content. The Web API and Web Application templates can be
configured with different schemes for authenticating users and authorizing their access to the application.

The project templates can give the impression that you need to follow a specific path to create a certain
kind of ASP.NET application, but that’s not the case. The templates are just different starting points into
the same functionality, and you can add whatever functionality you need to projects created with any of
the templates. For example, I explain how to deal with Ajax requests in Chapter 20 and authentication and
authorization in Chapters 28-30, all of which I do by starting with the Empty project template.

So, the real difference between the project templates is the initial set of libraries, configuration files,
code, and content that Visual Studio adds when it creates the project. There are a lot of differences between
the simplest template (Empty) and the most complex (Web Application), as you can see in Figure 3-6,
which shows the Solution Explorer after a project has been created with each one. For the Web Application
template, I had to focus the Solution Explorer on different folders because a single listing was too long for the
printed page.

Solution Explorer *Ox 5 xplorer
cof o-sa@| F - cofd|e-s0@ | F -

Seasch Sclution Cirte:) £ +| | Search Solution Explorer (Ctris Search Solution Explores {Ctrie:) B £-
53] Sohution MyProject {1 project) B Sohution MyPraject {1 project) = Search Solution Explorer (Ctris P~
4 Solution ltems - e 4 Account Medels

£T globaljzon 4 T MyProject [ ConfumEmaiL.cshtml 4 AccountViewhodels
- b Properties [ ExternsiLoginConfimation.czhtmi ©* ExtemalLoginC
b o References it & ForgotPasswordViewbodelcs
4 Jo Properties b @l wwwroot B ForgotPasswword.cshtmi & LoginViewModel.cs
T launchSettings json b &8 Dependencies B ForgotPasswordConfirmation.cshtrnl € RegisterViewModel.cs
b @ References 4 Controllers B Lockout.cshtmi = ResetPasswordViewModelcs
@' wwwroot € AccountController.cs B Login.cshtm! © SendCodeNiewModelcs
58 Dependencies € HomeController.ce [B) Register.cshimi o VerifyCodeViewhModel.cs
€ Program.cs € ManageController.cs B ResetPassword.cshtml 4 ManageViewModels
4 [T projectjson F Data B ResetPasswordConfimation.cshimi £ AddPhoneNumberViewModel.cs
T project.ockjson a Migrations B SendCode.cshtmi € ChangePasswordViewModel.es
[ Project_Readme.htmi b c D000ODO0OO0000_CreateldentitySel ) VefyCode.cshtmi o ConfigureTwoFactorViewhModel.cs
l‘:' Startup.cs © ApplicationDbContexthModeiSnap Home € FactorViewModel.cs
Pl web.config = ApphcationDbContext.cs B About.cshtmi o IndedViewModel.cs
3 Models @ Contactcshimi € ManageloginsViewModelcs
4 Senvices B Indexcshtrmi € RemoveloginViewModel.cs
©* IEmailSender.cs 4 Manage © SePasswordviewModel.cs
= [SmsSender.cs B AddPhoneumber.cshimi © VerifyPhoneNumberViewModel.cs
€* MessageSenvices.cs B ChangePassword.cshimi ©* ApplicationUser.cs
b Views [ Index.cshtml Explo
& appsettingsjson [® ManageLogins.cshtml
T bundieconfig.jron B SetPassword.cshimi
€= Program.cs B VerifyPhonebumbes.cshtmi earch Sclution Explore P~
¢ LT projectjson 3 Shared ~
D Project_Readme.htrl B Layout.cshtmi ¥ M o
€ Startup.cs [ _LeoginPartial.cshtmi 3 images
¥ web.config [ _ValidstionScriptsPartial.cshtml 3 B
[® Error.cshiml Pl ib
[& _Viewtmportscshtml ] bootstrap
B _ViewStart.cshtmi 3 jquery
3 jquery-validation
b jquery-validation-unobtrusive
IT _referencesjs
B faviconico

Figure 3-6. The default content added to a project by the Empty and Web Application templates

The extra files that the Web Application template adds to the project looks daunting, but some of
them are just placeholders or example implementations of common features. Some of the other files set up
MVC or configure ASP.NET. Yet others are client-side libraries, which you will incorporate into the HTML
generated by an application. The list of files may seem overwhelming now, but you'll understand what
everything does by the time you finish this book.
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Regardless of the template that you use to create a project, there are some common folders and files
that will appear. Some of the items in a project have special roles that are hard-coded into ASP.NET or MVC
or one of the tools that Visual Studio provides support for. Others are subject to naming conventions that are
used in most ASP.NET or MVC projects. In Table 3-1, I have described the important files and folders that
you will encounter in an ASP.NET Core MVC project, some of which are not present in project by default but
which I introduce in later chapters.

Note All of the folders and files described in Table 3-1 are found in the sxc folder, which is where Visual
Studio creates the ASP.NET Core MVC Project inside of the project solution.

Table 3-1. Summary of MVC Project Items

Folder or File

Description

/Areas
/Dependencies

/Components

/Controllers

/Data

/Migrations

/Models

/Views

/Views/Shared

/Views/_ViewImports.

cshtml

/Views/_ViewStart.
cshtml

Areas are a way of partitioning a large application into smaller pieces.
I describe areas in Chapter 16.

The Dependencies item provides details of all the packages a project relies on.
I describe the package managers that Visual Studio uses in Chapter 6.

This is where view component classes, which are used to display self-
contained features such as shopping carts, are defined. I describe view
components in Chapter 22.

This is where you put your controller classes. This is a convention. You can put
your controller classes anywhere you like, because they are all compiled into
the same assembly. I describe controllers in detail in Chapter 17.

This is where database context classes are defined, although I prefer to ignore
this convention and define them in the Models folder, as demonstrated in
Chapter 8.

This is where details of database schemas are stored so that deployment
databases can be updated. I demonstrate the deployment process in Chapter
12.

This is where you put your view model and domain model classes. This is a
convention. You can define your model classes anywhere in the project or in a
separate project.

This directory holds views and partial views, usually grouped together in
folders named after the controller with which they are associated. I describe
views in detail in Chapter 21.

This directory holds layouts and views that are not specific to a single
controller. I describe views in detail in Chapter 21.

This file is used to specify the namespaces that will be included in Razor
view files, as described in Chapter 5. It is also used to set up tag helpers, as
described in Chapter 23.

This file is used to specify a default layout for the Razor view engine, as
described in Chapter 5.

(continued)
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Table 3-1. (continued)

Folder or File Description

/bower.json This file is hidden by default. It contains the list of packages managed by the
Bower package manager, as described in Chapter 6.

/project.json This file specifies some basic configuration options for the project, including
the NuGet packages it uses, as described in Chapter 6.

/Program.cs This class configures the hosting platform for the application, as described in
Chapter 14.

/Startup.cs This class configures the application, as described in Chapter 14.

/wwwroot This is where you put static content such as CSS files and images. It is also
where the Bower package manager installs JavaScript and CSS packages, as
described in Chapter 6.

Understanding MVC Conventions

There are two kinds of conventions in an MVC project. The first kind is just suggestions as to how you
might like to structure your project. For example, it is conventional to put the third-party JavaScript and
CSS packages you rely on in the wawroot/1ib folder. This is where other MVC developers would expect to
find them and where the package manager will install them. But you are free to rename the 1ib folder, or
remove it entirely and put your packages somewhere else. That would not prevent MVC from running your
application as long as the script and link elements in your views refer to the location you settle on.

The other kind of convention arises from the principle of convention over configuration , which was one
of the main selling points that made Ruby on Rails so popular. Convention over configuration means that
you don’t need to explicitly configure associations between controllers and their views, for example. You
just follow a certain naming convention for your files, and everything just works. There is less flexibility in
changing your project structure when dealing with this kind of convention. The following sections explain
the conventions that are used in place of configuration.

Tip  All of the conventions can be changed by replacing the standard MVC components with your own
implementations. | describe different ways of doing this throughout the book to help explain how MVC
applications work, but these are the conventions you will be dealing with in most projects.

Following Conventions for Controller Classes

Controller classes have names that end with Controller, such as ProductController, AdminController,
and HomeController. When referencing a controller from elsewhere in the project, such as when using an
HTML helper method, you specify the first part of the name (such as Product), and MVC automatically
appends Controller to the name and starts looking for the controller class.

Tip  You can change this by creating a model convention, which | describe in Chapter 31.
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Following Conventions for Views

Views go into the folder /Views/Controllername. For example, a view associated with the
ProductController class would go in the /Views/Product folder.

Tip Notice that | omit the Controller part of the class from the views folder: /Views/Product, not /
Views/ProductController. This may seem counterintuitive at first, but it quickly becomes second nature.

MVC expects that the default view for an action method should be named after that method. For
example, the default view associated with an action method called List should be called List.cshtml.
Thus, for the List action method in the ProductController class, the default view is expected to be /Views/
Product/List.cshtml. The default view is used when you return the result of calling the View method in an
action method, like this:

return View();
You can specify a different view by name, like this:
return View("MyOtherView");

Notice that I do not include the file name extension or the path to the view. When looking for a view,
MVC looks in the folder named after the controller and then in the /Views/Shared folder. This means that I
can put views that will be used by more than one controller in the /Views/Shared folder and MVC will
find them.

Following Conventions for Layouts

The naming convention for layouts is to prefix the file with an underscore (_) character, and layout files

are placed in the /Views/Shared folder. This layout is applied to all views by default through the /Views/_
ViewStart.cshtml file. If you do not want the default layout applied to views, you can change the settings in
_ViewStart.cshtml (or delete the file entirely) to specify another layout in the view, like this:

o
Layout = "~/ _MylLayout.cshtml";
}
Or you can disable any layout for a given view, like this:
of
Layout = null;
}
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Summary

In this chapter, I introduced you to the MVC architectural pattern and compared it to some other patterns
you may have seen or heard of before. I discussed the significance of the domain model and introduced
dependency injection, which allows you to decouple components to enforce a strict separation between
the parts of an application. In the next chapter, I explain the structure of Visual Studio MVC projects and
describe the essential C# language features that are used in MVC web application development.
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CHAPTER 4

Essential C# Features

In this chapter, I describe C# features used in web application development that are not widely understood
or often cause confusion. This is not a book about C#, however, and so I provide only a brief example for
each feature so that you can follow the examples in the rest of the book and take advantage of these features
in your own projects. Table 4-1 summarizes this chapter.

Table 4-1. Chapter Summary

Problem Solution Listing

Avoid accessing properties on null references Use the null conditional operator 6-9

Simplify C# properties Use automatically implemented 10-12
properties

Simplify string composition Use string interpolation 13

Create an object and set its properties in a single  Use an object or collection initializer 14-17

step

Add functionality to a class that cannot be Use an extension method 18-25

modified

Simplify the use of delegates and single- Use a lambda expression 26-33

statement methods

Use implicit typing Use the var keyword 34

Create objects without defining a type Use an anonymous type 35-36

Simplify the use of asynchronous methods Use the async and await keywords 37-40

Get the name of a class method or property Use a nameof expression 41-42

without defining a static string

Preparing the Example Project

For this chapter I created a new Visual Studio project called LanguageFeatures using the ASP.NET Core Web
Application (.NET Core) template. I unchecked the Add Application Insights to Project option and clicked

the OK button, as shown in Figure 4-1.
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» Online Click here to go online and find templates. ;“f'P me understand Application Insights

rivacy Statement

Name: LanguageFeatures

Location: C:\Projects -

Solution name: LanguageFeatures [w] Create directory for solution

[] Add to Source Control

Figure 4-1. Selecting the project type

When presented with the different ASP.NET project configurations, I selected the Empty template, as
shown in Figure 4-2, and clicked the OK button to create the project.

ET Core) - LanguageFeatures

Select a template:

An empty project template for creating an ASP.NET Core
ASFP.NET Core Templates application. This template does not have any content in
it

v ca-Y v

Empty Web API Web
Application

Change Authentication

Authentication: No Authentication

S Microsoft Azure
@ [] Host in the cloud

| AppSevice |

OK || Cancel

Figure 4-2. Selecting the initial project content
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Enabling ASP.NET Core MVC

The Empty project template creates a project that contains a minimal ASP.NET Core configuration without
any MVC support. This means that the placeholder content that is added by the Web Application template
isn’t present, but it also means that some extra steps are required to enable MVC so that features such as
controllers and views work. In this section, I make the changes required to add enable an MVC setup in the
project, but I won'’t get into the details of what each step does for the moment. The first step is to add the
.NET assemblies for MVC, which is done in the dependencies section of the project.json file, as shown in
Listing 4-1.

Listing 4-1. Adding the MVC Assemblies in the project.json File

"dependencies": {
"Microsoft.NETCore.App": {
"version": "1.0.0",
"type": "platform"

)
"Microsoft.AspNetCore.Diagnostics": "1.0.0",

"Microsoft.AspNetCore.Server.IISIntegration": "1.0.0",
"Microsoft.AspNetCore.Server.Kestrel": "1.0.0",
"Microsoft.Extensions.Logging.Console": "1.0.0",
"Microsoft.AspNetCore.Mvc": "1.0.0"

1

The dependencies section of the project. json file lists the assemblies that are required for a project. I
have added the Microsoft.AspNetCore.Mvc assembly, which contains the MVC classes. Notice the addition
of the comma at the end of the line before the one that adds the Microsoft.AspNetCore.Mvc assembly.
JSON configuration files are sensitive to correct formatting, and it is easy to forget to add the comma, which
produces an error.

Tip  Each assembly is specified with a version number. You must make sure that all the assembly versions
you specify work together. When you edit the project. json file, Visual Studio will provide a list of available
assembly versions, and the simplest approach is to make sure that the version you specify for Microsoft.
AspNetCore.Mvc is the same as the version of the existing assemblies in the dependencies section that were
added by Visual Studio when the project was created.

The next step is to tell ASP.NET to use MVC, which is done in the Startup class, as shown in Listing 4-2.

Listing 4-2. Enabling MVC in the Startup.cs File

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Logging;

67

VN Secret
Www.vnsecret.com



CHAPTER 4 © ESSENTIAL C# FEATURES

namespace LanguageFeatures {
public class Startup {

public void ConfigureServices(IServiceCollection services) {
services.AddMvc();

}

public void Configure(IApplicationBuilder app, IHostingEnvironment env,
ILoggerFactory loggerFactory) {
app .UseMvcliithDefaultRoute();

I explain how to configure ASP.NET Core MVC applications in Chapter 14, but the two statements
added in Listing 4-2 provide a basic MVC setup using the default configuration and conventions.

Creating the MVC Application Components

Now that MVC is set up, I can add the MVC application components that I will use to demonstrate the
important C# language features.

Creating the Model

I started by creating a simple model class so that I can have some data to work with. I added a folder called
Models and created a class file called Product. cs within it, which I used to define the class shown in Listing 4-3.

Listing 4-3. The Contents of the Product.cs File in the Models Folder

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }
public decimal? Price { get; set; }

public static Product[] GetProducts() {
Product kayak = new Product {
Name = "Kayak", Price = 275M
};
Product lifejacket = new Product {
Name = "Lifejacket", Price = 48.95M

};
return new Product[] { kayak, lifejacket, null };

The Products class defines Name and Price properties, and there is a static method called
GetProducts that returns a Products array. One of the elements contained in the array returned by the
GetProducts method is set to null.
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Creating the Controller and View

For the examples in this chapter, I use a simple controller to demonstrate different language features. I
created a Controllers folder and added to it a class file called HomeController.cs, the contents of which are
shown in Listing 4-4. When using the default MVC configuration, the Home controller is where MVC will send
HTTP requests by default.

Listing 4-4. The Contents of the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
return View(new string[] { "C#", "Language", "Features" });
}

The Index action method tells MVC to render the default view and passes it an array of strings to be
included in the HTML sent to the client. To create the corresponding view, I added a Views/Home folder (by
creating a Views folder and then adding a Home folder within it) and added a view file called Index.cshtml,
the contents of which are shown in Listing 4-5.

Listing 4-5. The Contents of the Index.cshtml File in the Views/Home Folder

@model IEnumerable<string>
@{ Layout = null; }

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Language Features</title>
</head>
<body>
<ul>
@foreach (string s in Model) {
<li>@s</1i>
}

</ul>
</body>
</html>

If you run the example application by selecting Start Debugging from the Debug menu, you will see the
output shown in Figure 4-3.
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[ Language Features

C | ® localhost:53290 w| @

e C=
e Language
e Features

Figure 4-3. Running the example application

Since the output from all the examples in this chapter are text, I will show the messages displayed by the
browser like this:

C#
Language
Features

Using the Null Conditional Operator

The null conditional operator allows for null values to be detected more elegantly. There can be a lot of
testing for nulls in MVC development as you work out whether a request contains a specific header or value
or whether the model contains a particular data item. Traditionally, dealing with nulls requires making an
explicit check, and this can become tedious and error-prone when both an object and its properties have

to be inspected. The null conditional operator makes this process simpler and more concise, as shown in
Listing 4-6.

Listing 4-6. Detecting null Values in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
List<string> results = new List<string>();
foreach (Product p in Product.GetProducts()) {
string name = p?.Name;

decimal? price = p?.Price;
results.Add(string.Format("Name: {0}, Price: {1}", name, price));
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return View(results);

The static GetProducts method defined by the Product class returns an array of objects that I inspect in
the controller's Index action method in order to get a list of the Name and Price values. The problem is that
both the object in the array and the value of the properties could be null, which means that I can’t just refer
to p.Name or p.Price within the foreach loop without causing a Nul1lReferenceException. To avoid this, I
used the null conditional operator, like this:

string name = p?.Name;
decimal? price = p?.Price;

The null conditional operator is a single question mark (the ? character). If p is null, then name will be set to
null as well. If p is not null, then name will be set to the value of the Person.Name property. The Price property is
subject to the same test. Notice that the variable you assign to when using the null conditional operator must be
able to be assigned null, which is why the price variable is declared as a nullable decimal (decimal?).

Chaining the Null Conditional Operator

The null conditional operator can be chained together to navigate through a hierarchy of objects, which is
where it really becomes an effective tool for simplifying code and allowing safe navigation. In Listing 4-7,
have added a property to the Product class that nests references, creating a more complex object hierarchy.

Listing 4-7. Adding a Property in the Product.cs File

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }
public decimal? Price { get; set; }
public Product Related { get; set; }
public static Product[] GetProducts() {

Product kayak = new Product {
Name = "Kayak", Price = 275M
};

Product lifejacket = new Product {

Name = "Lifejacket", Price = 48.95M
};
kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

71

VN Secret
Www.vnsecret.com



CHAPTER 4 © ESSENTIAL C# FEATURES

Each Product object has a Related property that can refer to another Product object. In the
GetProducts method, I set the Related property for the Product object that represents a kayak. Listing 4-8
shows how I can chain the null conditional operator together to navigate through the object properties
without causing an exception.

Listing 4-8. Detecting Nested null Values in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
List<string> results = new List<string>();

foreach (Product p in Product.GetProducts()) {
string name = p?.Name;
decimal? price = p?.Price;
string relatedName = p?.Related?.Name;
results.Add(string.Format("Name: {0}, Price: {1}, Related: {2}",
name, price, relatedName));

}

return View(results);

The null conditional operator can be applied to each part of a chain of properties, like this:
string relatedName = p?.Related?.Name;

The result is that the relatedName variable will be null when p is null or when p.Related is null.
Otherwise, the variable will be assigned the value of the p.Related.Name property. If you run the example,
you will see the following output in the browser window:

Name: Kayak, Price: 275, Related: Lifejacket
Name: Lifejacket, Price: 48.95, Related:
Name: , Price: , Related:

Combining the Conditional and Coalescing Operators

It can be useful to combine the null conditional operator (a single question mark) with the null coalescing
operator (two question marks) to set a fallback value to present null values being used in the application, as
shown in Listing 4-9.
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Listing 4-9. Combining Null Operators in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
List<string> results = new List<string>();

foreach (Product p in Product.GetProducts()) {
string name = p?.Name ?? "<No Name>";
decimal? price = p?.Price ?? 0;
string relatedName = p?.Related?.Name ?? "<None>";
results.Add(string.Format("Name: {0}, Price: {1}, Related: {2}",
name, price, relatedName));

}

return View(results);

The null conditional operator ensures that I don’t get a Nul1ReferenceException when navigating
through the object properties, and the null coalescing operator ensures that I don’t include null values in
the results displayed in the browser. If you run the example, you will see the following results displayed in
the browser window:

Name: Kayak, Price: 275, Related: Lifejacket
Name: Lifejacket, Price: 48.95, Related: <None>
Name: <No Name», Price: 0, Related: <None»

Using Automatically Implemented Properties

C# supports automatically implemented properties, and I used them when defining properties for the
Person class in the previous section, like this:

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }
public decimal? Price { get; set; }
public Product Related { get; set; }
public static Product[] GetProducts() {

Product kayak = new Product {
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Name = "Kayak", Price = 275M
};
Product lifejacket = new Product {

Name = "Lifejacket", Price = 48.95M
};

kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

This feature allows me to define properties without having to implement the get and set bodies. Using
the auto-implemented property feature means that defining a property like this:

public string Name { get; set; }
is equivalent to the following code:

public string Name {
get { return name; }
set { name = value; }

This type of feature is known as syntactic sugar, which means that it makes C# more pleasant to work with—in
this case by eliminating redundant code that ends up being duplicated for every property—without substantially
altering the way that the language behaves. The term sugar may seem pejorative, but any enhancements that
make code easier to write and maintain can be beneficial, especially in large and complex projects.

Using Auto-Implemented Property Initializers

Automatically implemented properties have been supported since C# 3.0. The latest version of C# supports
initializers for automatically implemented properties, which allows an initial value to be set without having
to use the constructor, as shown in Listing 4-10.

Listing 4-10. Using an Auto-Implemented Property Initializer in the Product.cs File

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }

public string Category { get; set; } = "Watersports”;
public decimal? Price { get; set; }

public Product Related { get; set; }

public static Product[] GetProducts() {
Product kayak = new Product {
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Name = "Kayak",

Category = "Water Craft",

Price = 275M
};
Product lifejacket = new Product {

Name = "Lifejacket", Price = 48.95M
b

kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

Assigning a value to an auto-implemented property doesn’t prevent the setter from being used to
change the property later and just tidies up the code for simple types that ended up with a constructor that
contained a list of property assignments to provide default values. In the example, the initializer assigns a
value of Watersports to the Category property. The initial value can be changed, which I do when I create
the kayak object and specify a value of Water Craft instead.

Creating Read-Only Automatically Implemented Properties

You can create a read-only property by using an initializer and omitting the set keyword from an auto-
implemented property that has an initializer, as shown in Listing 4-11.

Listing 4-11. Creating a Read-Only Property in the Product.cs File

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }

public string Category { get; set; } = "Watersports";
public decimal? Price { get; set; }

public Product Related { get; set; }

public bool InStock { get; } = true;

public static Product[] GetProducts() {

Product kayak = new Product {
Name = "Kayak",
Category = "Water Craft",
Price = 275M
};
Product lifejacket = new Product {
Name = "Lifejacket", Price = 48.95M

};
kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };
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The InStock property is initialized to true and cannot be changed; however, the value can be assigned
to in the type’s constructor, as shown in Listing 4-12.

Listing 4-12. Assigning a Value to a Read-Only Property in the Product.cs File

namespace LanguageFeatures.Models {
public class Product {

public Product(bool stock = true) {
InStock = stock;
}

public string Name { get; set; }

public string Category { get; set; } = "Watersports";
public decimal? Price { get; set; }

public Product Related { get; set; }

public bool InStock { get; }

public static Product[] GetProducts() {
Product kayak = new Product {
Name = "Kayak",
Category = "Water Craft",
Price = 275M
};
Product lifejacket = new Product(false) {

Name = "Lifejacket",
Price = 48.95M

}s
kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

The constructor allows the value for the read-only property to be specified as an argument and defaults
to true if no value is provided. The property value cannot be changed once set by the constructor.

Using String Interpolation

The string.Format method is the traditional C# tool for composing strings that contain data values. Here is
an example of this technique from the Home controller:

results.Add(string.Format("Name: {0}, Price: {1}, Related: {2}",
name, price, relatedName));
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C# 6.0 adds support for a different approach, known as string interpolation, that avoids the need to
ensure that the {0} references in the string template match up with the variables specified as arguments.
Instead, string interpolation uses the variable names directly, as shown in Listing 4-13.

Listing 4-13. Using String Interpolation in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
List<string> results = new List<string>();

foreach (Product p in Product.GetProducts()) {
string name = p?.Name ?? "<No Name>";
decimal? price = p?.Price ?? 0;
string relatedName = p?.Related?.Name ?? "<None>";
results.Add($"Name: {name}, Price: {price}, Related: {relatedName}");

}

return View(results);

Interpolated strings are prefixed with the $ character and contain holes, which are references to values
contained within the { and } characters. When the string is evaluated, the holes are filled in with the current
values of the variables or constants that are specified.

Visual Studio provides IntelliSense support for creating interpolated strings and offers a list of the
available members when the { character is typed; this helps to minimize typos, and the result is a string
format that is easier to understand.

Tip  String interpolation supports all the format specifies that are available with the string.Format
method. The format specifies are included as part of the hole, so $"Price: {price:C2}" would format the
price value as a currency value with two decimal digits.

Using Object and Collection Initializers

When I create an object in the static GetProducts method of the Product class, I use an object initializer,
which allows me to create an object and specify its property values in a single step, like this:

Product kayak = new Product {
Name = "Kayak",
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Category = "Water Craft",
Price = 275M

This is another syntactic sugar feature that makes C# easier to use. Without this feature, I would have to
call the Product constructor and then use the newly created object to set each of the properties, like this:

Product kayak = new Product();
kayak.Name = "Kayak";
kayak.Category = "Water Craft";
kayak.Price = 275M;

A related feature is the collection initializer, which allows the creation of a collection and its contents to
be specified in a single step. Without an initializer, creating a string array, for example, requires the size of
the array and the array elements to be specified separately, as shown in Listing 4-14.

Listing 4-14. Initializing an Object in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
string[] names = new string[3];
names[0] = "Bob"
names[1] = "Joe";
names[2] = "Alice";
return View("Index", names);

o we

Using a collection initializer allows the contents of the array to be specified as part of the construction,
which implicitly provides the compiler with the size of the array, as shown in Listing 4-15.
Listing 4-15. Using a Collection Initializer in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {
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public ViewResult Index() {
return View("Index", new string[] { "Bob", "Joe", "Alice" });
}

The array elements are specified between the { and } characters, which allows for a more concise
definition of the collection and makes it possible to define a collection inline within a method call. The code
in Listing 4-15 has the same effect as the code in Listing 4-14, and if you run the example application, you
will see the following output in the browser window:

Bob
Joe
Alice

Using an Index Initializer

C# 6 tidies up the way that collection initializers are used to create collections that use indexes, such as
dictionaries. Listing 4-16 shows the Index action rewritten to define a collection using the C# 5 approach to
initializing a dictionary.

Listing 4-16. Initializing a Dictionary in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
Dictionary<string, Products> products = new Dictionary<string, Products> {
{ "Kayak", new Product { Name = "Kayak", Price = 275M } },
{ "Lifejacket", new Product{ Name = "Lifejacket", Price = 48.95M } }

b
return View("Index", products.Keys);

The syntax for initializing this type of collection relies too much on the { and } characters, especially
when the collection values are creating using object initializers. The C# 6 compiler supports a more natural
approach to initializing indexed collections that is consistent with the way that values are retrieved or
modified once the collection has been initialized, as shown in Listing 4-17.

Listing 4-17. Using the C# Collection Initializer Syntax in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
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namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
Dictionary<string, Product> products = new Dictionary<string, Product> {
["Kayak"] = new Product { Name = "Kayak", Price = 275M },
["Lifejacket"] = new Product { Name = "Lifejacket", Price = 48.95M }

};

return View("Index", products.Keys);

The effect is the same—to create a dictionary whose keys are Kayak and Lifejacket and whose values
are Product objects—but the elements are created using the index notation that is used for other collection
operations. If you run the application, you will see the following results in the browser:

Kayak
Lifejacket

Using Extension Methods

Extension methods are a convenient way of adding methods to classes that you do not own and cannot
modify directly. Listing 4-18 shows the definition of the ShoppingCart class, which I added to the Models
folder in a file called ShoppingCart.cs file and which represents a collection of Product objects.

Listing 4-18. The Contents of the ShoppingCart.cs File in the Models Folder

using System.Collections.Generic;
namespace LanguageFeatures.Models {

public class ShoppingCart {
public IEnumerable<Product> Products { get; set; }
}

This is a simple class that acts as a wrapper around a List of Product objects (I only need a basic
class for this example). Suppose I need to be able to determine the total value of the Product objects in the
ShoppingCart class but I cannot modify the class itself, perhaps because it comes from a third party and I do
not have the source code. I can use an extension method to add the functionality I need. Listing 4-19 shows
the MyExtensionMethods class that I added to the Models folder in the MyExtensionMethods. cs file.

Listing 4-19. The Contents of the MyExtensionMethods.cs File in the Models Folder
namespace LanguageFeatures.Models {
public static class MyExtensionMethods {

public static decimal TotalPrices(this ShoppingCart cartParam) {
decimal total = 0;
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foreach (Product prod in cartParam.Products) {
total += prod?.Price ?? 0;
}

return total;

The this keyword in front of the first parameter marks TotalPrices as an extension method. The first
parameter tells .NET which class the extension method can be applied to—ShoppingCart in this case.Ican
refer to the instance of the ShoppingCart that the extension method has been applied to by using the cartParam
parameter. My method enumerates the Products in the ShoppingCart and returns the sum of the Product.Price
property. Listing 4-20 shows how I apply the extension method in the Home controller’s action method.

Note Extension methods do not let you break through the access rules that classes define for their
methods, fields, and properties. You can extend the functionality of a class by using an extension method, but
only using the class members that you had access to anyway.

Listing 4-20. Applying an Extension Method in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
ShoppingCart cart
= new ShoppingCart { Products = Product.GetProducts() };
decimal cartTotal = cart.TotalPrices();
return View("Index", new string[] { $"Total: {cartTotal:C2}" });

The key statement is this one:
decimal cartTotal = cart.TotalPrices();

I call the TotalPrices method on a ShoppingCart object as though it were part of the ShoppingCart
class, even though it is an extension method defined by a different class altogether. NET will find extension
classes if they are in the scope of the current class, meaning that they are part of the same namespace or in
anamespace that is the subject of a using statement. If you run the application, you will see the following
output in the browser window:

Total: $323.95
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Applying Extension Methods to an Interface

I can also create extension methods that apply to an interface, which allows me to call the extension method
on all the classes that implement the interface. Listing 4-21 shows the ShoppingCart class updated to
implement the IEnumerable<Product> interface.

Listing 4-21. Implementing an Interface in the ShoppingCart.cs File

using System.Collections;
using System.Collections.Generic;

namespace LanguageFeatures.Models {

public class ShoppingCart : IEnumerable<Products> {
public IEnumerable<Product> Products { get; set; }

public IEnumerator<Products> GetEnumerator() {

return Products.GetEnumerator();
}

IEnumerator IEnumerable.GetEnumerator() {
return GetEnumerator();
}

I can now update the extension method so that it deals with IEnumerable<Product>, as shown in
Listing 4-22.

Listing 4-22. Updating an Extension Method in the MyExtensionMethods.cs File
using System.Collections.Generic;
namespace LanguageFeatures.Models {
public static class MyExtensionMethods {
public static decimal TotalPrices(this IEnumerable<Products products) {
decimal total = 0;
foreach (Product prod in products) {

total += prod?.Price ?? 0;
}

return total;

The first parameter type has changed to IEnumerable<Product>, which means that the foreach loop
in the method body works directly on Product objects. The change to using the interface means that I can
calculate the total value of the Product objects enumerated by any IEnumerable<Product>, which includes
instances of ShoppingCart but also arrays of Product objects, as shown in Listing 4-23.
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Listing 4-23. Applying an Extension Method to an Array in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

ShoppingCart cart
= new ShoppingCart { Products = Product.GetProducts() };

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M}

s

decimal cartTotal = cart.TotalPrices();
decimal arrayTotal = productArray.TotalPrices();

return View("Index", new string[] {
$"Cart Total: {cartTotal:C2}",
$"Array Total: {arrayTotal:C2}" });

If you start the project, you will see the following results, which demonstrate that I get the same result
from the extension method, irrespective of how the Product objects are collected:

Cart Total: $323.95
Array Total: $323.95

Creating Filtering Extension Methods

The last thing I want to show you about extension methods is that they can be used to filter collections of objects.
An extension method that operates on an IEnumerable<T>and that also returns an IEnumerable<T>can use the
yield keyword to apply selection criteria to items in the source data to produce a reduced set of results. Listing 4-24
demonstrates such a method, which I have added to the MyExtensionMethods class.

Listing 4-24. Adding Filtering Extension Method in the MyExtensionMethods.cs File
using System.Collections.Generic;
namespace LanguageFeatures.Models {

public static class MyExtensionMethods {

public static decimal TotalPrices(this IEnumerable<Product> products) {
decimal total = 0;
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foreach (Product prod in products) {
total += prod?.Price ?? 0;
}

return total;

}

public static IEnumerable<Product> FilterByPrice(
this IEnumerable<Product> productEnum, decimal minimumPrice) {

foreach (Product prod in productEnum) {
if ((prod?.Price ?? 0) >= minimumPrice) {
yield return prod;
}

This extension method, called FilterByPrice, takes an additional parameter that allows me to filter
products so that Product objects whose Price property matches or exceeds the parameter are returned in
the result. Listing 4-25 shows this method being used.

Listing 4-25. Using the Filtering Extension Method in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M},
new Product {Name = "Soccer ball", Price = 19.50M},
new Product {Name = "Corner flag", Price = 34.95M}

};
decimal arrayTotal = productArray.FilterByPrice(20).TotalPrices();

return View("Index", new string[] { $"Array Total: {arrayTotal:C2}" });

When I call the FilterByPrice method on the array of Product objects, only those that cost more than
$20 are received by the TotalPrices method and used to calculate the total. If you run the application, you
will see the following output in the browser window:

Total: $358.90
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Using Lambda Expressions

Lambda expressions are a feature that causes a lot of confusion, not least because the feature they simplify
is also confusing. To understand the problem that is being solved, consider the FilterByPrice extension
method that I defined in the previous section. This method is written so that it can filter Product objects by
price, which means that if I want to filter by name, I have to create a second method, like the one shown in
Listing 4-26.

Listing 4-26. Adding a Filter Method in the MyExtensionMethods.cs File
using System.Collections.Generic;
namespace LanguageFeatures.Models {
public static class MyExtensionMethods {
public static decimal TotalPrices(this IEnumerable<Product> products) {
decimal total = 0;
foreach (Product prod in products) {

total += prod?.Price ?? 0;
}

return total;

}

public static IEnumerable<Product> FilterByPrice(
this IEnumerable<Product> productEnum, decimal minimumPrice) {

foreach (Product prod in productEnum) {

if ((prod?.Price ?? 0) >= minimumPrice) {
yield return prod;
}

}

public static IEnumerable<Products> FilterByName(
this IEnumerable<Product> productEnum, char firstletter) {

foreach (Product prod in productEnum) {
if (prod?.Name?[0] == firstlLetter) {
yield return prod;
}

Listing 4-27 shows the use of both filter methods applied in the controller to create two different totals.
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Listing 4-27. Using Two Filter Methods in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M},
new Product {Name = "Soccer ball", Price = 19.50M},
new Product {Name = "Corner flag", Price = 34.95M}

};

decimal priceFilterTotal = productArray.FilterByPrice(20).TotalPrices();
decimal nameFilterTotal = productArray.FilterByName('S').TotalPrices();

return View("Index", new string[] {
$"Price Total: {priceFilterTotal:C2}",
$"Name Total: {nameFilterTotal:C2}" });

The first filter selects all of the products with a price of $20 or more, and the second filter selects
products that whose name starts with the letter S. You will see the following output in the browser window if
you run the example application:

Price Total: $358.90
Name Total: $19.50

Defining Functions

I can repeat this process indefinitely and create a different filter method for every property and every
combination of properties that I am interested in. A more elegant approach is to separate out the code that
processes the enumeration from the selection criteria. C# makes this easy by allowing functions to be passed
around as objects. Listing 4-28 shows a single extension method that filters an enumeration of Product
objects but that delegates the decision about which ones are included in the results to a separate function.

Listing 4-28. Creating a General Filter Method in the MyExtensionMethods.cs File

using System.Collections.Generic;
using System;

namespace LanguageFeatures.Models {

public static class MyExtensionMethods {
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public static decimal TotalPrices(this IEnumerable<Product> products) {
decimal total = 0;
foreach (Product prod in products) {
total += prod?.Price ?? 0;
}

return total;

}

public static IEnumerable<Product> Filter(
this IEnumerable<Products> productEnum,
Func<Product, bool> selector) {

foreach (Product prod in productEnum) {
if (selector(prod)) {
yield return prod;
}

The second argument to the Filter method is a function that accepts a Product object and that returns
a bool value. The Filter method calls the function for each Product object and includes it in the result if the
function returns true. To use the Filter method, I can specify a method or create a stand-alone function, as
shown in Listing 4-29.

Listing 4-29. Using a Function to Filter Product Objects in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

bool FilterByPrice(Product p) {
return (p?.Price ?? 0) >= 20;
}

public ViewResult Index() {

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M},
new Product {Name = "Soccer ball", Price = 19.50M},
new Product {Name = "Corner flag", Price = 34.95M}

};
Func<Product, bool> nameFilter = delegate (Product prod) {
return prod?.Name?[0] == 'S’;
b
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decimal priceFilterTotal = productArray
.Filter(FilterByPrice)
.TotalPrices();

decimal nameFilterTotal = productArray
.Filter(nameFilter)
.TotalPrices();

return View("Index", new string[] {
$"Price Total: {priceFilterTotal:C2}",
$"Name Total: {nameFilterTotal:C2}" });

Neither approach is ideal. Defining methods like FilterByPrice clutters up a class definition. Creating
a Func<Product, bool>object avoids this problem but uses an awkward syntax that is hard to read and hard
to maintain. It is this issue that lambda expressions address by allowing functions to be defined in a more
elegant and expressive way, as shown in Listing 4-30.

Listing 4-30. Using Lambda Expression in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M},
new Product {Name = "Soccer ball", Price = 19.50M},
new Product {Name = "Corner flag", Price = 34.95M}

};

decimal priceFilterTotal = productArray
+Filter(p =» (p?.Price ?? 0) >= 20)
.TotalPrices();

decimal nameFilterTotal = productArray
.Filter(p => p?.Name?[0] == 'S')
.TotalPrices();

return View("Index", new string[] {

$"Price Total: {priceFilterTotal:C2}",
$"Name Total: {nameFilterTotal:C2}" });
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The lambda expressions are shown in bold. The parameters are expressed without specifying a type,
which will be inferred automatically. The =>characters are read aloud as “goes to” and link the parameter
to the result of the lambda expression. In my examples, a Product parameter called p goes to a bool result,
which will be true if the Price property is equal or greater than 20 in the first expression or if the Name
property starts with S in the second expression. This code works in the same way as the separate method and
the function delegate but is more concise and is—for most people—easier to read.

OTHER FORMS FOR LAMBDA EXPRESSIONS

| don’t need to express the logic of my delegate in the lambda expression. | can as easily call a method,
like this:

prod => EvaluateProduct(prod)

If I need a lambda expression for a delegate that has multiple parameters, | must wrap the parameters
in parentheses, like this:

(prod, count) => prod.Price > 20 8& count > 0

And, finally, if | need logic in the lambda expression that requires more than one statement, | can do so
by using braces ({}) and finishing with a return statement, like this:

(prod, count) => {
// ...multiple code statements...
return result;

You do not need to use lambda expressions in your code, but they are a neat way of expressing complex
functions simply and in a manner that is readable and clear. | like them a lot, and you will see them used
liberally throughout this book.

Using Lambda Expression Methods and Properties

In C# 6, support for lambda expressions has been extended so that they can be used to implement methods
and properties. In MVC development, especially when writing controllers, you will often end up with
methods that contain a single statement that selects the data to display and the view to render. In Listing 4-31,
I have rewritten the Index action method so that it follows this common pattern.

Listing 4-31. Creating a Common Action Pattern in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;
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namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
return View(Product.GetProducts().Select(p => p?.Name));
}

The action method gets a collection of Product objects from the static Product.GetProducts method
and uses LINQ to project the values of the Name properties, which are then used as the view model for the
default view. If you run the application, you will see the following output displayed in the browser window:

Kayak
Lifejacket

There will be an empty list item in the browser window as well because the GetProducts method
includes a null reference in its results, but that doesn’t matter for this section of the chapter.

When a method body consists of a single statement, it can be rewritten as a lambda expression, as
shown in Listing 4-32.

Listing 4-32. Expressing an Action Method as a Lambda Expression in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() =»>
View(Product.GetProducts().Select(p =» p?.Name));

Lambda expressions for methods omit the return keyword and use => (goes to) to associate the method
signature (including its arguments) with its implementation. The Index method shown in Listing 4-32 works
in the same way as the one shown in Listing 4-31 but is expressed more concisely.

The same basic approach can also be used to define properties. Listing 4-33 shows the addition of a
property that uses a lambda express to the Product class.

Listing 4-33. Expressing a Property as a Lambda Expression in the Product.cs File

namespace LanguageFeatures.Models {
public class Product {

public Product(bool stock = true) {
InStock = stock;
}
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string Name { get; set; }

string Category { get; set; } = "Watersports";
decimal? Price { get; set; }

Product Related { get; set; }

bool InStock { get; }

bool NameBeginsWithS =» Name?[0] == 'S';

static Product[] GetProducts() {

Product kayak = new Product {

};

Name = "Kayak",
Category = "Water Craft",
Price = 275M

Product lifejacket = new Product(false) {

};

Name = "Lifejacket",
Price = 48.95M

kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

Using Type Inference and Anonymous Types

The C# var keyword allows you to define a local variable without explicitly specifying the variable type, as
demonstrated by Listing 4-34. This is called type inference, or implicit typing.

Listing 4-34. Using Type Inference in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

using System;

using System.Ling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
var names = new [] { "Kayak", "Lifejacket", "Soccer ball" };
return View(names);
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It is not that the names variable does not have a type; instead, I am asking the compiler to infer the type
from the code. The compiler examines the array declaration and works out that it is a string array. Running
the example produces the following output:

Kayak
Lifejacket
Soccer ball

Using Anonymous Types

By combining object initializers and type inference, I can create simple view model objects that are useful
for transferring data between a controller and a view without having to define a class or struct, as shown in
Listing 4-35.

Listing 4-35. Creating an Anonymous Type in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Lling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
var products = new [] {
new { Name = "Kayak", Price = 275M },
new { Name = "Lifejacket", Price = 48.95M },
new { Name = "Soccer ball", Price = 19.50M },
new { Name = "Corner flag", Price = 34.95M }

)

return View(products.Select(p =» p.Name));

Each of the objects in the products array is an anonymously typed object. This does not mean that it
is dynamic in the sense that JavaScript variables are dynamic. It just means that the type definition will be
created automatically by the compiler. Strong typing is still enforced. You can get and set only the properties
that have been defined in the initializer, for example. If you run the example, you will see the following
output in the browser window:

Kayak
Lifejacket
Soccer ball
Corner flag
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The C# compiler generates the class based on the name and type of the parameters in the initializer.
Two anonymously typed objects that have the same property names and types will be assigned to the same
automatically generated class. This means that all the objects in the products array will have the same type
because they define the same properties.

Tip | have to use the var keyword to define the array of anonymously typed objects because the type isn't
created until the code is compiled and so | don’t know the name of the type to use. The elements in an array of
anonymously typed objects must all define the same properties; otherwise, the compiler can’t work out what
the array type should be.

To demonstrate this, I have changed the output from the example in Listing 4-36 so that it shows the
type name rather than the value of the Name property.

Listing 4-36. Displaying the Anonymous Type Name in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
var products = new [] {
new { Name = "Kayak", Price = 275M },
new { Name = "Lifejacket", Price = 48.95M },
new { Name = "Soccer ball", Price = 19.50M },
new { Name = "Corner flag", Price = 34.95M }

};

return View(products.Select(p => p.GetType().Name));

All the objects in the array have been assigned the same type, which you can see if you run the example.
The type name isn’t user-friendly but isn’t intended to be used directly, and you may see a different name
than the one shown in the following output:

<>f__AnonymousType0"2
<>f__AnonymousType0"2
<>f__AnonymousType0" 2
<>f__AnonymousType0" 2
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Using Asynchronous Methods

One of the big recent additions to C# is improvements in the way that asynchronous methods are dealt with.
Asynchronous methods go off and do work in the background and notify you when they are complete,
allowing your code to take care of other business while the background work is performed. Asynchronous
methods are an important tool in removing bottlenecks from code and allow applications to take advantage
of multiple processors and processor cores to perform work in parallel.

In MVC, asynchronous methods can be used to improve the overall performance of an application by
allowing the server more flexibility in the way that requests are scheduled and executed. Two C# keywords—
async and await—are used to perform work asynchronously.

To prepare for this section, I need to add a new .NET assembly to the example project so that I can make
asynchronous HTTP requests. Listing 4-37 shows the addition I made to the dependencies section of the
project.json file.

Listing 4-37. Adding an Assembly Reference in the project.json File

"dependencies": {
"Microsoft.NETCore.App": {
"version": "1.0.0",
"type": "platform"

}

"Microsoft.AspNetCore.Diagnostics": "1.0.0",

"Microsoft.AspNetCore.Server.IISIntegration": "1.0.0",
"Microsoft.AspNetCore.Server.Kestrel": "1.0.0",
"Microsoft.Extensions.Logging.Console": "1.0.0",
"Microsoft.AspNetCore.Mvc": "1.0.0",
"System.Net.Http": "4.1.0"

1

When you save the project. json file, Visual Studio will download the System.Net.Http assembly and
add it to the project. I describe this process in more detail in Chapter 6.

Working with Tasks Directly

C# and .NET have excellent support for asynchronous methods, but the code has tended to be verbose, and
developers who are not used to parallel programming often get bogged down by the unusual syntax. As

an example, Listing 4-38 shows an asynchronous method called GetPageLength, which I defined in a class
called MyAsyncMethods and added to the Models folder in a class file called MyAsyncMethods. cs.

Listing 4-38. The Contents of the MyAsyncMethods.cs File in the Models Folder

using System.Net.Http;
using System.Threading.Tasks;

namespace LanguageFeatures.Models {

public class MyAsyncMethods {
94

VN Secret
Www.vnsecret.com


http://dx.doi.org/10.1007/978-1-4842-0397-2_6

CHAPTER 4 © ESSENTIAL C# FEATURES

public static Task<long?> GetPagelength() {
HttpClient client = new HttpClient();
var httpTask = client.GetAsync("http://apress.com");
// we could do other things here while the HTTP request is performed

return httpTask.ContinueWith((Task<HttpResponseMessage> antecedent) => {
return antecedent.Result.Content.Headers.ContentLength;
1;

This method uses a System.Net.Http.HttpClient object to request the contents of the Apress home
page and returns its length. .NET represents work that will be done asynchronously as a Task. Task objects
are strongly typed based on the result that the background work produces. So, when I call the HttpClient.
GetAsync method, what I get back is a Task<HttpResponseMessage>. This tells me that the request will be
performed in the background and that the result of the request will be an HttpResponseMessage object.

Tip When | use words like background, | am skipping over a lot of detail in order to make the key points
that are important to the world of MVC. The .NET support for asynchronous methods and parallel programming
in general is excellent, and | encourage you to learn more about it if you want to create truly high-performing
applications that can take advantage of multicore and multiprocessor hardware. You will see how MVC makes it
easy to create asynchronous web applications throughout this book as I introduce different features.

The part that most programmers get bogged down with is the continuation, which is the mechanism by
which you specify what you want to happen when the background task is complete. In the example, I have
used the ContinuelWith method to process the HttpResponseMessage object I get from the HttpClient.
GetAsync method, which I do using a lambda expression that returns the value of a property that contains
the length of the content I get from the Apress web server. Here is the continuation code:

return httpTask.ContinueWith((Task<HttpResponseMessage> antecedent) => {
return antecedent.Result.Content.Headers.ContentlLength;
1;

Notice that I use the return keyword twice. This is the part that causes confusion. The first use of the
return keyword specifies that I am returning a Task<HttpResponseMessage > object, which, when the task is
complete, will return the length of the ContentLength header. The ContentLength header returns a long?
result (a nullable long value), and this means that the result of my GetPagelength method is Task<long?>,
like this:

public static Task<long?»> GetPagelength() {
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Do not worry if this does not make sense—you are not alone in your confusion. It is for this reason that
Microsoft added keywords to C# to simplify asynchronous methods.

Applying the async and await Keywords

Microsoft introduced two keywords to C# that are specifically intended to simplify using asynchronous
methods like HttpClient.GetAsync. The keywords are async and await, and you can see how I have used
them to simplify my example method in Listing 4-39.

Listing 4-39. Using the async and await Keywords in the MyAsyncMethods.cs File

using System.Net.Http;
using System.Threading.Tasks;

namespace LanguageFeatures.Models {
public class MyAsyncMethods {
public async static Task<long?»> GetPagelength() {
HttpClient client = new HttpClient();
var httpMessage = await client.GetAsync("http://apress.com");

return httpMessage.Content.Headers.ContentlLength;

I used the await keyword when calling the asynchronous method. This tells the C# compiler that I
want to wait for the result of the Task that the GetAsync method returns and then carry on executing other
statements in the same method.

Applying the await keyword means I can treat the result from the GetAsync method as though it were
aregular method and just assign the HttpResponseMessage object that it returns to a variable. And, even
better, I can then use the return keyword in the normal way to produce a result from other method—in this
case, the value of the ContentLength property. This is a much more natural technique, and it means I do not
have to worry about the ContinueWith method and multiple uses of the return keyword.

When you use the await keyword, you must also add the async keyword to the method signature, as I
have done in the example. The method result type does not change—my example GetPagelLength method
still returns a Task<long?>. This is because await and async are implemented using some clever compiler
tricks, meaning that they allow a more natural syntax, but they do not change what is happening in the
methods to which they are applied. Someone who is calling my GetPagelLength method still has to deal
with a Task<long? >result because there is still a background operation that produces a nullable long—
although, of course, that programmer can also choose to use the await and async keywords as well.

This pattern follows through into the MVC controller, which makes it easy to write asynchronous action
methods, as shown in Listing 4-40.

Listing 4-40. Defining an Asynchronous Action Methods in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
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using LanguageFeatures.Models;
using System;

using System.Ling;

using System.Threading.Tasks;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public async Task<ViewResult> Index() {
long? length = await MyAsyncMethods.GetPageLength();
return View(new string[] { $"Length: {length}" });

I have changed the result of the Index action method to Task<ViewResult>, which tells MVC that the action
method will return a Task that will produce a ViewResult object when it completes, which will provide details of
the view that should be rendered and the data that it requires. I have added the async keyword to the method’s
definition, which allows me to use the await keyword when calling the MyAsyncMethods . GetPathLength method.
MVC and .NET take care of dealing with the continuations, and the result is asynchronous code that is easy to
write, easy to read, and easy to maintain. If you run the application, you will see output similar to the following
(although with a different length since the content of the Apress website changes often):

Length: 62164

Getting Names

There are many tasks in web application development in which you need to refer to the name of an
argument, variable, method, or class. Common examples include when you throw an exception or create a
validation error when processing input from the user. The traditional approach has been to use a string value
hard-coded with the name, as shown in Listing 4-41.

Listing 4-41. Hard-Coding a Name in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Lling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

var products = new [] {
new { Name = "Kayak", Price = 275M },
new { Name = "Lifejacket", Price = 48.95M },
new { Name = "Soccer ball", Price = 19.50M },
new { Name = "Corner flag", Price = 34.95M }

s
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return View(products.Select(p =» $"Name: {p.Name}, Price: {p.Price}"));

The call to the LINQ Select method generates a sequence of strings, each of which contains a hard-
coded reference to the Name and Price properties. Running the application produces the following output in
the browser window:

Name: Kayak, Price: 275

Name: Lifejacket, Price: 48.95
Name: Soccer ball, Price: 19.50
Name: Corner flag, Price: 34.95

The problem with this approach is that it is prone to errors, either because the name was mistyped or
the code was refactored and the name in the string isn’t correctly updated. The result can be misleading,
which can be especially problematic for messages that are displayed to the user. C# 6 introduces the nameof
expression, in which the compiler takes responsibility for producing a name string, as shown in Listing 4-42.

Listing 4-42. Using nameof Expressions in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Lling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

var products = new [] {
new { Name = "Kayak", Price = 275M },
new { Name = "Lifejacket", Price = 48.95M },
new { Name = "Soccer ball", Price = 19.50M },
new { Name = "Corner flag", Price = 34.95M }

¥

return View(products.Select(p =»
$"{nameof(p.Name)}: {p.Name}, {nameof(p.Price)}: {p.Price}"));

The compiler processes a reference such as p.Name so that only the last part is included in the string,
producing the same output as in previous examples. Visual Studio includes IntelliSense support for nameof
expressions, so you will be prompted to select references, and expressions will be correctly updated when
you refactor code. Since the compiler is responsible for dealing with nameof, using an invalid reference
causes a compiler error, which prevents incorrect or outdates references from escaping notice.
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Summary

In this chapter, I gave you an overview of the key C# language features that an effective MVC programmer
needs to know. C# is a sufficiently flexible language that there are usually different ways to approach any
problem, but these are the features that you will encounter most often during web application development
and see throughout the examples in this book. In the next chapter, I introduce the Razor view engine and
explain how it is used to generate dynamic content in MVC web applications.
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CHAPTER 5

Working with Razor

In an ASP.NET Core MVC application, a component called the view engine is used to produce the
content sent to clients. The default view engine is called Razor, and it processes annotated HTML files for
instructions that insert dynamic content into the output sent to the browser.

In this chapter, I give you a quick tour of the Razor syntax so you can recognize Razor expressions when
you see them. I am not going to supply an exhaustive Razor reference in this chapter; think of this more as
a crash course in the syntax. I explore Razor in depth as I continue through the book, within the context of
other MVC features. Table 5-1 puts Razor in context.

Table 5-1. Putting Razor in Context

Question Answer

What is it? Razor is the view engine responsible for incorporating data into
HTML documents.

Why is it useful? The ability to dynamically generate content is essential to being

How is it used?

Are there any pitfalls or limitations?

Are there any alternatives?

Has it changed since MVC 5?

able to write a web application. Razor provides features that make
it easy to work with the rest of the ASPNET Core MVC using C#
statements.

Razor expressions are added to static HTML in view files. The
expressions are evaluated to generate responses to client requests.

Razor expressions can contain almost any C# statement, and it can
be hard to decide whether logic should belong in the view or in
the controller, which can erode the separation of concerns that is
central to the MVC pattern.

You can write your own view engine, as I explain in Chapter 21.
There are some third-party view engines available, but they tend to
be useful for niche situations and don’t attract long-term support.

Razor works in largely the same way as in MVC 5 but has some
useful enhancements. The view imports file is used to specify
namespaces that will be searched for types when the view is
processed and also defines where tag helpers, which I describe in
Chapter 23, are located.

© Adam Freeman 2016

101

A. Freeman, Pro ASPNET Core MVC, DOI 10.1007/978-1-4842-0397-2_5

VN Secret
Www.vnsecret.com



http://dx.doi.org/10.1007/978-1-4842-0397-2_21
http://dx.doi.org/10.1007/978-1-4842-0397-2_23

CHAPTER 5 © WORKING WITH RAZOR

Table 5-2 summarizes the chapter.

Table 5-2. Chapter Summary

Problem Solution Listing

Access the view model Use an @Model expression to define the 6,15,18
model type and @model expressions to
access the model object

Use type names without qualifying them with Create a view imports file 7-8
namespaces

Define content that will be used by multiple Use a layout 9-11
views

Specity a default layout Use a view start file 12-14
Pass data from the controller to the view outside Use the view bag 16-17
of the view model

Generate content selectively Use Razor conditional expressions 19, 20
Generate content for each item in an array or Use a Razor foreach expression 21-22
collection

Preparing the Example Project

To demonstrate how Razor works, I created an ASP.NET Core Web Application (.NET Core) project called
Razor using the Empty template, just as in the previous chapter. I added the MVC assembly by editing
dependencies section of the project. json file, as shown in Listing 5-1.

Listing 5-1. Adding the MVC Assembly in the project.json File

"dependencies": {
"Microsoft.NETCore.App": {
"version": "1.0.0",
"type": "platform”

)
"Microsoft.AspNetCore.Diagnostics": "1.0.0",

"Microsoft.AspNetCore.Server.IISIntegration": "1.0.0",
"Microsoft.AspNetCore.Server.Kestrel": "1.0.0",
"Microsoft.Extensions.Logging.Console": "1.0.0",
"Microsoft.AspNetCore.Mvc": "1.0.0"

1

When you save the changes to the project. json file, Visual Studio adds the Microsoft.AspNetCore.
Mvc assembly to the project. Next, I enabled MVC with its default configuration in the Startup. cs file, as
shown in Listing 5-2.
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Listing 5-2. Enabling MVC in the Startup.cs File

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Logging;

namespace Razor {
public class Startup {

public void ConfigureServices(IServiceCollection services) {
services.AddMvc();
}

public void Configure(IApplicationBuilder app, IHostingEnvironment env,
ILoggerFactory loggerFactory) {
app.UseMvcliithDefaultRoute();

Defining the Model

Next, I created a Models folder and added to it a class file called Product.cs, which I used to define the
simple model class shown in Listing 5-3.

Listing 5-3. The Contents of the Product.cs File in the Models Folder

namespace Razor.Models {
public class Product {

public int ProductID { get; set; }
public string Name { get; set; }
public string Description { get; set; }
public decimal Price { get; set; }
public string Category { set; get; }

Creating the Controller

The default configuration that I set up in the Startup. cs file follows the MVC convention of sending
requests to a controller called Home by default. I created a Controllers folder and added to it a class file
called HomeController.cs, which I used to define the simple controller shown in Listing 5-4.
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Listing 5-4. The Contents of the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using Razor.Models;

namespace Razor.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

Product myProduct = new Product {
ProductID = 1,
Name = "Kayak",
Description = "A boat for one person”,
Category = "Watersports",
Price = 275 M

};

return View(myProduct);

The controller defines an action method called Index, in which I create and populate the properties
of a Product object. I pass the Product to the View method so that it is used as the model when the view is
rendered. I do not specify the name of a view file when I call the View method, so the default view for the
action method will be used.

Creating the View

To create the default view for the Index action method, I created a Views/Home folder and added to it an
MVC View Page file called Index.cshtml, to which I added the content shown in Listing 5-5.

Listing 5-5. The Contents of the Index.cshtml File in the Views/Home Folder

@model Razor.Models.Product

of
Layout = null;
}
<IDOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
</head>
<body>
Content will go here
</body>
</html>

In the sections that follow, I go through the different parts of a Razor view and demonstrate some of
the different things you can do with one. When learning about Razor, it is helpful to bear in mind that views
exist to express one or more parts of the model to the user—and that means generating HTML that displays
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data that is retrieved from one or more objects. If you remember that I am always trying to build an HTML
page that can be sent to the client, then everything that Razor does begins to make sense. If you run the
application, you will see the simple output shown in Figure 5-1.

[ Index

C | ® localhost:60753 Y| @

X

Content will go here

Figure 5-1. Running the example application

Working with the Model Object

Let’s start with the first line in the Index.cshtml view file:
@model Razor.Models.Product

Razor expressions start with the @ character. In this case, the @model expression declares the type of the
model object that I will pass to the view from the action method. This allows me to refer to the methods,
fields, and properties of the view model object through @Model, as shown in Listing 5-6, which shows a
simple addition to the Index view.

Listing 5-6. Referring to a View Model Object Property in the Index.cshtml File

@model Razor.Models.Product

f
Layout = null;
}
<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
</head>
<body>
@Model.Name
</body>
</html>

Note Notice that | declare the view model object type using @model (a lowercase m) and access the Name
property using @Model (an uppercase M). This is slightly confusing when you start working with Razor, but it
becomes second nature pretty quickly.
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If you run the application, you will see the output shown in Figure 5-2.

[ Index X

C | ® localhost:60753 Y| @

Kayak

Figure 5-2. The effect of reading a property value in the view

A view that uses the @model expression to specify a type is known as a strongly typed view. Visual Studio
is able to use the @model expression to pop up suggestions of member names when you type @Model followed
by a period, as shown in Figure 5-3.

Index.cshtml* & X
@model Razor.Models.Product

ef
Layout = null;
}
<!DOCTYPE html>
= <html>
El<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
| </head>
= <body>
@Model.nf
| :; :‘::{ ; y 4 Categloq‘,r
. A Description
@ Equals
@ GetHashCode
@ GetType
o m string Razor.Models.ProductName { get; set; }
M Price
A ProductiD
@ ToString

Figure 5-3. Visual Studio offering suggestions for member names based on the @Model expression
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The Visual Studio suggestions for member names help avoid errors in Razor views. You can ignore the
suggestions if you prefer, and Visual Studio will highlight problems with member names so that you make
corrections, just as it does with regular C# class files. You can see an example of problem highlighting in
Figure 5-4, where I have tried to reference @odel.NotARealProperty. Visual Studio has realized that the
Product class I specified at the model type does not have such a property and has highlighted an error in the
editor.

NS

-I<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
</head>
-1<body>
@odel.NotARealProperty
</body>
</html>

4 AP e P T

Figure 5-4. Visual Studio reporting a problem with an @Model expression

Using View Imports

When I defined the model object at the start of the Index.cshtml file, I had to include the namespace that
contains the model class, like this:

@model Razox.Models.Product

By default, all types that are referenced in a strongly typed Razor view must be qualified with a
namespace. This isn’t a big deal when the only type reference is for the model object, but it can make a view
more difficult to read when writing more complex Razor expressions such as the ones I describe later in this
chapter.

You can specify a set of namespaces that should be searched for types by adding a view imports file to
the project. The view imports file is placed in the Views folder and is named ViewImports.cshtml.

Note Files in the Views folder whose names begin with an underscore (the _character) are not returned
to the user, which allows the file name to differentiate between views that you want to render and the files that
support them. View imports files and layouts (which | describe shortly) are prefixed with an underscore.

To create the view imports file, right-click the Views folder in the Solution Explorer, select Add » New
Item from the pop-up menu, and select the MVC View Imports Page template from the ASP.NET category, as
shown in Figure 5-5.

Visual Studio will automatically set the name of the file to _ViewImports.cshtml, and clicking the Add
button will create the file. Add the expression shown in Listing 5-7.
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Add New [tem - Razor

4 |nstalled Sort by: Default - 52 |i= Search Installed g
I cs e
ASEHEY @] MVC View Layout Page ASP.NET Type: ASP.NE'
Client-side - " 1
MVC View Impc
Code c# .
ESI MVC View Start Page ASP.NET &
B Onli
nline = ,
E_SI MVC View Imports Page ASP.NET
cn
!‘;j Razor Tag Helper ASP.NET
C# _
gj Middleware Class ASP.NET <
co 4
!:.;j Startup class ASP.NET p
?3 ASP.NET Configuration File ASP.NET ’
i <
Click here to go online and find templates. J
Name: _Viewlmports.cshtml (
-

Figure 5-5. Creating a view imports file

Listing 5-7. The Content of the _ViewImports.cshtml File in the Views Folder

@using Razor.Models

The namespaces that should be searched for classes used in Razor views are specified using the @

using expression, followed by the namespace. In Listing 5-7, I have added an entry for the Razor .Models
namespace that contains the model class in the example application.

Now that the Razor .Models namespace is included in the view imports file, I can remove the

namespace from the Index.cshtml file, as shown in Listing 5-8.

Listing 5-8. Referring to a Model Class without a Namespace in the Index.cshtml File

@model Product

of
Layout = null;

}

<!DOCTYPE html>

<html>

<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>

</head>

<body>
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@Model .Name
</body>
</html>

Tip You can also add an @using expression to individual view files, which allows types to be used without
namespaces in a single view.

Working with Layouts

There is another important Razor expression in the Index.cshtml view file:

ef
Layout = null;
}

This is an example of a Razor code block, which allows me to include C# statements in a view. The code
block is opened with @{ and closed with }, and the statements it contains are evaluated when the view is
rendered.

This code block sets the value of the Layout property to null. Razor views are compiled into C# classes
in an MVC application, and the base class that is used defines the Layout property. I'll show you how this all
works in Chapter 21, but the effect of setting the Layout property to null is to tell MVC that the view is self-
contained and will render all of the content required for the client.

Self-contained views are fine for simple example apps, but a real project can have dozens of views,
and some views will have shared content. Duplicating shared content in views becomes hard to manage,
especially when you need to make a change and have to track down all of the views that need to be altered.

A better approach is to use a Razor layout, which is a template that contains common content and that
can be applied to one or more views. When you make a change to a layout, the change will automatically
affect all the views that use it.

Creating the Layout

Layouts are typically shared by views used by multiple controllers and are stored in a folder called Views/
Shared, which is one of the locations that Razor looks in when it tries to find a file. To create a layout, create
the Views/Shared folder, right-click it, and select Add » New Item from the pop-up menu. Select the MVC
View Layout Page template from the ASP.NET category and set the file name to _Basiclayout.cshtml, as
shown in Figure 5-6. Click the Add button to create the file. (Like view import files, the names of layout files
begin with an underscore.)

Listing 5-9 shows the initial contents of the Basiclayout.cshtml file, added by Visual Studio when it
creates the file.
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Add New Item - Razor

4 Installed Sort by: | Default .| 3= Search Installed Templatg
A c= -
gs_P ':FL "’?.l MVC Controller Class ASP.NET Type: ASP.NET 1
s IZ" e E . MVC View Layout Pagegf
s fe] WebAPIController Class  ASP.NET
: &
P Online -
[6] My viewpage ASP.NET j
{
(<]
@] MVC View Start Page ASP.NET P
cs
@] MVC View Imports Page ASP.NET ,
co o
% Razor Tag Helper ASP.NET #
Click here to go online and find templates.
Name: _BasicLayout.cshtml {

Figure 5-6. Creating a layout

Listing 5-9. The Initial Contents of the _BasicLayout.cshtml File

<IDOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>@ViewBag.Title</title>
</head>
<body>
<div>
@RenderBody()
</div>
</body>
</html>

Layouts are a specialized form of view, and I have highlighted the @ expressions in the listing. The call
to the @RenderBody method inserts the contents of the view specified by the action method into the layout
markup. The other Razor expression in the layout looks for a property called ViewBag.Title in order to
set the contents of the title element. The ViewBag is a handy feature that allows data values to be passed
around an application and, in this case, between a view and its layout. You will see how this works when I
apply the layout to a view.

The HTML elements in a layout will be applied to any view that uses it, providing a template for defining
common content. In Listing 5-10, I have added some simple markup to the layout so that its template effect
will be obvious.
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Listing 5-10. Adding Content to the _BasicLayout.cshtml File

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>@iewBag.Title</title>
<style>
#mainDiv {
padding: 20px;
border: solid medium black;
font-size: 20 pt
}
</style>
</head>
<body>
<h1>Product Information</h1>
<div id="mainDiv"»
@RenderBody()
</div>
</body>
</html>

I have added a header element as well as some CSS to style the contents of the div element that
contains the @RenderBody expression, just to make it clear what content comes from the layout and what
comes from the view.

Applying a Layout

To apply the layout to the view, I need to set the value of the Layout property and remove the HTML that will
now be provided by the layout, such as the html, head, and body elements, as shown in Listing 5-11.

Listing 5-11. Applying a Layout in the Index.cshtml File

@model Product

of
Layout = "_BasicLayout";
ViewBag.Title = "Product Name";

}

Product Name: @Model.Name

The Layout property specifies the name of the layout file that will be used for the view, without the
cshtml file extension. Razor will look for the specified layout file in the /Views/Home and Views/Shared
folders.

I also set the ViewBag.Title property in the listing. This will be used by the layout to set the contents of
the title element when the view is rendered.
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The transformation of the view is dramatic, even for such a simple application. The layout contains all
of the structure required for any HTML response, which leaves the view to focus on just the dynamic content
that presents the data to the user. When MVC processes the Index.cshtml file, it applies the layout to create
a unified HTML response, as shown in Figure 5-7.

[ Product Name x

C [ localhost:60631 Lol =

Product Information

Product Name: Kayak

Figure 5-7. The effect of applying a layout to a view

Using a View Start File

I still have a tiny wrinkle to sort out, which is that I have to specify the layout file I want in every view.
Therefore, if I need to rename the layout file, I am going to have to find every view that refers to it and make
a change, which will be an error-prone process and counter to the general theme of easy maintenance that
runs through MVC development.

I can resolve this by using a view start file. When it renders a view, MVC will look for a file called
_ViewStart.cshtml. The contents of this file will be treated as though they were contained in the view file
itself, and I can use this feature to automatically set a value for the Layout property.

To create a view start file, right-click the Views folder, select Add » New Item from the pop-up menu,
and choose the MVC View Start Page template from the ASP.NET category, as shown in Figure 5-8.
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Add New Item - Razor

4 Installed Sort by: Default - ;3‘ — Search Installed Templates (Cw’
cs
zfp'?qd @] MVC View Layout Page ASPNET Type: ASP.NET ¢
c ‘;“ Teide MVC View Start Page
oce @ MVC View Start Page ASP.NET
b Online o 1
@ MVC View Imports Page ASP.NET ¢
.I;j Razor Tag Helper ASP.NET ’
-
Ccn
§e] Middieware Class ASP.NET ?
‘il_gj Startup class ASP.NET J
?3 ASP.NET Configuration File ~ ASP.NET
v (
Click here to go online and find templates. {
L
A
Name: _ViewStart.cshtml 4

Figure 5-8. Creating a view start file

Visual Studio will set the name of the file to _ViewStart.cshtml automatically, and clicking the Add
button will create the file with the initial content shown in Listing 5-12.

Listing 5-12. The Initial Contents of the _ViewStart.cshtml File

ef
Layout =
}

_Layout";
To apply my layout to all the views in the application, I changed the value assigned to the Layout
property, as shown in Listing 5-13.

Listing 5-13. Applying a Default View in the _ViewStart.cshtml File

o{
Layout = "_BasicLayout";
}

Since the view start file contains a value for the Layout property, I can remove the corresponding
expression from the Index.cshtml file, as shown in Listing 5-14.
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Listing 5-14. Updating the Index.cshtml File to Reflect the Use of a View Start File
@model Product

o{

}

ViewBag.Title = "Product Name";

Product Name: @Model.Name

I do not have to specify that I want to use the view start file. MVC will locate the file and use its contents
automatically. The values defined in the view file take precedence, which makes it easy to override the view
start file.

You can also use multiple view start files to set defaults for different parts of the application. Razor
looks for the closest view start file to the view that it being processed, which means that you can override the
default setting by adding a view start file to the Views/Home or Views/Shared folders, for example.

Caution It is important to understand the difference between omitting the Layout property from the view
file and setting it to null. If your view is self-contained and you do not want to use a layout, then set the Layout
property to null. If you omit the Layout property, then MVC will assume that you do want a layout and that it
should use the value it finds in the view start file.

Using Razor Expressions

Now that I have shown you the basics of views and layouts, I am going to turn to the different kinds

of expressions that Razor supports and how you can use them to create view content. In a gopod MVC
application, there is a clear separation between the roles that the action method and view perform. The rules
are simple; I have summarized them in Table 5-3.

Table 5-3. The Roles Played by the Action Method and the View

Component Does Do Doesn’t Do

Action method Passes a view model object to the view Passes formatted data to the view

View Uses the view model object to present content Changes any aspect of the view model
to the user object

I come back to this theme throughout this book. To get the best from MVC, you need to respect
and enforce the separation between the different parts of the app. As you will see, you can do quite a lot
with Razor, including using C# statements—but you should not use Razor to perform business logic or
manipulate your domain model objects in any way.

As a simple example, Listing 5-15 shows the addition of a new expression to the Index view.

114

VN Secret
Www.vnsecret.com



CHAPTER 5 WORKING WITH RAZOR

Listing 5-15. Adding an Expression to the Index.cshtml File
@model Product

of
}

ViewBag.Title = "Product Name";

<p>Product Name: @Model.Name</p>
<p>Product Price: @($"{Model.Price:C2}")</p>

I could have formatted the value of the Price property in the action method and passed it to the view.
It would have worked, but taking this approach undermines the benefit of the MVC pattern and reduces
my ability to respond to changes in the future. As I said, I will return to this theme again, but you should
remember that ASP.NET Core MVC does not enforce proper use of the MVC pattern and that you must
remain aware of the effect of the design and coding decisions you make.

PROCESSING VERSUS FORMATTING DATA

It is important to differentiate between processing data and formatting it. Views format data, which is
why | passed the Product object in the previous section to the view, rather than formatting the object’s
properties into a display string. Processing data—including selecting the data objects to display—is the
responsibility of the controller, which will call on the model to get and modify the data it requires. It can
sometimes be hard to figure out where the line between processing and formatting is, but as a rule of
thumb, | recommend erring on the side of caution and pushing anything but the simplest of expressions
out of the view and into the controller.

Inserting Data Values

The simplest thing you can do with a Razor expression is to insert a data value into the markup. The most
common way to do this is with the @odel expression. The Index view already includes examples of this
approach, like this:

<p>Product Name: @Model.Name</p>

You can also insert values using the ViewBag feature, which is the feature I used in the layout to set
the content of the title element. The ViewBag can be used to pass data from the controller to the view,
supplementing the model, as shown in Listing 5-16.

Listing 5-16. Using the View Bag in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using Razor.Models;
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namespace Razor.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
Product myProduct = new Product {
ProductID = 1,
Name = "Kayak",
Description = "A boat for one person”,
Category = "Watersports",
Price = 275 M

};
ViewBag.StockLevel = 2;

return View(myProduct);

The ViewBag property returns a dynamic object that can be used to define arbitrary properties. In
the listing, I have defined a property called StockLevel and assigned a value of 2 to it. Since the ViewBag
is dynamic, I don’t have to declare the property names in advance, but it does mean that Visual Studio is
unable to provide autocomplete suggestions for view bag properties.

Knowing when to use the view bag and when the model should be extended is a matter of experience
and personal preference. My personal style is to use the view bag only to give a view hints about how to
render data and not to use it for data values that are displayed to the user. But that’s just what works for me.
If you do use the view bag for data you want to display to the user, then you access values using the @ViewBag
expression, as shown in Listing 5-17.

Listing 5-17. Displaying a View Bag Value in the Index.cshtml File
@model Product

of
}

ViewBag.Title = "Product Name";

<p>Product Name: @Model.Name</p>
<p>Product Price: @($"{Model.Price:C2}")</p>
<p>Stock Level: @ViewBag.StockLevel</p>

Figure 5-9 shows the result of the new data value.
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[ Product Name x

C | ® localhost:60753 * ¢

Product Information

Product Name: Kayak
Product Price: $275.00

Stock Level: 2

Figure 5-9. Using Razor expressions to insert data values

Setting Attribute Values

All the examples so far have set the content of elements, but you can also use Razor expressions to set the
value of element attributes. Listing 5-18 shows the user of the @odel and @ViewBag expressions to set the
contents of attributes on elements in the Index view.

Listing 5-18. Using Razor Expressions to Set Attribute Values in the Index.cshtml File
@model Product

of
}

<div data-productid="@Model.ProductID" data-stocklevel="@ViewBag.StockLevel"»
<p>Product Name: @Model.Name</p>
<p>Product Price: @($"{Model.Price:C2}")</p>
<p>Stock Level: @ViewBag.StocklLevel</p>

</div>

ViewBag.Title = "Product Name";

I used the Razor expressions to set the value for some data attributes on a div element.

Tip Data attributes, which are attributes whose names are prefixed by data-, have been an informal way
of creating custom attributes for many years and have been made part of the formal standard as part of HTML5.
They are most often applied so that JavaScript code can locate specific elements or so that CSS styles can be
more narrowly applied.
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If you run the example application and look at the HTML source that is sent to the browser, you will see
that Razor has set the values of the attributes.

<div data-stocklevel="2" data-productid="1"»
<p>Product Name: Kayak</p>
<p>Product Price: $275.00</p>
<p>Stock Level: 120</p>

</div>

Using Conditional Statements

Razor is able to process conditional statements, which means that I can tailor the output from a view based
on values in the view data. This kind of technique is at the heart of Razor and allows you to create complex
and fluid layouts that are still reasonably simple to read and maintain. In Listing 5-19, I have updated the
Index view so that it includes a conditional statement.

Listing 5-19. Using a Conditional Razor Statement in the Index.cshtml File

@model Product
o{

}

<div data-productid="@Model.ProductID" data-stocklevel="@ViewBag.StockLevel">
<p>Product Name: @Model.Name</p>
<p>Product Price: @($"{Model.Price:C2}")</p>
<p>Stock Level:
@switch ((int)ViewBag.StockLevel) {
case 0:
@:0ut of Stock
break;
case 1:
case 2:
case 3:
<bs>Low Stock (@ViewBag.StockLevel)</bs
break;
default:
@: @ViewBag.StockLevel in Stock
break;

ViewBag.Title = "Product Name";

}
</p>
</div>

To start a conditional statement, you place an @ character in front of the C# conditional keyword, which
is switch in this example. You terminate the code block with a close brace character (}) just as you would
with a regular C# code block.

Tip  Notice that | had to cast the value of the ViewBag.ProductCount property to an int in order to use
it with a switch statement. This is required because the Razor switch expression cannot evaluate a dynamic
property—you must cast to a specific type so that it knows how to perform comparisons.
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Inside the Razor code block, you can include HTML elements and data values into the view output just
by defining the HTML and Razor expressions, like this:

<bs>Low Stock (@ViewBag.StockLevel)</bs

I do not have to put the elements or expressions in quotes or denote them in any special way—the Razor
engine will interpret these as output to be processed. However, if you want to insert literal text into the view
when it is not contained in an HTML element, then you need to give Razor a helping hand and prefix the line
like this:

@: Out of Stock

The @: characters prevent Razor from interpreting this as a C# statement, which is the default behavior
when it encounters text. You can see the result of the conditional statement in Figure 5-10.

[} Product Name x

C | ® localhost:60753 Y| i

Product Information

Product Name: Kayak
Product Price: $275.00

Stock Level: Low Stock (2)

Figure 5-10. Using a switch statement in a Razor view

Conditional statements are important in Razor views because they allow content to be varied based on
the data values that the view receives from the action method. As an additional demonstration, Listing 5-20
shows the addition of an if statement to the Index.cshtml view. As you might imagine, this is a commonly
used conditional statement.
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Listing 5-20. Using an if Statement in a Razor View in the Index.cshtml File

@model Product
of
}

<div data-productid="@Model.ProductID" data-stocklevel="@ViewBag.StockLevel">
<p>Product Name: @Model.Name</p>
<p>Product Price: @($"{Model.Price:C2}")</p>
<p>Stock Level:
@if (ViewBag.StockLevel == 0) {
@:0ut of Stock
} else if (ViewBag.StockLevel » 0 3& ViewBag.StockLevel <= 3) {
<b>Low Stock (@ViewBag.StockLevel)</b>
} else {
@: @ViewBag.StockLevel in Stock
}

</p>
</div>

ViewBag.Title = "Product Name";

This conditional statement produces the same results as the switch statement, but I wanted to
demonstrate how you can mesh C# conditional statements with Razor views. I explain how this works in
Chapter 21, when I describe views in depth.

Enumerating Arrays and Collections

When writing an MVC application, you will often want to enumerate the contents of an array or some other kind
of collection of objects and generate content that details each one. To demonstrate how this is done, in Listing 5-21
I have revised the Index action in the Home controller to pass an array of Product objects to the view.

Listing 5-21. Using an Array in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using Razor.Models;

namespace Razor.Controllers {
public class HomeController : Controller {

public IActionResult Index() {
Product[] array = {

new Product {Name

new Product {Name

"Kayak", Price = 275 M},
"Lifejacket", Price = 48.95 M},

new Product {Name = "Soccer ball", Price = 19.50 M},
new Product {Name = "Corner flag", Price = 34.95 M}
b
return View(array);
}
}
}
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This action method creates a Product[ ] object that contains simple data values and passes them to the
View method so that the data is rendered using the default view. In Listing 5-22, I have changed the model
type for the Index view and used a foreach loop to enumerate the objects in the array.

Tip The Model term in Listing 5-22 doesn’t need to be prefixed with an @ character because it is part of a
larger C# expression. It can be difficult to figure out when an @ character is required and when it is not but the
Visual Studio IntelliSense for Razor files will tell you when you get it wrong by underlining errors.

Listing 5-22. Enumerating an Array in the Index.cshtml File

@model Product[]

o{
ViewBag.Title = "Product Name";
}
<tabley
<thead»
<tr><th>Name</th><th>Price</th></tr>
</thead»
<tbody>
@foreach (Product p in Model) {
<try
<td>@p.Name</td>
<td>@($"{p.Price:C2}")</td>
</tr>
}
</tbody>
</tables

The @foreach statement enumerates the contents of the model array and generates a row in a table for
each of them. You can see how I created a local variable called p in the foreach loop and then referred to its
properties using the Razor expressions @p.Name and @p.Price. You can see the result in Figure 5-11.
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[} Product Name x

C | ® localhost:60753 Y| i

Product Information

Name  Price
Kayak $275.00
Lifejacket $48.95
Soccer ball $19.50
Corner flag $34.95

Figure 5-11. Using Razor to enumerate an array

Summary

In this chapter, I gave you an overview of the Razor view engine and how it can be used to generate HTML.

I showed you how to refer to data passed from the controller via the view model object and the view bag
and how Razor expressions can be used to tailor responses to the user based on data values. You will see
many different examples of how Razor can be used in the rest of the book, and I describe how the MVC view
mechanism works in detail in Chapter 21. In the next chapter, I introduce some of the features provided by
Visual Studio for working with ASP.NET Core MVC projects.
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CHAPTER 6

Working with Visual Studio

In this chapter, I describe the key features that Visual Studio provides for developing ASP.NET Core MVC
projects. Table 6-1 summarizes the chapter.

Table 6-1. Chapter Summary

Problem Solution Listing
Add .NET packages to a project Edit the dependencies section of the 1-6
project.json file or use the NuGet tool
Add JavaScript or CSS packages to a project Create a bower. json file and add the 7,8
required packages to the dependencies
section.
See the effect of view or class changes Use the iterative development model 9-11
Display detailed messages in the browser Use developer exception pages 12
Get detailed information and control about Use the debugger 13
application execution
Reload one or more browsers using Visual Use Browser Link 14-16
Studio
Reduce the number of HTTP requests and the Use the Bundler & Minifier extension 17-28
amount of bandwidth required for JavaScript
and CSS files

Note As | explained in Chapter 2, Microsoft has said that it will change the tools that are used to create
ASP.NET Core applications in future releases of Visual Studio. This means that the instructions in this chapter
may become outdated. See the Apress.com page for this book for revised instructions, which | will write when
the new tools have been released and are stable.

Preparing the Example Project

For this chapter, I created a new ASP.NET Core Web Application (.NET Core) project called
WorkingWithVisualStudio using the Empty template. I added the MVC assembly by editing the
dependencies section of the project. json file, as shown in Listing 6-1.
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Listing 6-1. Adding the MVC Assembly in the project.json File

"dependencies": {
"Microsoft.NETCore.App": {
"version": "1.0.0",
"type": "platform"

)
"Microsoft.AspNetCore.Diagnostics": "1.0.0",

"Microsoft.AspNetCore.Server.IISIntegration": "1.0.0",
"Microsoft.AspNetCore.Server.Kestrel": "1.0.0",
"Microsoft.Extensions.Logging.Console": "1.0.0",
"Microsoft.AspNetCore.Mvc": "1.0.0"

1

Next, I enabled MVC with its default configuration in the Startup.cs file, as shown in Listing 6-2.

Listing 6-2. Enabling MVC in the Startup.cs File

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Logging;

namespace WorkingWithVisualStudio {
public class Startup {

public void ConfigureServices(IServiceCollection services) {
services.AddMvc();
}

public void Configure(IApplicationBuilder app, IHostingEnvironment env,
ILoggerFactory loggerFactory) {
app .UseMvcliithDefaultRoute();

Creating the Model

I created a Models folder and added to it a class file called Product.cs, which I used to define the class
shown in Listing 6-3.

Listing 6-3. The Contents of the Product.cs File in the Models Folder

namespace WorkingWithVisualStudio.Models {

public class Product {
public string Name { get; set; }
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public decimal Price { get; set; }

To create a simple store of Product objects, I added a class file called SimpleRepository.cs to the
Models folder and used it to define the class shown in Listing 6-4.

Listing 6-4. The Contents of the SimpleRepository.cs File in the Models Folder

using System.Collections.Generic;

namespace WorkingWithVisualStudio.Models {
public class SimpleRepository {
private static SimpleRepository sharedRepository = new SimpleRepository();
private Dictionary<string, Product> products
= new Dictionary<string, Product>();

public static SimpleRepository SharedRepository => sharedRepository;

public SimpleRepository() {
var initialItems = new[] {
new Product { Name = "Kayak", Price = 275M },
new Product { Name = "Lifejacket", Price = 48.95M },
new Product { Name = "Soccer ball", Price = 19.50M },
new Product { Name = "Corner flag", Price = 34.95M }

};

foreach (var p in initialItems) {
AddProduct(p);

}

}

public IEnumerable<Product> Products => products.Values;

public void AddProduct(Product p) => products.Add(p.Name, p);

This class stores model objects in memory, which means that any changes to the model are lost when
the application is stopped or restarted. A non-persistent store is sufficient for the examples in this chapter,
butitisn’t an approach that can be used in many real projects; see Chapter 8 for an example of creating a
repository that stores model objects persistently using a relational database.

Note In Listing 6-4, | defined a static property called SharedRepository that provides access to a single
SimpleRepository object that can be used throughout the application. This isn’t best practice, but | want to
demonstrate a common problem that you will encounter in MVC development; | describe a better way to work
with shared components in Chapter 18.
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Creating the Controller and View

I added a Controllers folder to the project and added to it a class file called HomeController.cs, whichI
used to define the controller shown in Listing 6-5.

Listing 6-5. The Contents of the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using WorkingWithVisualStudio.Models;

namespace WorkingWithVisualStudio.Controllers {
public class HomeController : Controller {

public IActionResult Index()
=> View(SimpleRepository.SharedRepository.Products);

There is a single action—called Index—that gets all of the model objects and passes them to the View
method to render the default view. To add that view, I created the Views/Home folder and added a view file
called Index.cshtml, the contents of which are shown in Listing 6-6.

Listing 6-6. The Contents of the Index.cshtml File in the Views/Home Folder

@model IEnumerable<WorkingWithVisualStudio.Models.Product>
@{ Layout = null; }

<!DOCTYPE html>

<html>

<head>
<meta name="viewport" content="width=device-width" />
<title>Working with Visual Studio</title>

</head>
<body>
<table>
<thead>
<tr><td>Name</td><td>Price</td></tr>
</thead>
<tbody>
@foreach (var p in Model) {
<tr>
<td>@p.Name</td>
<td>@p.Price</td>
</tr>
}
</tbody>
</table>
</body>
</html>

The view contains a table that uses a Razor foreach loop to create rows for each model object, where
each row contains cells for the Name and Price properties. If you run the example application, you will see
the results shown in Figure 6-1.
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[ Working with Visual Stuc X

C | ® localhost:61207 d
Name Price
Kayak 275

Lifejacket 48.95
Soccer ball 19.50
Comer flag 34.95

Figure 6-1. Running the example application

SELECTING A .NET RUNTIME

When you create a new ASP.NET Core project, you have to choose between two similarly named
project templates: ASP.NET Core Web Application (.NET Core) and ASP.NET Core Web Application (.NET
Framework). Both templates can be used to create applications using ASP.NET Core MVC, and the
difference between them is the .NET runtime that executes the code.

.NET Core is a small optimized runtime originally created specifically for ASP.NET but that has now
taken on a broader role for other types of .NET application. It has been designed to be cross-platform
and provides opportunities for deploying ASP.NET applications outside of the traditional set of Windows
platforms and into lightweight cloud containers like Docker. The.NET Core runtime will support Windows,
Mac 0S, FreeBSD, and Linux; it has been designed to be modular and includes only the assemblies that
an application requires, which gives a smaller and simpler footprint for deployment. The .NET Core API
is also smaller because it removes features that are specific to Windows and that cannot be supported
on other platforms.

In the short-term, the choice of runtime for your projects will be driven by the tools and libraries that
you depend on. It will take a while for third-party software to be updated to work with .NET Core and to
reach the levels of stability required for production use. If you depend on a package of tool that requires
the full .NET Framework (or if you have a legacy codebase that you can’t update), then you should use
the ASP.NET Core Web Application (.NET Framework) option when you create your ASP.NET projects. You
can still use all of the features that | describe in this book, and the only difference is the runtime that
executes the code.

That said, the future of ASP.NET is .NET Core. That doesn’t mean you have to switch existing projects
immediately, but it does mean that you shouldn’t create any new dependencies on the .NET Framework
if you can help it, and you should consider the path to .NET Core support when selecting new tools

and libraries. You can learn more about.NET Core at https://docs.microsoft.com/en-us/dotnet/
articles/welcome.
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Managing Software Packages

There are two different types of software package required for ASP.NET Core MVC projects. In the
sections that follow, I describe each type of package and the tools that are provided by Visual Studio for
managing them.

Understanding NuGet

Visual Studio provides a graphical tool for managing the .NET packages that are included in a project. To
open the tool, select Manage NuGet Packages for Solution from the Tools » NuGet Package Manager menu.
The NuGet tool opens and displays a list of the packages that are already installed, as shown in Figure 6-2.

MNuGet - Solution & X
Browse In ed Updates Consolidate Manage Packages for Solution
Search (Ctri+E) P - ¢ W include prerelease Package source:  api.nuget.org - &
= .
- Microsoft. AspNetCore.Mvc
Microsoft.AspMetCore.Diagnostics by Microsoft.AspNetCore.Diagnostics v1.00
ASP.NET Core middleware for exception handling, exception display pages, and Version(s) - 1
diag 5 inf tion. Includes devel exception page middleware, exception han... £ s
[ Project ~ Version
.+ Microsoft.AspNetCore.Mvc by Microsoft.AspNetCore.Mvc [0 sre\WorkingWithVisu 1.0.0
=
&) ASP.NET Core MVC is a web framework that gives you a powerful, patterns-based way to
build dynamic websites and web APls. ASP.NET Core MVC enables a clean separation of...
Microsoft.AspNetCore.Server.lISIntegration by Microsoft. AspNetCoreServe  ¥1.0.0
ASP.NET Core components for working with the IIS AspNetCoreModule.
Microsoft.AspNetCore.Server.lISIntegration.Tools by Micr,  v1.0.0-previewZ-final
15 Integration publish teel for NET Core CLI. Contains the dotnet-publish-

Prereiease iis command for publishing web applications to be hosted using li5. Installed: 1.0.0 Uninstall
Microsoft.AspNetCore.Server.Kestrel by Microsoft AspNetCore.Server Kestrel V100 Version:  Latest stable 1.0.0 nstall
ASP.NET Core Kestrel cross-platform web server.

. . ; Q) Options
Microsoft.Extensions.Logging.Console by Microsoft.Extensions.Logging.Cons  ¥1.00
Console logger provider impl ion for Microsoft.E ions.Logging.
Description
ASP.NET Core MVC is a web framework that gives
Microsoft.NETCore.App by Microsoft v1.00 you a powerful, patterns-based way to build
A set of NET API's that are included in the default NET Core application model. »  dynamic websites and web APIs. ASP.NET CoreMVC

Figure 6-2. Using the NuGet package manager

The Installed tab provides a summary of the packages that are already installed in the project. The
Browse tab can be used to locate and install new packages and the Updates tab can be used to list packages
for which more recent versions have been released.
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Understanding the NuGet Packages List and Location

The NuGet tool manages the contents of the dependencies section of the project. json file, which is created
by Visual Studio when a new project is set up, even when using the Empty template.

Note Microsoft intends to change the tooling for ASP.NET in future releases of Visual Studio. One change
that has been announced (but not implemented) is that the project. json file won’t be used to manage NuGet
packages. See the Apress.com page for this book for updates when the Microsoft releases the new versions.

I describe the other sections of the project. json file in Chapter 14, but if you inspect the list of
packages shown in the NuGet tool you will see it corresponds to the dependencies items, which are as
follows for the example project:

"dependencies": {

"Microsoft.NETCore.App": {

"version": "1.0.0",

"type": "platform"
}
"Microsoft.AspNetCore.Diagnostics": "1.0.0",
"Microsoft.AspNetCore.Server.IISIntegration": "1.0.0",
"Microsoft.AspNetCore.Server.Kestrel": "1.0.0",
"Microsoft.Extensions.Logging.Console": "1.0.0",
"Microsoft.AspNetCore.Mvc": "1.0.0"

1

Each package is specified with its name and the version number that is required. Some packages, such
as the Microsoft.NetCore.App package in the example project, have additional configuration information,
which I explain in Chapter 14. Visual Studio monitors the contents of the project.json file, which means that
you can add or remove packages by editing the file directly, which is what I do throughout this book because
it helps ensure that you will get the expected results if you are following along.

When you use NuGet to add a package to a project, it is automatically installed along with any packages
it depends on. You can explore the NuGet packages and their dependencies by opening the References
item in the Solution Explorer, which contains an entry for each NuGet package in the project. json file.
Expanding a package item shows the packages it depends on, as shown in Figure 6-3. As the figure shows,
when [ added the Microsoft.AspNetCore.Mvc package in Listing 6-1, NuGet downloaded and installed that
package and many others that are required for MVC development.
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Solution Explorer v B X
COR| o-sa@|F -
Search Solution Explorer (Ctrl+;) R~

=0 References
4 BHR .NETCoreApp,Version=v1.0
b ‘@ Microsoft.AspNetCore.Diagnostics (1.0.0)
4[5 Microsoft.AspNetCore.Mvc (1.0.0)
b ‘@ Microsoft.AspNetCore.Mvc.ApiExplorer (1.0.0)
b ‘@ Microsoft.AspNetCore.Mvc.Cors (1.0.0)
P '@ Microsoft.AspNetCore.Mvc.DataAnnotations (1.0.0)
b ‘@ Microsoft.AspNetCore.Mvc.Formatters.Json (1.0.0)
'@ Microsoft.AspNetCore.Mvc.Localization (1.0.0)
'B Microsoft.AspNetCore.Mvc.Razor (1.0.0)
‘@ Microsoft.AspNetCore.Mvc.TagHelpers (1.0.0)
@ Microsoft.AspNetCore.Mvc.ViewFeatures (1.0.0)
b '@ Microsoft.Extensions.Caching.Memory (1.0.0)
b '@ Microsoft.Extensions.Dependencylinjection (1.0.0)
=8 Microsoft.AspNetCore.Mvc.dll
B Microsoft.AspNetCore.Server.lISIntegration (1.0.0)
'@ Microsoft.AspNetCore.Server.Kestrel (1.0.0)
'@ Microsoft.Extensions.Logging.Console (1.0.0)
'@ Microsoft.NETCore.App (1.0.0)
@ Microsoft.VisualStudio.Web.BrowserLink.Loader (14.0.0)

p
b
b
p

v v v vw

Figure 6-3. The References section of the Solution Explorer

Understanding Bower

A client-side package is one that contains content that is sent the client, such as JavaScript files, CSS
stylesheets or images. NuGet used to be used to manage these projects as well, but ASP.NET Core MVC relies
on a new tool, called Bower. Bower is an open-source tool that has been developed outside of Microsoft and
the .NET world and is widely used in non-ASP.NET web application development. In fact, Bower has become
so successful that some popular client-side packages are only distributed through Bower.

Understanding the Bower Packages List

Bower packages are specified through the bower . json file. To create this file, right click the
WorkingWithVisualStudio project item in the Solution Explorer, select Add » New Item from the pop-up
menu, and choose the Bower Configuration File item template from the Client-Side category, as shown in
Figure 6-4.
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Add New Item - WorkingWithVisualStudio

4 |nstalled Sort by: Default .| 3= Search Installed Templ.‘at’eq_
ASP.NET - - -
e g Oq TypeScript JSON Configuration File ~ Client-side Type: Client-side
C ld . Bower Configuration [
ode
@ Bower Configuration File Client-side and .bowerrc. )
b Online 4
g npm Configuration File Client-side J
By T o 4
-J Gulp Configuration File Client-side P
sz ) . ) ) ) A
-J Grunt Configuration File Client-side /
5 JSON Schema File Client-side o
S <
r JSX File Client-side
L&y v T
Click here to go online and find templates. -
Name: bower.json ’

Figure 6-4. Creating the Bower configuration file

Note Bower uses the git tool to download client-side packages. You must replace the Visual Studio
version of git for Bower to work correctly, as described in Chapter 2.

Visual Studio sets the name to bower. json, and clicking the Add button adds the file to the project with
the default content shown in Listing 6-7.

Tip  Visual Studio hides bower. json by default, and it must be revealed by clicking the Show All Files
button at the top of the Solution Explorer window.

Listing 6-7. The Default Contents of the bower.json File

{

"name": "asp.net",
"private": true,
"dependencies": {

}

131

VN Secret
www.vnsecret.com


http://dx.doi.org/10.1007/978-1-4842-0397-2_2

CHAPTER 6 © WORKING WITH VISUAL STUDIO

Listing 6-8 shows the addition of a client-side package to the bower. json file, which is done by adding
an entry to the dependencies section using the same format as the project. json file.

Tip The repository for Bower packages is http://bower.io/search, where you can search for packages
to add to your project.

Listing 6-8. Adding Packages to the bower.json File

{
"name": "asp.net",
"private": true,
"dependencies": {
"bootstrap": "3.3.6"
}
}

The addition in the listing adds the Bootstrap CSS package to the example project. When you edit the
bower. json file, Visual Studio will offer you a list of package names and list the versions of the packages that
are available, as shown in Figure 6-5.

M WorkingWithVisualStudio - bower.json®

NuGet - Solution bowerjson* £ X

Schema: http://json.schemastore.org/bower
-:{
"name": "asp.net”,
"private”: true,

E “dependencies": {
"bootstrap”: "M

L} &% The latest stable version of the package
} & 336
B ~336

Figure 6-5. Listing the available versions of the client-side package

At the time of writing, the latest version of the bootstrap package is 3.3.6. Notice, however, that there
are three options offered by Visual Studio: 3.3.6, *3.3.6, and ~3.3.6. Version numbers can be specified in a
range of different ways in the bower . json file, the most useful of which are described in Table 6-2. The safest
way to specify a package is to use an explicit version number. This ensures that you will always be working
with the same version unless you deliberately update the bower. json file to request a different one.
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Table 6-2. Common Formats for Version Numbers in the bower.json File

Format Description

3.3.6 Expressing a version number directly will install the package with the exactly
matching version number, e.g., 3.3.6.

* Using an asterisk will allow Bower to download and install any version of the package.

>3.3.6 >=3.3.6  Prefixing a version number with > or > = will allow Bower to install any version of the

<3.3.6 <=3.3.6

~3.3.6

"3.3.6

package that is greater than or greater than or equal to a given version.

Prefixing a version number with < or < = will allow Bower to install any version of the
package that is less than or less than or equal to a given version.

Prefixing a version number with a tilde (the ~ character) will allow Bower to install
versions even if the patch level number (the last of the three version numbers) doesn’t
match). For example, specifying ~3.3.6 will allow Bower to install version 3.3.7 or
3.3.8 (which would be patches to version 3.3.6) but not version 3.4.0 (which would be
a new minor release).

Prefixing a version number with a caret (the * character) will allow Bower to install
versions even if the minor release number (the second of the three version numbers)
or the patch number doesn’t match. For example, specifying "3.3.0 will allow Bower
to install versions 3.3.1, 3.4.0, and 3.5.0, for example, but not version 4.0.0.

Tip  For the examples in this book, | create and edit the bower . json file directly. The file is simple
to edit and it helps ensure that you get the expected results if you are following along. Visual Studio also
provides a graphical tool for managing Bower packages, which can be opened by right clicking on the
WorkingWithVisualStudio project in the Solution Explorer (the item that is the parent of the bower . json file)
and selecting Manage Bower Packages from the popup menu.

Visual Studio monitors the bower . json files for changes and automatically uses the Bower tool to
download and install packages. When you save the change to the file for Listing 6-8, Visual Studio will
download the Bootstrap package and install it into the wawroot/1ib folder, as shown in Figure 6-6.

Solution Explorer v O X
COR o-5TE|F -
Search Solution Explorer (Ctrl+;) P~
4 lib

b bootstrap

4 Jquery

Figure 6-6. Adding client-side packages to the project
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Like NuGet, Bower manages the dependencies of the packages you add to a project. Bootstrap relies on
the jQuery JavaScript library for some of its advanced features, which is why there are two packages shown
in the figure. You can see the list of packages and their dependencies by expanding the Dependencies item in
the Solution Explorer, as shown in Figure 6-7.

Solution Explorer *OX
o o-5a@| L=
Search Solution Explorer (Ctrl+;) pe i

(0 Dependencies

4 o Bower
4 [ bootstrap (3.3.6)

i jquery (22.4)

Figure 6-7. Examining the client-side packages and their dependencies

WHAT HAPPENED TO NPM AND GULP?

During the early development of ASPNET Core, Microsoft adopted two other popular open-source development
tools from outside the .NET ecosystem: NPM and Gulp. NPM is a package manager for development tools that
are executed by the Node.js JavaScript engine and Gulp is a JavaScript-based task runner that allows scripts
to be written to perform development tasks, such as concatenating and minifying files.

Just before the release of ASP.NET Core 1.0, Microsoft had a change of heart and these tools are no
longer used automatically in the MVC project templates. One of the most common tasks for which Gulp
is used is now provided by the Visual Studio extension that | describe in the Preparing JavaScript and
CSS for Deployment section of this chapter.

Visual Studio still supports NPM and Gulp and they can still be used for projects that have a complex
client-side component. This can be useful because there are useful tools and packages that are only
available through NPM and which can only be customized using Gulp. See my Pro Client Development
for ASPNET Core MVC Developers book for details.

Understanding Iterative Development

Web application development can often be an iterative process, where you make small changes to views
or classes and run the application to test their effect. MVC and Visual Studio work together to support this
iterative approach to make seeing the impact of changes quick and easy.

Making Changes to Razor Views

During development, changes to Razor views take effect as soon as an HTTP request is received from the
browser. To demonstrate how this works, start the application by selecting Start Debugging from the Debug
menu and, once a browser tab has been opened and the data displayed, make the changes shown in Listing 6-9
to the Index.cshtml file.
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Listing 6-9. Making Changes to the Index.cshtml File

@model IEnumerable<WorkingWithVisualStudio.Models.Product>
@{ Layout = null; }

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Working with Visual Studio</title>
</head>
<body>
<h3>Products</h3>
<table>
<thead>
<tr><td>Name</td><td>Price</td></tr>
</thead>
<tbody>
@foreach (var p in Model) {
<tr>
<td>@p.Name</td>
<td>@($"{p.Price:C2}")</td>
</tr>
}
</tbody>
</table>
</body>
</html>

Save the changes to the Index view and reload the current web page using the browser reload button.
The changes to the view (the addition of a header and formatting the Price model property as a currency)
take effect and are shown in the browser, as illustrated in Figure 6-8.

[ Working with Visual Stuc X

C | ® localhost:61207 w

Products

Name Price

Lifejacket $48.95
Soccer ball $19.50
Comer flag $34.95

Figure 6-8. Making a change to a view
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Tip | explain the process by which Razor views are prepared for use in Chapter 21.

Making Changes to C# Classes

For C# classes, including controllers and models, the way that changes are handled depend on how you
start the application. In the sections that follow, I describe the two approaches available, which are selected
through different items in the Debug menu, as described in Table 6-3 for quick reference.

Table 6-3. The Debug Menu Items

Menu Iltem Description

Start Without Debugging  The classes in the project are compiled automatically when an HTTP request
is received, allowing for a more dynamic development experience. The
application is run without the debugger, which cannot be used to take control
of code execution.

Start Debugging In this development style you must explicitly compile your project and restart the
application for changes to take effect. The debugger is attached to the application
when it runs, allowing inspection of its state and analysis of any problems.

Compiling Classes Automatically

During normal development, a fast iterative cycle lets you see the effect of your changes immediately,
whether it is the effect of adding a new action or changing the way that view model data is selected. For this
kind of development, Visual Studio supports detecting changes as soon as an HTTP request is received from
the browser and recompiling classes automatically. To see how this works, select Start Without Debugging
from the Visual Studio Debug menu. Once the browser displays the application data, make the changes
shown in Listing 6-10 to the Home controller.

Listing 6-10. Filtering Model Data in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using WorkingWithVisualStudio.Models;
using System.Ling;

namespace WorkingWithVisualStudio.Controllers {
public class HomeController : Controller {

public IActionResult Index()
=> View(SimpleRepository.SharedRepository.Products
Where(p => p.Price < 50));

The changes use LINQ to filter the Product objects so that only those whose Price property is less
than 50 are passed to the view. Save the changes to the controller class file and reload the browser window
without stopping or restarting the application in Visual Studio. The HTTP request from the browser will
trigger the compilation process, and the application will be restarted using the modified controller class,
producing the results shown in Figure 6-9, which omit the Kayak product from the table.
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[ Working with Visual Stuc X

C | ® localhost:61207 e

L

Products

Name Price

Lifejacket $48.95
Soccer ball $19.50
Comer flag $34.95

Figure 6-9. Automatically compiling classes

The automated compilation feature is useful when everything is going to plan. The drawback is that
compiler and runtime errors are displayed in the browser rather than Visual Studio, which can make it hard
to figure out what is happening when there is a problem. As an example, Listing 6-11 shows the addition of a
null reference to the collection of model objects in the repository.

Listing 6-11. Adding a null Reference in the SimpleRepository.cs File

using System.Collections.Generic;

namespace WorkingWithVisualStudio.Models {
public class SimpleRepository {
private static SimpleRepository sharedRepository = new SimpleRepository();
private Dictionary<string, Product> products
= new Dictionary<string, Product>();

public static SimpleRepository SharedRepository => sharedRepository;

public SimpleRepository() {
var initialIltems = new[] {
new Product { Name = "Kayak", Price = 275 M },
new Product { Name = "Lifejacket", Price = 48.95 M },

new Product { Name = "Soccer ball", Price = 19.50 M },
new Product { Name = "Corner flag", Price = 34.95 M }
b
foreach (var p in initialItems) {
AddProduct(p);
}

products.Add("Error"”, null);
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public IEnumerable<Product> Products => products.Values;

public void AddProduct(Product p) => products.Add(p.Name, p);

Visual Studio’s IntelliSense feature will highlight syntax problems, but a problem like a null reference
won't show up until the application is running. Reloading the browser page will cause the SimpleRepository
class to be compiled, and the application will be restarted. When MVC creates an instance of the controller
class to process the HTTP request from the browser, the HomeController constructor will instantiate the
SimpleRepository class, which will, in turn, try to process the null reference added in the listing.

The null value causes a problem, but it isn’t obvious what the problem is because the browser doesn’t
display a helpful message (and, if you are using Chrome, doesn’t display a message at all, preferring instead
to display an empty tab).

Enabling Developer Exception Pages

During the development process, it can be helpful to display more useful information in the browser
window when there is a problem. This can be done by enabling developer exception pages, which requires a
configuration change in the Startup class, as shown in Listing 6-12.

I explain the role of the Startup class in detail in Chapter 14, but for now it is enough to know that
calling the UseDeveloperExceptionPage extension method sets up the descriptive error pages.

Listing 6-12. Enabling Developer Exception Pages in the Startup.cs File

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Logging;

namespace WorkingWithVisualStudio {
public class Startup {
public void ConfigureServices(IServiceCollection services) {
services.AddMvc();
}
public void Configure(IApplicationBuilder app, IHostingEnvironment env,

ILoggerFactory loggerFactory) {

app.UseDeveloperExceptionPage();
app.UseMvchithDefaultRoute();

If you reload the browser window, the automatically compilation process will rebuild the application
and produce a more useful error message in the browser, as shown in Figure 6-10.
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[3 Internal Server Error x

C | ® localhost:61207 | ¢

An unhandled exception occurred while processing the request.

NullReferenceException: Object reference not set to an instance of an object.
<Index>b_0_0 in HomeController.cs, line 10

m Query Cookies Headers

NullReferenceException: Object reference not set to an instance of an object.

<Index>b_0_0 in HomeController.cs

1e@. .Where(p => p.Price < 58));
MoveNext

MoveNext in Index.cshtml

17. @foreach (var p in Model) {

Figure 6-10. A developer exception page

The error message shown by the browser can be sufficient to figure out simple problems, especially
since the iterative style of development means that the most recent changes made are likely to be the cause.
But for more complex problems—and for problems that don't become immediately apparent—the Visual
Studio debugger is required.

Using the Debugger

Visual Studio also supports running an MVC application using a debugger, which allows execution to be
halted to inspect the application’s state and the path that a request follows through the code. This requires
a different style of development because modifications to C# classes are not applied until the application is
restarted (although changes to Razor views still take effect automatically).

This style of development isn’t as dynamic as using the automatic compilation feature, but the Visual
Studio debugger is excellent and can provide much deeper insights into the way an application works than is
possible with a message displayed in a browser window.

To run an application using the debugger, select Start Debugging from the Visual Studio Debug menu.
Visual Studio will compile the C# classes in the project before launching the application, but you can also
manually compile your code by using the items in the Build menu.

The example application still contains the null reference, which means that the unhandled
NullReferenceException that thrown by the SimpleRepository class will interrupt the application and pass
execution control to the developer, as shown in Figure 6-11.
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HomeController.cs & X
E'WolkmngtthsualStuﬂlo NETCoreApp, Version i" Work dio.C llers.HomeCor -19 Index() =

| Husing Microsoft.AspNetCore.Mvc; '§'

using WorkingWithVisualStudio.Models; I T |
using System.Ling; ! NullReferenceException occurred x!

~ [Exception thrown: "System.NullReferenceException’ in
| Einamespace M:lr'klnsh’)th\usunlstud:m Cnntrollers { WorkingWithVisualStudio.dil

public class HomeContre Con - {
; Additional information: Object reference not set to an instance of an object.
public Ia ult Im:lex[) :
=> View( . Sharedneposi,tory Products Troubleshooting tips:
-1 N‘her‘e(p => p.Price < 58)); Check to determine if the object is null before calling the method. | -
} } Use the "new" keyword to create an object instance.

Get general help for this exception.

Search for more Help Online...

[Exception settings:

B4 Break when this exception type is thrown
Actions:

View Detail...

0% - Copy exception detail to the clipboard

Open exception settings

Figure 6-11. Dealing with an unhandled exception

Tip If the debugger doesn’t intercept the exception, then select Windows > Exception Settings from the
Visual Studio Debug menu and make sure that all the exception types in the Common Language Runtime
Exceptions list are checked.

Setting a Breakpoint

The debugger doesn’t indicate the root cause of the problem, only where it manifested itself. The statement
that Visual Studio highlights indicates that the problem occurs when filtering the objects using LINQ, but a
little work is required to dig into the detail and get to the underlying cause.

A breakpoint is an instruction that tells the debugger to halt execution of the application and hand
control to the programmer. You can inspect the state of the application and see what is happening and,
optionally, resume execution again.

To create a breakpoint, right-click a code statement and select Breakpoint » Insert Breakpoint from the
pop-up menu. As a demonstration, apply a breakpoint to the AddProduct method in the SimpleRepository
class, as shown in Figure 6-12.
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Dq WorkingWithVisualStudio

SimpleRepository.cs & X

[€=] WorkingWithVisualStudio. NETCoreApp, Version -l‘“.: WorkingWithVisualStudio.Models.SimpleReposi -!9 SimpleRepository() -
+
- public SimpleRepository() { -
var initialItems = new[] {
new P ct { Name = "Kayak"”, Price = 275M },

new F
new F
new Pro

Name = "Lifejacket”™, Price = 48.95M },
Name = “Soccer ball”, Price = 19.56M },
Name = “Corner flag”, Price = 34.95M }

by gty

b
foreach (var p in initialItems) {
AddProduct(p);

}

products.Add("Error”, null);
} =

public IEnumerable<Product> Products => products.Values;

(] public void AddProduct(Product p) => [IRat Il
}

100% =~

Figure 6-12. Creating a breakpoint

Select Debug » Start Debugging to start the application using the debugger or Debug » Restart if the
application is already running. During the initial HTTP request from the browser, the SimpleRepository
class will be instantiated, and the execution of the code will reach the breakpoint, at which point execution
of the application will stop.

At this point, you can use the Visual Studio Debug menu items or the controls at the top of the
window to control execution of the application or use the different debugger views available through the
Debug» Windows menu to inspect the application state.

Viewing Data Values in the Code Editor

The most common use for breakpoints is to track down bugs in your code. Before you can fix a bug, you have
to figure out what is going on, and one of the most useful features that Visual Studio provides is the ability to
view and monitor the values of variables right in the code editor.

If you move the mouse over the p argument to the AddProduct method highlighted by the debugger, a
pop-up will appear that shows you the current value of p, as shown in Figure 6-13. It can be hard to make out
the pop-up, so I have shown a magnified version in the figure.
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[€=] WorkingWithVisualStudio..NETCoreAp VorkingWithVisualStudio.Models. SimpleReposi IG) SimpleRepository() -
T new Pr ct { ‘Name = "Corner flag ; Price = 34.95M } +
1 -
foreach (var p in initialltems) £
AddProduct (p); a0 p {WorkmgWrthVnsuaIStudlo Models. Product} = |
}
products.Add("Error”, null); ﬁ Name Q ~ Kayalc
} M Price 275
public IEnumerable<Product> Produfts => products.Values;
[+ public void AddProduct(Product pf => products.Add(p.Name, p);
} 4 @ p {WorkingWithVisualStudio.Models.Product} D—] ;:_
} 18 Name| Q ~ "Kayak® !
& Price 275
100% =

Figure 6-13. Inspecting a data value

This may not seem impressive since the data object is defined in the same constructor as the breakpoint,
but this feature works for any variable. You can explore values to see their property and field values. Each value
has a small pin button to its right that you can use to monitor a value when code execution continues.

Hover the mouse over the p variable and pin the Product reference. Expand the pinned reference so
that you can also pin the Name and Price properties, creating the effect shown in Figure 6-14.

mpleRepository.

SimpleRepository.cs & X

I_‘WurkmgWrth\-fusuaIStud-o NETCoranppVersaon l" WorkingWithVisualStudio.Models.SimpleReposi -I@ SimpleRepository(). .
new Pr ct { Name = “Corner flag”, Price = 34.95M } +
i -
foreach (var p in initialItems) {
L2 AddProduct(p); : AR -
roduct(p) B p {WorkingWithVisualStudio.Models.Product}
} 9
products.Add("Error”, null); # pName £ -“Kayak®
} & p.Price 275

public IEnumerable<Product> Products => prpducts.Values;

(- ] public void AddProduct(Product p) products.Add(p.Name, p);

} -
} L
E@ p {WorkingWithVisualStudio.Models.Product}
X p.Name A -"Kayak"
# p.Price 275
100% ~ i

Figure 6-14. Pinning values in the code editor

Select Continue from the Visual Studio Debug menu to continue execution of the application. Since the
application is executing a foreach loop, execution will be halted again when the breakpoint is encountered
again. The pinned values show how the object assigned to the p variable and its properties change, as
illustrated by Figure 6-15.
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Ee p {WorkingWithVisualStudio.Models.Product}
# p.Name A -"Lifejacket"
& p.Price 48.95

Figure 6-15. Monitoring state change using pinned values

Using the Locals Window

A related feature is the Locals window, which is opened by selecting the Debug» Windows » Locals menu
item. The Locals window displays data values in a similar way to pinning, but it displays all of the local
objects relative to the breakpoint, as shown in Figure 6-16.

Locals - M X
Name Value Type
4 @ this {WorkingWithVisualStudio.Models.SimpleRepository} WorkingWithVisualStudio.Models.SimpleRepos
4 S Products Count=2 System.Collections.Generic.IEnumerable<Work
b @ [0] {WorkingWithVisualStudio.Models.Product} WorkingWithVisualStudio.Models.Product
b @ (1] {WorkingWithVisualStudio.Models.Product} WorkingWithVisualStudio.Models.Product
b @ Raw View
LHC? products System.Collections.Generic.Dictionary<string,
b %z Static members
4@ p {WorkingWithVisualStudio.Models.Product} WorkingWithVisualStudio.Models.Product
& Name "Soccer ball" Q, - string
& Price 19.50 decimal

Figure 6-16. The Locals window

Each time you select Continue, execution of the application will resume, and another object will
be processed by the foreach loop. If you keep going, you will see the null reference appear, both in the
Locals window and in the pinned values displayed in the code editor. By using the debugger to control the
execution of the application, you can follow the flow through your code and get a sense of what is going on.
I could fix the null reference problem by cleaning up the collection of Product objects, but an
alternative approach is to make the controller more robust, as shown in Listing 6-13, where I have applied
the null conditional operator to check for null values (as described in Chapter 4).

Listing 6-13. Fixing the null Reference Problem in the HomeController.cs File

using Microsoft.AspNetCore.Mvc;
using WorkingWithVisualStudio.Models;
using System.Ling;

namespace WorkingWithVisualStudio.Controllers {
public class HomeController : Controller {

public IActionResult Index()

=> View(SimpleRepository.SharedRepository.Products
Where(p => p?.Price < 50));
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Disable the breakpoint by right-clicking the code statement to which it has been applied and selecting
Breakpoint » Delete Breakpoint from the pop-up menu. Restart the application and you will see the simple
data table shown in Figure 6-17.

[ Working with Visual Stuc X

C | @ localhost:61207 e [

Products

Name Price

Lifejacket $48.95
Soccer ball $19.50
Comer flag $34.95

Figure 6-17. Fixing the bug

This is a simple problem to solve compared to the problems that require real bug hunting, but the
Visual Studio debugger is excellent, and by using the many different views of the application that are
available and controlling execution, you can really dig into the detail to figure out what is going wrong.

Using Browser Link

The Browser Link feature can simplify the development process by putting one or more browsers under the
control of Visual Studio. This feature is especially useful if you need to see the effect of changes on a range of
browsers. The Browser Link feature works with or without the debugger, but I find it most useful when using
the automatic class compilation feature because it means I can modify any file in the project and see the
effect of the change without having to switch to the browser and manually reload the page.

Setting Up Browser Link

Enabling Browser Link means adding an assembly to the project and changing its configuration. In Listing 6-14,
you can see how I added the Microsoft.VisualStudio.Web.BrowserLink.Loader assembly to the dependencies
section of the project. json file.

Listing 6-14. Adding the Browser Link Assembly in the project.json File

"dependencies": {
"Microsoft.NETCore.App": {
"version": "1.0.0",
"type": "platform"

)
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"Microsoft.AspNetCore.Diagnostics": "1.0.0",

"Microsoft.AspNetCore.Server.IISIntegration": "1.0.0",
"Microsoft.AspNetCore.Server.Kestrel": "1.0.0",
"Microsoft.Extensions.Logging.Console": "1.0.0",
"Microsoft.AspNetCore.Mvc": "1.0.0",
"Microsoft.VisualStudio.Web.BrowsexLink.Loader": "14.0.0"

1

Listing 6-15 shows the corresponding change to the Startup class.

Listing 6-15. Enabling Browser Link in the Startup.cs File

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Logging;

namespace WorkingWithVisualStudio {
public class Startup {

public void ConfigureServices(IServiceCollection services) {
services.AddMvc();
}

public void Configure(IApplicationBuilder app, IHostingEnvironment env,
ILoggerFactory loggerFactory) {

app.UseDeveloperExceptionPage();
app.UseBrowserLink();
app.UseMvchithDefaultRoute();

Using Browser Link

To understand how Browser Link works, select Start Without Debugging from the Visual Studio Debug
menu. Visual Studio will start the application and open a new browser tab to display the results. Inspect the
HTML sent to the browser and you will see that it contains an additional section like this:

<!DOCTYPE html>

<html>

<head>
<meta name="viewport" content="width=device-width" />
<title>Working with Visual Studio</title>

</head>

<body>
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<h3>Products</h3>
<table>
<thead>
<tr><td>Name</td><td>Price</td></tr>
</thead>
<tbody>
<try><tdsLifejacket</td><td>$48.95¢</td></tr>
<tr><td>Soccer ball</td><td>$19.50</td></tr>
<tr><td>Corner flag</td><td>$34.95</td></tr>
</tbody>
</table>
<!-- Visual Studio Browser Link -->
<script type="application/json" id="__browserLink_initializationData"»
{"requestId":"9e00c6¥8058f4369818e7ba315cobdde" , "requestMappingFromServer": false}
</script>
<script type="text/javascript" src="http://localhost:56147/e7b85fe070c54198a041d57c363ceeq0/
browserLink" async="async"»</scripty
<!-- End Browser Link -->
</body>
</html>

Visual Studio adds a pair of script elements to the HTML sent to the browser, which are used to open
along-lived HTTP connection back to the application server so that Visual Studio can force the browser to
reload the page. (If you don’t see the script elements, then make sure that Enable Browser Link is selected
in the menu shown in Figure 6-18). Listing 6-16 shows a change to the Index view that will illustrate the
effect of using Browser Link.

.ministrator) Y S° | Quick Launch (Ctrl+Q) I = [&] o=
‘ools Test Analyze Window Help Adam Freeman ~
Any CPU - P lSEpress - G - | p i | 2= N =

_ C; Refresh Linked Browsers Ctrl+Alt+Enter 2
Studio.Models.Product> &) Browser Link Dashboard h E
v Enable Browser Link 8
v Enable CSS Auto-Sync g

:_ Solution Item;

idth=device-width" /> &T globaljson

j itle>
Figure 6-18. Using Browser Link to reload a browser

Listing 6-16. Adding a Timestamp in the Index.cshtml File

@model IEnumerable<WorkingWithVisualStudio.Models.Product>
@{ Layout = null; }

<!DOCTYPE html>
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<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Working with Visual Studio</title>
</head>
<body>
<h3>Products</h3>
<p>Request Time: @DateTime.Now.ToString("HH:mm:ss")</p>
<table>
<thead>
<tr><td>Name</td><td>Price</td></tr>
</thead>
<tbody>
@foreach (var p in Model) {
<tr>
<td>@p.Name</td>
<td>@($"{p.Price:C2}")</td>
</tr>
}
</tbody>
</table>
</body>
</html>

Save the change to the view file and select Refresh Linked Browsers from the Browser Link menu on the
Visual Studio toolbar, as shown in Figure 6-18. (If Browser Link doesn’t work, try restarting Visual Studio and
trying again).

The JavaScript code embedded in the HTML sent to the browser will reload the page, showing the effect
of the addition, which is to add a simple timestamp. Each time you select the Visual Studio menu item, the
browser will make a new request to the server. The request will result in the Index view being rendered to
generate a new HTML page with an updated timestamp.

Note Browser Link’s script elements are embedded only in successful responses, meaning that if an
exception is thrown when compiling a class, rendering a Razor view, or handling a request, then the connection
between the browser and Visual Studio is lost and you will have to reload the page using the browser once you
have resolved the problem.

Using Multiple Browsers

Browser Link can be used to display an application in multiple browsers simultaneously, which can
be useful when you want to iron out implementation differences between browsers (especially when
implementing custom CSS stylesheets) or see how an application is rendered on a mix of desktop and
mobile browsers.

To pick the browsers that will be used, select Browse With from the IIS Express button on the Visual
Studio toolbar as shown in Figure 6-19.
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E Y &° Quick Laun?
ols Test CodeMaid Analyze Window Help )
Any CPU | P sExpress - & - | M EMfE| = AW OWCACR

iio.Models.Pro|{ ¥ IS Express
WorkingWithVisualStudio
Web Browser (Google Chrome Canary) »
Browse With... N

th=device-width" />
title>

Figure 6-19. Selecting multiple browsers

Visual Studio displays a list of the browsers that it knows about. Figure 6-20 shows the browsers I have
installed on my system, some of which are installed with Windows (Internet Explorer and Edge) and others

that I install because they are in widespread use.
Browse With -

Browsers (select one or more):

Firefox Add... ‘
Google Chrome (Default) ' s
Google Chrome Canary P

Internal Web Browser
Internet Explorer I
Microsoft Edge Set as Default ]
Opera Internet Browser

Program:
Arguments;

Size of browser window: -. Default v ‘

Figure 6-20. Picking browsers from the list
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Visual Studio looks for common browsers during the installation process, but you can use the Add
button to set up browsers that were not discovered automatically. You can also set up third-party testing
tools like Browser Stack, which run browsers on cloud-hosted virtual machines so that you don’t have to
manage a large matrix of operating systems and browsers for testing.

I selected three browsers in the figure: Chrome, Internet Explorer, and Edge. Clicking the Browse button
starts all three browsers and causes them to load the example application’s URL, as shown in Figure 6-21.

B Working with Visual Stu X

& http://localhost:60518/ | [ Working with Visual Stud X

& Working with Visual Studio % & > 0 local -

~

C | [ localhost:60518

]
mn

Products

Products
Request Time: 17:51:26
9 Request Time: 17:51:26 Hemn

Name Price Request Time: 17:51:26

Lifejacket £48.95 f‘f:“ g‘;; : '

Soccer ball £19.50 thejacket £4S5. Name  Price

Comer flag £34.95 Soccer ball £19.50 Lifejacket $48.95
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Figure 6-21. Working with multiple browsers

You can see which browsers Browser Link is managing by selecting the Browser Link Dashboard menu
item, which opens the window shown in Figure 6-22. The dashboard shows the URL displayed by each
browser, and each browser can be refreshed individually.

Browser Link Dashboard *\O X
4 WorkingWithVisualStudio (0 connections)

4 Connections

o current connections

View in Browser

4  Unknown (3 connections)

4 Connections

Chrome = http://localhost:60518/
Microsoft Edge +  http://localhost:60518/
Mozilla « http://localhost:60518/

Learn more about Browser Link

Figure 6-22. The Browser Link Dashboard window
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Preparing JavaScript and CSS for Deployment

When you create the client-side part of a web application, you will usually create a number of custom
JavaScript and CSS files, which are used to supplement those in the packages installed by Bower. These files
require processing to optimize them for delivery in a production environment, to minimize the number of
HTTP requests and the amount of network bandwidth required to deliver them to the client. In this section, I
describe the Visual Studio extension that Microsoft has provided to perform this task.

Enabling Static Content Delivery

ASP.NET Core includes support for delivering static files from the wwwroot folder to clients but it isn’t
enabled by default when the Empty template is used to create the project. To enable static file support, a new
package is required in the dependencies section of the project. json file, as shown in Listing 6-17.

Listing 6-17. Adding a Package in the project.json File

"dependencies": {
"Microsoft.NETCore.App": {
"version": "1.0.0",
"type": "platform"

)
"Microsoft.AspNetCore.Diagnostics": "1.0.0",

"Microsoft.AspNetCore.Server.IISIntegration": "1.0.0",
"Microsoft.AspNetCore.Server.Kestrel": "1.0.0",
"Microsoft.Extensions.Logging.Console": "1.0.0",
"Microsoft.AspNetCore.Mvc": "1.0.0",
"Microsoft.VisualStudio.Web.BrowserLink.Loader": "14.0.0",
"Microsoft.AspNetCore.StaticFiles": "1.0.0"

1

The Microsoft.AspNetCore.StaticFiles package contains the functionality for handling static files,
which must be enabled in the Startup class, as shown in Listing 6-18.

Listing 6-18. Enabling Static Files Support in the Startup.cs File

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Logging;

namespace WorkingWithVisualStudio {
public class Startup {

public void ConfigureServices(IServiceCollection services) {
services.AddMvc();
}
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public void Configure(IApplicationBuilder app, IHostingEnvironment env,
ILoggerFactory loggerFactory) {

app.UseDeveloperExceptionPage();
app.UseBrowserLink();
app.UseStaticFiles();
app.UseMvchithDefaultRoute();

Adding Static Content to the Project

To demonstrate the bundling and minification process, I need to add some static content to the project
and add the ability to deliver it to the client. First, I created the wawroot/css folder, which is where custom
CSS files are stored. I then added a file called first.css using the Style Sheet item template, as shown in
Figure 6-23.

Add New ltem - WorkingWithVisualStudio r

4 Installed Sort by: Default N Search Installed T?
ASP.NET IS - . 2
C? entE‘ 3 "-j JavaScript File Client-side Type: Client-sid!
C Id He A cascading styl
ode Style Sheet Client-side HTML style defi
b Online == 1
|=§[ TypeScript File Client-side J
—-Ts - -
[E Typeseript ssx File Client-side 4
5 TypeScript JSON Configuration File Client-side (
q Bower Configuration File Client-side 1
i 4
5 npm Configuration File Client-side 3
Click here to go online and find templates. 4
Name: first.css J

Figure 6-23. Creating a CSS stylesheet

I edited the first.css file to add the CSS styles shown in Listing 6-19.

Listing 6-19. The Contents of the first.css File in the wwwroot/css Folder

h3 {
font-size: 18 pt;
font-family: sans-serif;
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table, td {
border: 2px solid black;
border-collapse:collapse;
padding: 5px;
font-family: sans-serif;

Irepeated the process to create another style sheet called second. css in the wwwroot/css folder, with
the content shown in Listing 6-20.

Listing 6-20. The Contents of the second.css File in the wwwroot/css Folder

p{
font-family: sans-serif;
font-size: 10 pt;
color: darkgreen;
background-color:antiquewhite;
border: 1px solid black;
padding: 2px;

Custom JavaScript files are stored in the wwwroot/js folder. I created this folder and used the JavaScript
File item template to create a file called third. js, as shown in Figure 6-24.

Add New Item - WorkingWithVisualStudio

= s Dl e Search Installed Templates (Ctrl+E)
4
ASP.NET — o
- ype: Client-side
Client-side ‘I._.j s Client-side

A script file containing JavaScript co

Code N ; 5
@ JavaScript File Client-side

Online
Style Sheet Client-side

-4

TS

|-E| TypeScript File Client-side
TS

|_E| TypeScript JSX File Client-side

°| I TypeScript JSON Configuration File Client-side
o‘ I Bower Configuration File Client-side

Click here to go online and find templates.

Name: third.js

[N Ay o Lo~

Figure 6-24. Creating a JavaScript File

I added some simple JavaScript code to the new file, as shown in Listing 6-21.
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Listing 6-21. The Contents of the third.js File in the wwwroot/js Folder

document.addEventListener ("DOMContentLoaded", function () {
var element = document.createElement("p");
element.textContent = "This is the element from the third.js file";
document. querySelector("body").appendChild(element);

1

Ineed one more JavaScript file. I created a file called fourth. js in the wwroot/js folder and added the
code shown in Listing 6-22.

Listing 6-22. The Contents of the fourth.js File in the wwwroot/js Folder

document.addEventListener("DOMContentLoaded"”, function () {
var element = document.createElement("p");
element.textContent = "This is the element from the fourth.js file";
document . querySelector("body").appendChild(element);

1;

Updating the View

The final preparatory step is to update the Index.cshtml view to use the new CSS stylesheets and JavaScript
files, as shown in Listing 6-23.

Listing 6-23. Adding script and link Elements to the Index.cshtml File

@model IEnumerable<WorkingWithVisualStudio.Models.Product>
@{ Layout = null; }

<!DOCTYPE html>

<html>

<head>
<meta name="viewport" content="width=device-width" />
<title>Working with Visual Studio</title>
<link rel="stylesheet" href="css/first.css" /»
<link rel="stylesheet" href="css/second.css" />
<script src="js/third.js"></scripts
¢script src="js/fourth.js"s></scripts

</head>
<body>
<h3>Products</h3>
<p>Request Time: @DateTime.Now.ToString("HH:mm:ss")</p>
<table>
<thead>
<tr><td>Name</td><td>Price</td></tr>
</thead>
<tbody>
@foreach (var p in Model) {
<tr>
<td>@p.Name</td>
<td>@($"{p.Price:C2}")</td>
</tr>
}
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</tbody>
</table>
</body>
</html>

If you run the example application, you will see the content shown in Figure 6-25. The existing content
has been styled by the CSS style sheets and the JavaScript code has added new content.

[ Working with Visual Stuc X

C | @ localhost:61207 e :

Products

[Request Time: 17:29:48

Name Price

Lifejacket | $48.95
Soccer ball | $19.50
Corner flag | $34.95

[This is the element from the third js file |

[This is the element from the fourth js file |

Figure 6-25. Running the example application

Bundling and Minifying in MVC Applications

At the moment, there are four static files and the browser has to make four requests in order to get the
static files. And each of those files takes more bandwidth than it should to deliver to the client because they
contain whitespace and variable names that are meaningful to the developer but have no significance to the
browser.

Combining files of the same type is called bundling. Making files smaller is called minification. Both of
these tasks are performed in ASP.NET Core MVC applications by the Bundler & Minifier extension for Visual
Studio.

Installing the Visual Studio Extension

The first step is to install the extension. Select the Tools » Extensions and Updates menu and click on the
Online category to display the gallery of available Visual Studio extensions. Enter Bundler & Minifier in to
the search box in the top right corner of the window, as shown in Figure 6-26. Locate the Bundler & Minifier
extension and click the Download button to add it to Visual Studio. Complete the installation process and
restart Visual Studio.
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Extensions and Updates ? X
b Installed Sort by: Relevance - Bundler & Minifier X -
4 Online e o
Bundler & Mlmﬁer_ Created by: Mads Kristensen
4 Visual Studio Gallery Adds suppatt forkunding and Version: 2.1.255
minifying JavaScript, CSS and HTML fil... i
b Controls Downloads: 144540
b Templates Web Essentials 2015.3 Rating: (42 Votes)
v Tools Adds many useful features to Visual Studio for web More Information
Search Results developers. Requires Visual Studio 2015 Report Extension to Microsoft

e i Web Extension Pack

The easiest way to set up Visual Studio for the ultimate
web development experience.

8
n

Al

b Updates (2)

Web Analyzer
Provides static analysis directly in Visual Studio for
JavaScript, TypeScript, JSX, CS5 and more

Image Sprites

Change your Extensions and Updates settings

Figure 6-26. Finding the Visual Studio extension

Bundling and Minifying Files

Once the extension has been installed and Visual Studio has been restarted, you can select multiple files of
the same type, bundle them together and minify their contents. As an example, select the first.css and
second.css files in the Solution Explorer, right-click and then select Bundler & Minifier » Bundle and Minify

Files from the popup menu, as shown in Figure 6-27.

Solution Explorer > B X |
OOQ|'®'$Q@|C’ Open
Search Solution Explorer (Ctrl+;) I Open With...

@ wwwroot I Hide from Sol